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The purpose of this research was to develop the model of blended learning and
flexible learning to promote lifelong learning for working-age adult by means of research
development.The research included 3 stages:1) Studying of the learning needs of working-
age adults; 2) Constructing blended learning and flexible learning model to promote lifelong
learning for working-age adult and 3) Assessingthe effectiveness of the model. The samples
used for learning needs assessment consisted of 134 working age adults from both government
and non-government organizations. The samples used for three efficiency verifications of
the model were 3, 7 and 32 working-age adults. The instruments used in the study included
1)The manual for organizing learning activities: curriculum, lesson plans, learning materials
(slides, e-learning, and learner’s manual); 2) Learning objective record form; 3)Lesson
learned record form; 4) Pre and post learning test, 5) The assessment questionnaire on
learning satisfaction, and 6) The assessment questionnaire on learned skills. The data were
analyzed by descriptive statistics, t-test dependent, and content analysis.

The research findings were as follows:

1. The model of blended learning and flexible learning to promote lifelong learning for
working-age adult was called “BL&FL Model”, included

1.1 Eight major components as follows: 1) Learning design delivering of a clear,
simple, reliable, and interesting presentation, enabling self-learning management and
freedom to learn, and providing learning alternatives through a variety of media; 2) Learning
objective which each learner could targeted self objectives, needs, and scope of each learning
lesson; 3) Evaluation beable to assess and measure learning outcome, and providing
activities for learning practice; 4) Philosophy and adult learning concept promoting lifelong
learning process, readiness to learn, and needs to achieve self-highest potential development;

5) Learning model; 6) Learning and teaching; 7) Curriculum; and 8) Learner analysis.



1.2 The model was developed in four steps and called “ACBF Model”: 1) Learner
analysis: A, 2) Course content analysis: C, 3) Blended learning design for learner: B; and
4) Flexible learning management: F

2. The results of the effectiveness study of the model were:

2.1 After implementation the model, the efficiency of blended learming and flexible
learning model or the E,/E, was found at 83.85/85.22. The efficiency value was met the
criteria at 85/85, + 2.5.

2.2 After using the model, the post-test score was higher than the pre-test with the
statistical significance at the 0.1 level. The effectiveness index (E.l.) was found at 0.702.
This value was greater than 0.50 therefore it was met the criterion.

2.3 The learner’s satisfaction towards the model were at highest level.

2.4 The learner’s self assessment of learning skill towards the model were at high

level.
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et Nanasiin An17lnsra udununaaulall faudun1Faunisdanlud ey

| ndld o 1 dqj dl o a & v Y ij/ [ [~1 Y =
dounidndouaasitianininauanieaunasiintagniniasay 30 tu anidunisldinalulat
(3 1 = E2Z a 1% a o = v a o dy ]
BudqanisFaunisaeu uidnazingldszuuiznnsdnnisBeud n1suiausiilaniiiunig
AUaFLIR uAariiFuNunanssuNtauan1saaulalliunn wazfaaiunisFaunisaaidly

4 = | o 1
NN Lﬁ‘ﬂuLﬂuﬂ@ﬂﬂ%

A1319 5 AAdI1NN1I9ANTTIFUUNTAAULLLNANNEU (Blended learning ratio)

Funaunisldunisauaaulail

(Online learning) "Il
0% A21LULNEA (Tradition)
1-29% WnNgaeaINNNIELE (Web facilitation)
30-79% WNNENNaNNARTU(Blended learning)
80%Up m@@miunumu%ﬁ(omine learning)

N19EUUULLNANKATY (Blended leaming) lunszuqunisBauinuainuane
a b4 a a ¥ = L d’ a 1
sluuunisFeuluiesFausuum@nyutn warnisiaunueaulal TegtluuunisFaulid
o ] dl o ] 49{ 1o dgl/ as o dl % dl =
Andaunmnesausarauegiuianiuazisnislunisaneive liussquivung taefinnsFeam
wuveeaulaifilszandiumalulatiansaumnaniuadslnaiagiunisdnnisunauas ldssuy
LMS (Learning Management System) 23w luesFeulng (Face to face) N1938UN1FADL
wuvaaulall (e-Leamning)

yaa '

nsuanuau iudaudsenay LL@zmiéhﬁmmﬁ@mmmiﬁmgﬁummmem\‘lﬁﬁz
ANTHUANFNTDIANEHIUTN 19T AINLANA N TIANNTAENITNIDINNTFEUT ATINWANGINY
vedsmsliAuusiuazmddeietszaudifunisFoudzlunuresaanugey Anauansag
m@qz‘ﬁmumﬁﬂu@mu Dynamics

#191 Blended leaming fianumunafndelnafifnfiianuiRasiuiufe integrative
learning, hybrid learning”, Multi-method learning” (The Node. 2001) 1n1514A191 Blended
learning fupeiaunnaluann NI AnE LAz FEMenTY Wl 2003 The americansociety for
training and development. 13AN134AANALAE1 Blended learning agj 1 1w 10 Ainemyinun g

TugnunisAne 3iel uaziNauaN (cited in Rooney. 2003, Graham. 2004)
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2. 23AL5ENALURINTTHUS UL LNANRATY
AN (Jared, M. Carman. 2005: 2) AMUN84ALISZNaLII8NTULLILNANKATY
aaniilu 5 491 Usznavumag
P . = P a = vl o v
1. wisnsnian (Live events) NMaEaufuLLgauan AanssunisEeauininlaadasy
TnafFauiidoudanlunanmeaiuegy nsEaug uieBaualouuuuan
X - ) = = v -«
2. amaaulad (Online content) lunnsBeuimuilszaunisniatnannsnaes
v ada al dl al U v a 1 =l a & & =
FILLDY HREABN9BEUILAZIZIZINANT TUUANAYNAENN 1999 BEU IhuFauaNaume L 1Te
alal dl =K
ANTRTaNINeNITENaLTN
3. gEaudnssandeiugdu (Collaboration) léun nsldanuune@idnnsatindnis
HUa5ALAAIAMNAAWIL UFANITAUNUILUBWINDSIANTTFN N e LR sz naLAR8N1999HN NS
Auszndngg Fauiudizanuazssninvdaauiugizay
4. nn9sziiu (Assessment) Taeiini9Ussiinnanizewn s2M9N9T8ULAZAdTEIL
A o ~ o o a Ao a v @ o
iadananisizauiaesdFaunuAaninn ldlunsdsuiivlfiduacing

5. @ﬂﬂ?ﬁi@ﬁuﬂuum?ﬁﬁﬂui (Reference materials)

3. SALTUTBINNTARTLUUNSIFBUSU LU NS NRAL

z%ﬁﬁu%ummmﬁm:uum@ﬁﬂu;ﬁﬂ,l,uur:mummwm§M“m§mﬂ,mu((:harles R. Graham.
2009: 376) ALAAISIFLTUIE9N 28 AT ULN T BEULLLNFNEA LY 3 Fufe TuAay
Wl 1@ lunnsuanngu (Enabling blends) Funannaudngonu (Enhancing blends) Fulaey
gluuunNaNNAY (Transforming blends)ImﬂLmezSﬁﬁu%ummmﬁm:uumiﬁﬂuimummmmu

Tunwisznau 7

Enabling blends

v

Enhancing blends

N7

Transforming blends

NNUsENeU 7 AMALIUA8INIIATELILNNTEEUEULLINANNATY
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o @ @

NAUUTUADUY FEazIR8A

Fduparutduldlalunng duEuARlLnITUIZINAZUINIHANNZA1Y 1A TN1Ta0 1L

= o o

HANKATY (Enabling blends)  Twu guluuunisaauls vsedesing o ey Naziiuiiinig

u

' |
a

HaNNAIUniulE LAaNIN199E YT NN UARINFBINIT
NANNAY
Funaunauiindndau %umw@mmmmﬁlmﬁm’mﬁ@iﬁiﬁgﬂ WLLINTHANKANY LT
(Enhancing blends) N3N TEULLLLNE oy win luieFau AudndaunisFau
wuvaaula
fuidae UIHuUUNaN A %w,ﬂﬁ'ﬂugﬂLLuummmmuLﬂummﬂ?iﬂugﬂ WUUNN9EEUE 1w
-

(Transforming blends) wasugduuunisFauangizeududiu Wudeauiug
A

MuuaRNILuLLRANN A UNN WA 1S

4. UUUUNSHANKAIUNANTTUUALITNITADY

%
=< [

SULLUNNINANNATUNANITNUATIDNITABY HAANTTHLALITNNTABU TIAz UL T

o ~ o . = o - o
Lﬂ@uimiuﬂﬁ@L?ﬂug Tmmmamm‘mgﬂ WU NNFLTEUIULLADUAR UWASNITLIUUIATNAIN
Faanng danaaaunindsynay 8

4.1 m‘it%'ﬂufuuuﬂ'auﬂm (Synchronous learning)

= v . 5| = o dl

N7t ugLLLdaudn (Synchronous Iearnlng)LﬂumiLiﬂum?Zﬁ'ﬂuﬁlu@m:fmwl
£ v a U al o %3 al dl o [~ U =l =l
QZQ@LLLL@Z?E{L?ﬂuﬁlﬂ\mmﬂ'ﬂﬂﬁ‘ﬂﬂulu ANTUCAITINADUNADNTIUNF TN um@%mummﬂu Y78

o o o

PR P R Aa = Ao g vya ~ o o
ANTUN VII@‘V]‘WH\?Q\?@:ﬁllﬂ@ﬂ??ﬂﬂ’]?ﬁﬂuﬂq?ﬂ@u%%qﬁlﬂE;!L?Elullﬂ HNUD Uaﬁﬂulu@ﬂﬂmz

£9)

WWTtyuin (Face to face)
4.2 N5IFAUFAINAINARINIS (Asynchronous learning)

= v v . A = A
NITLTUUIATNAITNADINIT (Asynchronous learning)Aa gﬂLLUUﬂ’]TL?ﬂuﬂ”}iﬁ@u%

gasuuazdraulianiudasnuiuaiunarluanme anuualduddaeuuazgizauaiuisn

o

a 1 o ny g A A A ' P P yalh 1Ay o A
m@[ﬂ@ﬂ‘lﬂ@m@‘ﬂﬂLQ@WI@EI?L@?@QN@@@@W?@WQ jsﬁQLﬂuﬂ"I?L?HU?Wh\IN @qqﬂﬂluL?‘ﬂ\imﬂ\iLQ@q

U

oy o o ah v .
wazan N EauaINnsnEaun iy wanlafls (Anywhere anytime)
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Live (synchronous) (asynchronous) On Demand
Face to Face Live Collaboration ‘Web-Based Performance

Classroom Online Coaching & Community Multimedia Learning Support

[
. D - 1
= o] _J
BPhysical ®Virtual mCoaching ®Portal Site ®Video  ®internet/ ®WKnowledge
Classroom Classroom mMentoring ® Blog Streaming  Intranet Management
mField Trips ®Webinar Wik WPodcasts M Self-paced W \Workflow
mlab @ Chat mDistance  'ulorials  Automation
m M Leaming ®Simulation m Performance
BThreaded WCD-ROM/ ®Games Support
Discussion DVD m Mobile &
@/olP Wireless

nwilszney 8 JUNLILNSHANKANWAANIINLAYIBNN9AEY
N Cognitivedesignsolutions. (2011: Online).

F11319 6 Naulan1sdnnisizaud Aanssuuazdsnisaen

a o P % a ac
N'ﬂuvl»mﬂ’l‘i‘aﬂﬂ'lﬁ'l,'i‘ﬂug NANITHLASIENITHAU

981 / gouTiAeaAY (WuLy)  nnsEewluiesde
Ug9818,N190AUT 8, LNUINANYF, Bauaniale,
anae, Nsefdsangw, 69, nsdnensd,
NsNAUIINIUNGN, NITUAAILNLNANHF,
nsaddsanniden, nsdunisnd, nedunun,

n3seANANDY, NNsEanianninud, nsEaudaniloymn

AR/ A0UNFANNTY Web Casts
(Synchronous) fnamAgn UGN
e-Learning UF9818,N190AUTENY, UNLIMANYF, BFuuaniale,

ansm, nsailsengw, 16ail, nsAnsna,
NsRAuIINIUNGN, NITUARILNLNANHF,
nisaddsanniden, nsdunisnd, nedunun,

= v = ¥
NN9ILANANDY, N3FEUFANINNE, N13i3euganaymn
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A9 6 (5iD)

=i [ a [ a ac
L\i'ﬂuvl"llﬂ']‘i'qmﬂ'l'ilﬁﬂuz NANTTHLASIENITFAU

DAY/ ADUTLAN nsirauluiesizey
UF9818,NN7BNLINENY, LNLINANYB,
= ada a a |
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Tia#, nnsildausanlungu, nsAnsned,
NNIUAAILNUMANYE, nnsaddananniden,
nMsfunEal, nsfuNwN, NITEANANDS,

= v = ¥
mmﬂugmmﬂuﬁ, ﬂW?Liﬁlug’QWﬂﬂm‘M’]

1
=

NAANNAYE / ADT1UNAINAY  Web-based Training Tutorials
(Asynchronous) aalugil Fodnus gUnaw @es nanedauling
aa . i a
qAle, Flash animation, UNLNANYH
a 6 o 1 aa = v
TATIAFDatN, Aante, N1sEauIaInNINNg
= U % 1 6
nsBeuiantloyun(Faatramanisal),

n13La1ired,Blog

nsnazdnduladiazingiuiuassmaiulagunldeoulugluuunainau prsiazidinla
1UUNNTRANLULANUTWTEUL (Instructional system design process) e—LearningLﬂugﬂLL‘]_l‘]_l

wilalunnsdngtununisFaufuuunanuanii(Blended learning)

L ¥ =~ 1
5. NTLTa UL UL niE Y

a wd‘d 1 | o =2 dl dl ¥ o v v a =
mmﬂugmmuqmﬂuqmmmﬂﬂfyﬂmmﬂmLmzi:uummﬂfmmmﬂ’]iﬁlmwﬂuu

= o X A 2 : A g9 o vl P A =
1/]’]\1L@'ﬂﬂLWN?]“LW]ZQZ@"JT’]LL@Z‘LI@N“@ZW%Hﬁﬂ@LW@IﬂLﬁM’]:ﬁZ@NﬂUEﬂL?ﬂMIﬂE}L@Wﬁt’ﬂﬁl’]xﬁﬁlﬁﬂ'ﬁlﬁ‘ﬁluﬁ‘

a

©

=

PR & ' o p d A o PR = v A s X T o
VINM’]MH@M&!HIW&L ﬂuNV]qﬂLﬂ‘ﬂﬂLﬂﬂ'ﬂﬂ‘i_lﬂ']ﬁ/]LN@I@LL@:ﬁLﬁ‘ﬂquﬁﬂ’]?‘V]Lﬂﬂ“ﬂu‘l_lf]\iﬂ?ﬂ?_lq

v = %

= ~ pRp - | o Ao g A A -
UUIEDINT L?Eu?@quuﬂﬂ@ﬂq?l’ﬁ‘ﬂugwmV’]Q’]NﬂmuﬂquLﬂu@qVINﬂlﬁﬂu UseNATNTUAUA LAY

a El
1

A aa N yaa ~ 'Y v o Y @ =
'ﬂ@‘&Lm?L@ﬂQﬁﬂqiL?ﬂquNﬂ']qQJﬂﬂﬂﬂui@?Uﬂ’]?ﬂ'ﬂﬂLLUUNﬂ@zslfﬁﬂ]']\imem@\jﬂqﬁ‘lﬁﬂuﬂq?@ﬂu
A Y e a aal A gve o o y =2 9 A
LL@%ﬂ’]ﬁ‘L?ﬂugﬂﬁ"ﬁag’]VIqwgLLﬂmﬁﬂ’]?LW@W‘uﬂLﬁ‘ﬂus\liﬂﬂ%ﬂum?m’mWﬂNﬂ@LL@::M’]S\IL%H’JT]Q_/I

Aoy, \a a o Y o wa A ~4 X X a X o
WN@QH?QNV’]@LL@'Z@Q']NW@LMuLL@gﬂﬂﬂﬂ@@\?ﬂﬂaL?ﬂu@u°'] LL@ZWL@ﬂﬁu@WQLﬂﬂmquuﬂqﬁim\iqu

Aﬂl A 1 = % A a A = 1%
ABNLATANND Internet - based LT UITLINIANITLTEUILANDUIT (VLE) vi9® N7 UgITLLNIT
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o Gl 4 = ad =
AANN3 (LMS), NTABaUnuIvsaiasaunuitareataaziniseanuuuiiluisnieruan inad
del dl va & a 1 = L % dll ¥ =
wannlilfaidnnsetinduazszerina wuheoiu lunduine lundrun Fauuaznisussane
y o . oy A o duyse -
WeeFey lusnzndoulugaesldsunsunisgeuintavguinadunlfviidsclonmiainszuy
ABNWARBTANN (e-Learning)  MiAnTUet9maaFalundIn1sdszutanalazANla Nt
eaa 4 A Ao 4 g X ) . y e

ginsniRanaaieneaniameguianieda o dasnauladuetnanly nisldginniiieda
wiulnsdnyidea, iPods, WAriAL LNDIANAINAREIAITBNEFUUAINAIA UATIANAINN
BavejuednI9iFeud (Wikipedia. 2011: Online)

Tusdu aununasna (Brian Stanford. 1999: 41) a3UneDd svuLNTFRUELLLEANE N
o o = P = = = Y o
HlunisdaniszauinsentsAneiudsdasullaiuaoiumunzanuazaanndaeiy
anwuaAdaNtagFaunnsdantsAne ludnwaziaz ldinnuadu a1 anui 350135

= : a o oA ¥ 9 9 = v A o v

AABAAUIIEATIAN uUnaunfeiiad il wiazdlandr i FauliinenFaunnansienis
ANANLTUYTRLAANANNALNHNINNIZANTAIALEY TNADUANEHIAZFBIdnA L THUNN9 1T uas
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1Y

a A v v a aa = a % v a 1 =
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2. NIV ANIRALAIATAS D5 Fa D7

A. MatiUS T RaLALTag D5 A9 D7

2. NIUAUIUNGHTARAIWFTAR D5 119 D7



=
LULUNAFaUN 4
a @ 1% [% I a
Unn 4 ﬂ‘i’]\??ﬁﬂ\?ﬁuﬂ‘iﬂ“ﬂﬂaﬂﬂ’lﬂﬁﬂ‘a"\ﬂvlm'}lLLﬂglLﬂuQN

o anunNnanavilsvlaainasnisngla’
o mralafiunisaglieya

®  NINIINENIUUUUY
= ° Ay A
AALARNAN mﬂ‘].lV]QﬂmﬂQVl@]ﬂ
1. Anaunanawazdsslaguaasmseladna
n. agdayandanuiuun
2. JiAeiiayaEean

A. pliayaagiiinaialusesu

Lo

.gnyndia
2. AdlunisaFreansialad

N. Insert - > table

1. Insert -> PivotTable

A. Insert -> Data

3. gnynde

3. dawlanlduansiasunagadayareununi
n. ramlail (Gridlines)
ﬂ.Lﬁunuﬁume%@H@ﬁqnwﬁﬂm(PbtAmm)

A. Gai3eq (Title)

4. Legend

4. aaAn1sReTa CPU luifaunugnauis uiudssunn 15 alaandlavasuauns

n. daise (Title)
1. Legend
A.n3e ket (Gridlines)
3. Unaiuaasdinyangnnden (Plot Area)
1 a4 1% [ @ a a o
5. dautlsznavlauandlinsuinduunuginaanuasls

n.dauesLnemaieya

L?’rN (Title)

3. n’%mimﬁ (Gridlines)
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RULUNARKAUN 5

un® 5 A1lAs (Macro) NUNIsUlUaNHuzNAaingl o

® 117As (Macro)
® 119851941 1AT (Create a Macro)

® nsnNuuANIIAT

A o = 2 =
AABNANRBUNYNADINEA

1
n

1

Adamdad19 anlas

. File - > Macros

. Home - > Macros

. Data - > Macros

. View- > Macros
msldunlasidsslaniasinels
. AZAIN TR

. ANN1TDTILAANIINNIUNTE R

M IIUABUNNINIIUA AR

4. d18170a01 B AN 15T

v o I < <
wnlainaanisldunnlasian 151A95auNlasHuaAINTunawle
. View > Macros >laanxnlasfal > Delete
. NALN Delete

View >1aanunlAsiFesnisall > Delete

3. lifdalagnsias

4. Erdiaansriuiin Workbook MilanlasinadiasmslvianlasgniiufinsasazfaadanAasle
N. Save As > Excel Macro - Enabled Workbook

9. Save As > Excel Workbook

A. Save As > Excel Binary Workbook

4. Save

5. Store macro in Aaazls

n. nsizanliuniag

9. Mstiuanlng

A, Msfiiennuinduiaaiuanlas

Lo

. Aruea AU TAsRas1

239



un# 6 MsAnaINMsuila n1sisianlegns (Audiing Worksheets)

=
LUUNAFaUN 6

o msfiapnudgaiifandesumaln (Trace Cell Precedents)
° miﬁmmud’mﬁ@ﬁgné’m%ﬂﬂmmﬁw (Trace Cell Dependents)
° mﬁél,mma;mv%\mm

® nspdanANAIA9IgRAINIIATWINL (Locate Errors in Formulas)

® NIAEARINAAITBIFRLLST (Watch and Evaluate Formulas)

& ° Ay A
N L@ﬂﬂﬂ"lm‘ﬂﬂm@iﬂm@\?ﬂ@‘ﬂ

1 Madnmusaaildifaadasiuiale Mads

n.Formula -> Trace Cell Precedents

1.

A.

d.

3.

Formula -> Trace Dependents

Formula -> Trace Data

. Formula -> Trace View
. TUARAUIUANTAAAININTA LALN HITRINULTER LA TUABWLSNAD
. WU Formula
- o g
ABNIARNARINIIHARHN

ABNAUIU

WAL View

nsAneNIndatignatdstlilating Mada

n.Formula -> Trace Cell Precedents

.

Formula -> Trace Dependents

. Formula -> Trace Data
. Formula -> Trace View

. Ardanldaniannis Trace Cell Precedents Wwag Trace Cell Dependents )

n.Formulas -> View

1.

Formulas -> Cancel

A.Formulas -> Remove

d.
5.

Formulas -> Remove Arrows

AN [T ULARIGASNINNA

n.Formulas -> Show

1.

A.

Formulas -> Show All

Formulas -> Show Formulas

3. lisdiagn
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RULUNARAUN 7

un? 7 Msuduaz&Iaantaya (Importing and Exporting Data)
° mﬁ*mﬂﬂﬂ%yj@iﬂﬁ\i Microsoft Word (Export to Microsoft Word)

® N131ENMA1371997N Microsoft Word (Import a Word Table)

]
=

e nsidindeyainiiu Text File (Import Text Files)

4 o a4 9 A
AUADNANRDUNYNADINGA

1. dumauusnrasnisdsaandayaain excel 1l Microsoft Word
n.denieyafifiasnisazdeann -> copy

2. 1lallsunsa Microsoft Word -> paste

A laiidagn

3. gnde n uaz 3

2. ﬁgum'auuinm%‘ﬁ’lL°i|”l£v‘|’1"a"NQ’m Microsoft Word §1£19 excel
n.Talilaunsu excel uaz sheet REnIANTINEN - paste

q. Lafaﬂmi’]ﬁ@gﬂm*ml\/licrosoft Word -> copy

1

pladidagn

Lo

.gnda n uaz v

3.mstidndayaiidiu Text File ffdunau
n. 1 fupeu

9. 2 Fumen

A. 3 Tunas

1. 4 fupey

4. Tlsunsu Excel Wiasasmsnelaiaduanidaszninagadansda
n. widlaaay ()

9. JAanL ()

A.am ()

1. ndn (~)

5. Text file Aaudndayauuuly

n. uilsdayaniiugilnin

foy

1
a

9. windeyaniiudeniinetnunen

©

A. LLWN‘H@H@V}LﬂUﬂWWLﬂ@@ﬂlW}

v
4 a < o

v v
4. wilndeyaniiuisdenduuazglnin



=
Luunagaun 8

UNY 8 NMTNTUUAAINITSNHIANNLRRANE (Security)

gl
1

n

a.

® NN UUATHRENUWITING Excel

® nnsilasnii Worksheet&Workbook
& ° A o A
LABNATAAUNYNABNNE A
. AUAaUNTAIUUATHARNW LA ING Excel
. File -> save -> Tools -> General Options
File -> save as -> Tools -> General Options

. File -> as save as -> Tools -> General Options

liddagn

. n51laens Worksheet ldunuazls
. View
. Review

. Data

. Home

. maantannisilasny Sheet ldadsazls
. Review -> Unprotect WorkSheet
. Review -> Unprotect Data

. Review -> Unprotect Sheet

lsifdagn

. n151laenis Workbook lduivuaszls
. Review
. Data

. View

. Home

. msandnnmstlasiy Workbook Mdandsasls
. Review -> Unprotect WorkSheet
. Review -> Unprotect Workbook

. Review -> Unprotect Sheet

1y
3. lifdegn
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NFaUN2 Fa9n15 Ml UNTNAITINNULAUGS

BULNARAUNDULASUAILTEY 20 1D

& o S 9 A
AUARNAIADUNINADINGA

1. WHWIU (Worksheet) nanadeazls
n. Asedeyaurazuiinraautinsng
y X da e
2. An31edieyariannaniivet uATes
A. A998 AT LINTBINTIN AN
3. mdayalennzuiihnniaamineu
2. A1ALAMNIIAUDILATDINNIANIING

o @

° = [ o @
ArurunfiAntuaAuwLsn

o

n. 2UAU
2. BNNIAY
A. AR, W19
3.u9n, AU
3. M5 lAEITaYa (Data) AAALAAN AINTBY
(Filter) \WadngLlseaeAln
n. Wlun1s ey

dll A o A b
2. walilunisAniaanieya

A a =] 2
A. 11 lunstiunngudeys
1. Wlunsaudeyasenaingudeya

V| i s g alaa

4. msilautayaaaIussia LU TaALAEINIENTS
agls

v
a o

n. nALlu Ctri+Enter uuuiluiniilaauyssin s

=<

2. nailu Alt+Enter uuuiluiniiiiaduussyinluad

' v

A. NALN Ctri+Shift uuwiluinideduussvinlud
3. natju Shtft+Enter uuudluinfidetiuussinlug

J—
5. ﬁ taitldinaslsnudaya

q

n. Ysuusisdiays
2. iWNandiaya
A. INAAELIANINYNHBITaYA

A4 9
J. LAaNARUA

6.dausniazfasiidmiunisiiaszidayana
n. Waunanildlunstiaee

2. feyafililumsdinmed

A. zgm‘*?‘i’l%

3. nadiaya

7. dalafAinduiendu =AVERAGE(B3:B7)
N. =b3+b4+b5+b6+b7/5

1. =(b3+b4+b5+b6+b7)/5

A. =SUM(B3:B7)/5

1%
Y o v b4

9. #unsn 1 lAvisde @ wavda A
8.A1d9buN15519AN59 LU
n. Insert - > table
. Insert -> PivotTable
A. Insert -> Data
v

3. gnunde

' 3 @ a
9. autlsznavlanuanslimsiudntluunugi
= @
yneanuazls

n.duasuemndeya

=2
2L 5B

b4
AT83A

|
=

A. aaL3ay (Title)
3. n3nlad (Gridlines)
10. ANUHgwazlsylatiaainisreladna
n. agldiayanianuaunin
a cY a K
2. JiAeiiayaEean

A. pliayaagiainaialusesu

3. gnunde



11 nsldunlasiisclagidasinels

. 42AIN 39ALT7

9. gNNIDTIEAANN LT F e

A, ldduAaUN TN ILANAS

1. gunsnaatiunainan G iy

12 ldAaenisldanusnlasuan 1s1A29aL
wnlastumudunavle

n. View > Macros >L§@m\l’ﬁmﬁlau > Delete

2. NALN Delete

A. View >aanunlnsidednisal > Delete

3. lWifidalagnsias

13. Store macro in Aaazls

n. nsenlduniag

9. psiinanlas

A. NN A TuanTAs

A, fvueAn UL RuRn TAsTiaEN s

14. dunaulumsinmuinaalaiiaadasiuina
1p duRaUULINAD

n. WAL Formula

9. [N TadTidesn ARy

A. ABNATUIL

4. WAL View

15. Msdnaudaaiignansdeliliflatie 14
ANRa

N. Formula -> Trace Cell Precedents

4. Formula -> Trace Dependents

A. Formula -> Trace Data

d. Formula -> Trace View

244

16. Tlsunsn Excel iasasnsnglaiiaduan
NAETEUINTAAD19DY

n. wHlAaau ()

9. TAaau ()

A. A ()

1. ndn (~)

17. Text file Aaulndayauuvluu

BANINBENILAEN

: o = o
A. Windeyaniunineasulng

v k4 d’ =3 :/I b4
4. wilndeyaniiuistiannuuazsdnin
18. TuRAULTNURINTAIRANTaYAN excel 1l
€13 Microsoft Word

F ] Sy :
n.idendeyanfiainisazdeaan -> copy

9. 1laldsunsa Microsoft Word -> paste

o)

1y
laitdagn
1. gndie n uaz 3
n’; [ a 1 [4
19. TUABUNITAINUATUANIU LI ING Excel
N. File -> save -> Tools -> General Options
1. File -> save as -> Tools -> General Options
A. File -> as save as -> Tools -> General Options
1y
3. iddagn
20. MsEnLAnN15ilasny Sheet liAdsazls
N. Review -> Unprotect WorkSheet
1. Review -> Unprotect Data

A. Review -> Unprotect Sheet

1y
3. liifdegn



AARNUIN
HANNSILATISHTDYS

1. HanN193ATIzIdiayanIInIIadeLEut (Validation) WULARLNNNAMNARINNIEES
2 lar © 1% d’j o o (3 dsj 2 P
2095 R dein9nu (Auiilenvangms JadeesAlsznauiugiuuazsUuuunisizey)
2 NANIIUIAIAINENNNIEILATANRTLUNTBLLLT AN AR NN ENNIT e
¥ o =R o o &0 o va
3. a7deyauuutiunnnimnmuadnglsraefdmingzay (wuy B-1)

4. agUnaanuunTunNs B ML Bew (Wi B-2)

u
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1. NAMSAATIEWLRYANITATIAFAUEUL (Validation)
WULRBUIHNAMNABINITIEEUS VR Inn) T vy

(Frulamuangns taqeasnlssnauiugiuuassluuunisGaul)



247

F11979 41 UARIANATHANNABAAREY LATINRIBEANTTLIFULIRANAN ARSI TNy
Aﬂl [ 2 a P I lesr © 1% dly [ o
NEINL LUUAUNINANNABINNTEEUTYeE lundeineu Auilannangms dase

s d” = [
avAlsznauNugUuassuILNTiTaug

ANNARLTUYRI TRt 7 iy

qa SEATLAAATDAIAN Gu leile ladu 1L.O.C s1an1sUsuilgs

sae wl¥uilge piae

ARUN 1 TayalNanULAALLLLARLINN

1) WA (TIE/AEN) 7 1.00

2) @ao1unn (lam ansa) 5 2 0.71 ATUFLANNNATTIUYD
Aineuans v lan ansa
wdine viel wenfiueg) dusiu

3) a1g (21-30 7 31401 41-501 51-601) 6 1 0.86 Lﬁu@IﬁLﬁMqumnndﬁ
60 Tmsnzngua1guInnan
60 1 vi3ain@es

4) 3LAUNNTANSA (Uszoudnmn Seamdnun/los.vida 7 1.00

Wiauwi aytBoyaunalea vsaiiauwin Wsnyoyss Beayanin

styeyien au))

5) @1 AiA15AN13ANE 6 1 0.86

6) @1TN(EFUINTNNT  WHNILLEEN %'w]) 6 1 0.86  AusLlFumnumImIgIUATA
AIANUNUAT A UUST B

7) AL 7 1.00

8) Uszaunianinisinaiu Bngr 103 10201 7 1.00

21-30% 317 3ul4)

9) nanilivemszavalan 5 2 0.71  uUnfingusntng vineu

(127U 347U 56 U 79 szanialy

10) 1elfi(fiaandn 10,000 U 10,000 - 20,000 LM 7 1.00

20,001 - 30,000 UM 30,000 LMAUl)
naudl 2 viduzsadiryimsAnmgluguuidanisBauiradlugvinuianuAndiunanisAnenadials

11) FwiEndesnmsinenfunswamnaditoynn 5 1 1 0.57  wueliiuaneenifudiedenr
ADEITHIAZA3EE9IN N lun98w/ nnsidia / wangdsziauliinen
NNIAAAIUIN / qﬁﬂmryw%\i nEuazl s

12) HWiENE 091N A N AR NIV AL ALY WAL 6 1 0.86 aualiiuanseniiufietios
Aniilutlszabillnauas Wi dsan Eﬁimmz

duganurearnazaonuazantszaunisainig

a o
iTeug
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ANNARLTLYRI TRt 7 iy

T Faazidandasiann du o Twily i 1O.C 91EnnsUsuiga
pingl Fuilg pinel
13) drwidgedn luGesiugureudinmAnamizes 6 1 086 wueliiuaneenifluiates
AYNAY N1TAANIIANHIAIIADLALDIAIIN
% o 1 4
Aaansuazimanziunguiiuune
14) fawidmadinsBauinaandan aztinlignis 6 1 086  AndnhazifluFeesnis
wasuulasiaduneluaseupuazdany thantlszenefls
WuiiEnsisauiadisls
15) diawidnazannisanuuauioels diansbuay 4 3 0.57 aueldiUunnenlu
dszaunieniiinniunifon Mdundugudnang wevnfluseazidunaeiin
1 s | 6 dl9/ Y Yy o o v A b4
snnanseaiuguenans menanglunjidinun Wieuduaulitedinla
Gewiluusansnauainnngly Jlunflugudsm panaLAsulnAem
o ‘v A Ay = o o 5 o o
uazflunyfiasnisnazBuuginacinalaamnsariy Anuazdiasnsydu daiau
b4 % o
FrmiRnlunannenu
16) WA N ANARIN1T 1NN U AL 5 2 1 0.71  ausldiUsunnenlu
AuuadnnenisBeuaedned Nl
g a0 o A aa Ay
2OULALDUNRNIENAZEEW LRONIBNTEEUS
a A A a ~
watAuazATasiani1sEew n1ssviliunanis
=
fTau
17) awidnAndnsdaduliifBaudanauimly 3 4 043  aueliUunimlng
NNIAFIAADLAUENGANNIT T ATBIUATANAN Annuaumanglidaiay
229NN TIULYNI AATRIAN T NNTIABNUAL
paLIANAN WIIRARaN TN T
18) drwidnauednliinsnuuananss Wunns 4 3 0.57 aueldiUunnen i
Auananssaliifluuuanmy uazianssud dfunmn  “auedn T->d
S ] Yy % o % a U
tomejuliidnwiinaunsonseinlé ANNART ¢
19) IWANARINENTNIIAIZIRANTIHN unNg 5 2 0.71 aueldiUsunnenlu
FRINRUENN 7| Nazfiaainlaenistes
dhunnsresnisaeuseniiuqailsyaisaainis
A o ua = o o £
aauinaliilAnuazidanuaydnLauEsIu
20) FiEHANAAI NI NNS Tlunng 5 2 0.71 aueldiUsunnenlu

Uszifiunanisanfinanuwisnuaaasssuy el

= oAy o v
'Vlﬁ"]'].l"ﬂﬁﬂLL@S%@@@UWQ‘ZW@\?TJ?U?J?\?Lmvlﬂl
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ANNARLTLYRI TRt 7 iy

9a sEazIALATAAIDN g lwile e 1.0.C Fanssulgs
pingl Fuilg pinel
21) fwiRnAndnindinnsdiulpeufila Wuduaesnng 5 2 0.71  aueliUFunimlug
ihdiayanldannislszilunaliuflagpaausns
= ~ o gY@

srUUNNTIFENNTARuN ez T ussuunng

P e A A o a

FEuUNTdaUNNANNWINNZdNUTa N 3 ANEN N

o &

flau

22) FiEnAndain s TN aew Wudued 4 2 1 043 ausliisneen

nsieununsnnng il seuluduiFaugaay e ldiun

Auflufiasprupunisanfiuianssuliduliadig FLHUNNTEBURTNINLTING

Hils=@nsnmiga (%

4 < @

Aaun 3 UssiAuillauvangns

s o't a ¥ . .

nnUszasAlunisiFaus (Objective)

23) N9 T s Temedlasanuiing 5 2 071  navinlWnlse TeeeTluanud
inluilaquiu indnuiiede
WupaufieIni13es
YN
fBausiasannsanill
dszens wazaunsninly
@anTeafunmineuls

24) fiasnisnazFeusliaunananalildam 5 1 1 0.57  wnAnsFuufudaluicnly
UNUR Bauetaazanl
nng i uajazBeun
sawie 16 1EU s Tomhing

~ a A | a

25) IvaIAINAN NN aLAN 7 1.00

a o

tuanuangmns(Course content)

o a Py °

NANFAFLUAWIATUNTYINUY

26) ANuN1TRULAZN1TIYT 7 1.00

Tispgzyiiam

27) finunguung 7 1.00

Tispgzyiiam

28) Fumnalulatansaumna 7 1.00

Tismgzyiiam

29) a7 llamszy 7 1.00
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ANNARLTLYRI TRt 7 iy

) saazidgndasIny Wu  Wwle ldu LOC 91EnsSuilgs
pingl Fuilg pinel
wangasiiiamsumsgauaiunisyineu
30) n@im‘ﬁ 1 Tlsunsudnsinanu 7 1.00
30.1 Advanced Excel 6 1 0.86 Advanced Microsoft Excel
30.2 Advanced Word 6 1 0.86 Advanced Microsoft Word
30.3 Advanced PowerPoint Presentations 6 1 0.86 Advanced Microsoft
PowerPoint Presentations
30.4 Advanced MS Access 6 1 0.86  Advanced Microsoft
Access
30.5 SPSS-Practical Statistics Analysis 6 1 0.86  IBM SPSS - Statistics
30.6 A Tlsmszy 7 1.00
31) ﬂziu‘ﬁl 2 Graphic & Web Design (n329n+ 7 1.00
I GRS T:)]
31.1 NN94514 web page AN HTMLS 7 1.00
31.2 NMsrAGa Video 7 1.00
31.3 Flash CS5 6 1 0.86 Adobe Flash
31.4 FLEX4 e 1.00
31.5 Web Design with Photoshop and 7 1.00
Dreamweaver
31.6 Au) Tlsmszyy 7 1.00
n5uUszLduna (Evaluation)
32) evnunBauinsinuuesantsLssiuned 7 1.00
fEauassiaailufilssiiung
33) Mestszifiunadnaninld SefFuuduflsniu 6 1 0.86
Auesdn lAFumNfautianunizaw
34) nnstmuARAn TN uLLLE N AYiE N 6 1 0.86
wumumm’é‘lﬁmmmﬂuﬁ@mmﬁﬁWﬂ;um'fa
A
35) ﬂmﬁumﬁﬂumwﬁqmiﬁﬂu’g 7 1.00
36) ﬁluj BIEGESY 7 1.00
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ANNARLTLYRI TRt 7 iy

I S1EALLALATRANAN W Ll e 1.O.C

pingl Fuilg pinel

s1an1sUsuilge

paud 4 AvuagluuumsGaudlimansaniugiFeu

suuuunisiZaus (Learning model)

37) d1nAFeanis T‘ﬁmif‘muﬁmﬁLﬁummﬂﬁﬂu 7 1.00
AN AN15RAIUFATAU UWAAZANLETNAN

soulounznisfienniu

38) #rwidsieenisniedn nnsFauiuLuidIusan 7 1.00
awnsndae 1 BewRan1sFaugaINq Ay

NUBLANE

nsausasunsuluiasFaunasnisisauiuuuaaulan (30:70)

39) nsiranglutiesizay 7 1.00
39.1  ueeng 7 1.00
392 HnlfjuR 7 1.00
39.3  Fauaninle 7 1.00
39.4  Befaniloyumn 7 1.00
39.5  Beuaininud 7 1.00
39.6 TLANAND o 1.00
39.7  anUmeungu " 1.00
39.8  nnsdausanlungu 7 1.00
39.9 A Wanswy 7 1.00
40) MsBabuLLanulal 7 1.00
40.1 delugy fasnws 7 1.00
40.2 gunn nwiadenlmn 7 1.00
40.3 deluglaes o 7 1.00
40.4 doile 7 1.00
40.5 Flash animation 6 1 0.86
40.6 Blog e-learning 7 1.00
40.7 AAIisiaasing 7 1.00
40.8 g 7 1.00
40.9 B anasy 7 1.00
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ANNARLTLYRI TRt 7 iy

dia seazidandaou Wu Lwile  ldu LOC 91EmsdFuilga
pingl Fuilg pinel
NFARNITIERUSULLEARE Y
41) mmimumﬂunmiwi 6 1 0.86  iiwselsduinan
42) Hasselunsiend 7 1.00
43) PouAUlALATANATIALDIALLDY 7 1.00
44) WunsBadannunasienivannvans 7 1.00
45) faulinmuauaisnsnluniaaeniay 7 1.00
Amszidagaansanng
n1saantul (Design)
46) Aoprumanafiig 1 faaufinnniniaueiia 7 1.00
uazqla
47) ﬁm\iLﬁﬂnlunﬂiﬁﬂuﬁﬂﬁuéﬂﬁﬂq y ‘s 1.00
48) fFauanunsniimsnuesuaridass lunnsBe 7 1.00
Aauil 5 AMuUAIENMSIANNSFEY
181
49) FrwidndieanislinanBanluiiasizen lunis 6 1 0.86 fjFuuntaazanaus
Bendmuiitmnls naenusngas naziu lunnslrend Tuidl
LIRN Lﬁ‘ﬂ\?qqﬂﬁﬂqﬁ‘ﬁ@
Hn
50) $nwidndaannsldnan FeilelsflE ﬁyuﬂﬂm'ﬁu 7 1.00
ANAZAIN AHNGENTUNsEWE TR ENNLE
51) nwiEndeannsldnandaunikmuinaninivun 7 1.00
1 douvibeFuudlelsfly mudlismunals
anudl Aauazailnsol
52) svuaniiidaiau naesievudngns 6 1 0.86
53) iszyanufl Tuegiumaaznanaeldiiemet 6 1 0.86
uaT PaNfameT
54) Aennsisendsadiuganisieaeulutiosdou 6 1 0.86
RN
55) Aennsisendsadluganisitelddentsaen 6 1 0.86

fUWaLR
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ANNARLTLYRI TRt 7 iy

i seazidandasionu Wu Lwile  ldu LOC 91EmsdFuilga
pingl Fuilg pinel
56) Aansiesalluganisde ddenisaenun 6 1 0.86
umafiinuaz i lutieazay
57) guinsnlluieszeuligFauddousanlunig 7 1.00
HAnUfjum
58) atnsallutiesBaulitFauidiuianlunistin 7 1.00

UL uar@e BumesilnligEeuainnsodiile

nuldiazaan
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NIFAUNT (FRUNAUANITRENFDUALNITUNAUBNRIIUTUF

unin i ATRAANNENNARITRRAL(P) r ANRLUN agulua
1 1 0.70 0.67 i
* 2 0.40 -0.33 15114
* 3 0.90 0.33 15114
4 0.80 0.67 i
5 0.70 0.67 i
6 0.80 0.67 14145
* 7 1.00 0.00 15114
* 8 1.00 0.00 1114
* 9 0.90 0.33 1114
10 0.30 0.33 14145
2 1 0.40 1.00 14145
2 0.40 0.67 i
3 0.30 0.33 i
4 0.20 0.67 14145
5 0.60 0.67 1151414
* 6 0.80 0.00 1114
7 0.50 1.00 i
8 0.50 0.33 14145
* 9 0.90 0.33 15114
* 10 0.40 -1.00 1114
3 1 0.70 0.00 114
* 2 0.80 0.00 15114
3 0.30 0.33 1415
4 0.70 0.33 i
5 0.20 0.33 i
6 0.50 0.33 1415
7 0.40 0.33 1414
* 8 0.60 -0.33 114
* 9 0.30 0.00 1114
10 0.30 0.33 1414
4 1 0.80 0.67 1414
* 2 1.00 0.00 1114
3 0.60 0.67 i
* 4 0.90 0.33 15114
5 0.40 0.33 1414
6 0.80 0.33 i
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ian ATUAANNENNARITDRAL(P) r ANRLUN ag1lua
0.20 0.67 1414
0.70 0.67 i
9 0.80 0.67 i
10 0.60 0.33 1414
1 0.00 0.00 15114
2 0.30 0.00 1114
3 0.60 0.33 i
4 0.50 -0.33 15114
5 0.20 0.33 1414
6 0.10 0.00 1114
7 0.00 0.00 1114
8 0.40 0.67 1414
9 0.70 0.33 1414
10 0.60 0.67 i
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unn T3] ATUAANNENNARITRRAL(P) r ANRLUN agulua
1 1 1.00 0.00 1414
* 2 0.90 0.33 1414
3 0.70 1.00 i
. 4 0.90 0.33 11414
* 5 1.00 0.00 1414
* 6 0.90 0.33 1414
7 0.80 0.67 i
8 0.70 0.33 i
9 0.80 0.33 i
* 10 1.00 0.00 1414
2 1 0.00 0.00 11414
2 0.70 1.00 i
3 0.70 0.33 14145
* 4 0.90 0.33 1414
* 5 1.00 0.00 11414
6 0.80 0.00 i
* 7 0.10 0.33 1414
* 8 0.20 -0.33 1414
9 0.50 0.67 i
10 0.80 0.33 i
3 1 1.00 0.00 1414
2 0.40 -0.33 1414
* 3 1.00 0.00 11414
4 0.70 0.00 i
5 0.10 0.33 1414
4 1 0.80 0.33 1414
2 0.80 0.67 i
* 3 0.90 0.33 11414
* 4 1.00 0.00 1414
* 5 1.00 0.00 1414
6 0.40 1.00 i
7 0.60 0.00 i
* 8 0.70 -0.33 1414
9 0.70 0.00 1414
. 10 0.90 0.00 11414
5 1 0.60 1.00 i
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unn i ATUAANNENNARITRRAL(P) r ANRLUN agulua
2 0.50 0.33 i
3 0.70 1.00 i

* 4 0.10 0.33 1414
5 0.60 1.00 1414
6 0.30 0.00 i
7 0.80 0.67 i
8 0.50 1.00 1414
9 0.70 0.33 1414

. 10 0.90 0.33 11414
6 1 0.50 -0.33 i
2 0.60 0.67 1414
3 0.50 0.33 1414
4 0.60 1.00 i
5 0.70 0.67 i
7 1 0.20 0.33 1414
2 0.20 0.33 14145
3 0.40 0.00 i

. 4 0.10 -0.33 11414
5 0.50 0.33 1414
8 1 0.50 0.00 14145
2 0.60 1.00 i
3 0.60 0.67 i
4 0.70 0.67 1414
5 0.80 0.33 14145




259

3. mgﬂifﬂgaLmuﬂ'uﬁnmsﬁmum%’mqﬂs:mﬁﬁﬁu%'ulil'f%'sm (wuw B-1)



260

511979 42 agidiayaannuuuiiunnnisinuuadpgiseasfduiugBew (W B-1)

a

BLaeY

o a

Tdsunsun1siaua

.
a

NAUN

Tdsunsumnsnamua

¥

NARBIATIN 1 AU 3 AW TUNITARLLLLLWAN

1.

nsiaue g Anle uarlndides
animation

N19@319 background figneny

N5l power point waz excel Tuanuaay
nstaualugluuusiuadt uazannii s
Nl

nseamyidaelunaay

L‘Vlﬂﬁﬁ?ﬂiuj

1391 Power point 1#inaula Aaagaieen

ag1lnannImMAaIniIn 1
1. firaudiasnszauimaiinudasslilsunsutinaue uazlilsunsumnsaniuan
2. g luaundinla

nsldgmnslunisAurniaindeyalunss Excel
Tneaniy graneaiin n1InsIRaaLAINNgNFied
m@qgﬂlmﬂ@ (Data Validation)
nsuFunsnannmnsafiaselu Excel
NMIANU TGS

a roa/' A ° v ¥ a
nsUszanana / AiAseiiannnil excel s dom
01l
N199ININTUGI AIUTUNNIIETUNIATIA
miﬁﬁ’mﬂ@mn excel 11 copy &4 word ¥#8 N3
uilasdiagiaann word liiflu excel
n1stidiaya excel 8adlu power point
adl o ° ' IS 2
T8ansng 7 T excel gRaRtuanusing o Hezlsting

WANALAAZERNT

NARBIATIN 297U 5AU 91N 7 AU LUNISARLLULLIUNA

1.
2.

n19911 Power point liunaula
nsasranalugluuuiiaasans ieiln
AN 7] AN MUAazLsTIAN N13A319
ppt Fiinawla 1% animation

N1943514 template 19

n191N template A1N internet i
nsldnatia $an5au wansilidu
siifaesiu mainiaus waiiasing 7 Koea

Winladng

BENFAUFEATFN 7 109 excel

dl v o d‘ 1 v
naaenlaedeyanullsunsuay < U deya
excel -> database
n199N pivot table

NN9AINATHA N19AUrndiaya

nsdnfiugudeyalnelfuddesnen winendn
dinlUlwdesfignudieyastdelu

. v
nsutltlszinndeyansiesnis

A Y b4 dl9/
ﬂ’]?L@@ﬂlﬁ‘uLﬂW’]%“ﬂ@H@V}ﬁl‘ﬂ\m’]ﬁ‘



261

M99 42 (51R)

) Tdsunsun1siaua Tdsunsumnsnamua

aqUNanIIMARBIATIT 2

1. nsaialdsunsntiaualiiiaula

2. fBausiasnisBaudinatialudaesldsunsuiiaue uazlisunsuananeAuou
3. ansnsadielsunsudnuansiiinisdenlaeiugnudiesa

NARBIATIN 3 AU 15A1 A1 32 AXTUNITARLLLLLIWAN
1. nsdaiuieyaesAnsfaaiuRugauu n1saaan

LULANNNNIARLAL NTLsennana
NM9UsENIANANIIUD TURUGANYULBIAUETWINUN
psauAF lugNTu (Ana) InanfFaudaui
o o a4 o a Ve
Wity Ane Niag W Ane Taae3uRuy ldueiu
ana lalH5uRugauiu vise 11550
nsutivilszinnasdnanlazuRugamu uanany
ANANT AINAUIURR AN szinniasenig
2. N1IEANLLEN power point
3. N385 19n WAaew el power point
|l [ =
ARG GRS power point (LALINLWAN
\@eanypilszna)
wmATANNTERNWLLY power point . IHdnawla
WNNZANALNIT 191
4. NIUNAUBNAINUFLE power point NN
aanuILaaula
4 e
naaenleei slide 81 < 11 template

5. B81N591 WAAY icon toolbar Tiinaylsting

6. n19 link fia3yaan file web link %'u“] wunn’lu
excel
NI9UNINANTN excel b power point

7. N3 link fa3yaann file A 7 111414 excel

n138319n ARl lussuy excel (M0 61T l)
nsliges If (Tuge) sanlduuumiiugiioasl
Waridu N law

N96T19NTINNAUBINY



M99 42 (51R)

262

HiFauy Tdsunsunisinaua TdsunsumsnamuIm
AU
8. NITANUITUGAT If
miedeuliai excel
Macro VB
9. N34 animation visa n1sasegniauliingg  n19ld excel a319gtluuunisinauananisAIUIN
iauedeya Inglideyamesiaiaalugy
2894 chart A4 7
10.  Fedn19tIANgsinu power point lunag  Feenistiimanug excel Wudasusan 405 deya
dauananu wazussenelunisliinnnsd  Tunievinanu Auouata Munauue indeya
AUNUIZNNUANG 7]
Fiean191IAIINEANY power point UFutlge
naniauenaaliiaulantviu
1. madari template NviaueRRTAR NNIATUIDILATNENIDLFN 7]
799N background Lmewmﬁl@ﬂm?{ m?ﬁﬁmﬂ@ excel ml,%'ﬂwi'a power point
AN n19tlszeins i excel advance
RECRNITTTRRERERATE LT
NNINIANTNAIENTH
N3N
12. n19RBNULLIANLAY power point 1Hitaula sl excel Tun1sAtuanugassiaey nsinana
nsldsihisanala Usgnatnistiiaus FOLATIIENY
13, nadiauenasulugtuineng 7 N1IANUIUGATHN 7]
14, nsthdeyalu excel 1611 power point n1sAUIlUgRsEe 7|
N1991 video presentation Tu power point
1. n13 sum gasuiingi1 1 slautingi2 uazselilites

2 d
azLlHAN1ImMAARIATIN 3

1. N17g5191sunsNdaue L auwla

waldi sum sanfluilaqiii

2. fBausiasnnsBaudinatialudaesidsunsuiiaue uazlisunsumiseaiuans

3. annsnaialilsunsuaunsliiinismenleaiuguiieys




263

4. aginaanuuuiiuinnisEausdusugizau (wuu B-2)

au



511979 43 AgUnaanuULLunnsEeuA iy

a

FFe11 (WU B-2)

264

2.9uUfANY

3.MUAINTAUN

4 Rafulszvin la

5.&8a1u1nla

A LyuEeul - , . ; Bue lulsa
N . Anviuadndls  anadllldla anfige lunis snndige lums
su azlstie oA . , i , - , 531
numsEaus adals (FauaInnu (FauaIIue
Tdsunsninigua
4 . o =
NARRIATIN 1 TUU 3 AU °lum‘mﬂml,1.|1.|1.|uwn
1, 1.meBusiunsld  RFuAnagann anungnld N9 Auuunaaeuly
NUUATANANTR  umBandinediu famou tmne Aneaelug e-learning #A
galisunsu walfgunem UHUAR Uazin wazlddnlalu
Taua 2.113 T Tunng Mnaaawlug slide
. s 4 . Y < ao,
AanriaANn il Wwaldlunng
Viuama 3. N3 Pauld
qAn19zLnw
UNUWOH AN9I9UAY
H989ANT NIV
=
Aweaenlug
2. nmseanuuuslide  1H5uAnas ¥ lunseanuuy
WNAN uAaann Power point 1w
Ianaineaiu  msdaue
A1788NLUL
. 4
Tinauei
“aINUaenNInil
3. n19DesignSlide  l#FupAaaf ¥lunsaeen GUCRELTIT TR
, Animation WaAnleng WULWAZNNS aaudnla
A5794979AN"3 Taueauls
TNAUBITU BENNAIENTNLAY
a 1 d”
HgniauNINTL

& &
@@ﬂmﬂﬂ%“i’l@@ﬂ\‘iﬁﬁ\‘m 1

1.

2. fBauaunsninangisasiusunsumaauasz usunsunisnaue 14 lusunni

NARDIATIN 297U 3 AU AN 7 AN TUNITARLLULLIUNN

1.

N17RANULY slide
WHUNTW WU

ZFMN

Sandanudinla

Tun1iLaneny

1lunng
dsznaunig

N9

=

=
4

v al v o v a o I3 .
QL?EIHVL@L?EHE ﬂﬁﬁ‘@ﬁ"]\‘iLLNuQN AT INLACNNANANT N17RANLLIYU slide

NNFANALLAZIN

AN lulunng

TNLaue



M99 43 (s1R)

265

2.9uUfANY

3.MUAINTaUN

4 Rafulsziin la

5.&8a1u1nla

A LyuEeul - , . ; Bue lulsa
N . Anviuadndls  anadllldla anfige lunis snndige lums
su azlstie oA . , i , - , 531
numsEaus agsls PEEuaaIinug FEunaINiu
2. wedansaiede  Mlinmumalia 0 lddiuldlune nnslsEnUfusle Notebook @
LAZNNTENLALD NRCV RN LG AN Power e an T
HALTUgQ nsnAued point 1val#ins TdlFusulidu
gwlanngdu  duawasulunig 1afiis 2010
Useguvizanis
=
AUTNT
UsRnsnnuay
pappANaula
3. wAlANIIATY ansngntinly annsodinla iy o e
natLauadiag WAUIALLEY 9% mATlAnag anfianens
nrladiananu REYRITATG pANULLADUAY Usgenel i
o A X o ° % 2
nw den Aata power point 1 nnatnLauae dinlannnaiu

FNe] RABAAL
dURBUNITNN

4 4
Aweaenlug A
3 £ o a
A innsinanad

AaisuLaula

a71nan1IMAaeIAiIn 2

power point 15
naaAaLiin
dnemanliiion
fasaulFanNg

P
NN

1. fireuldBuug walian19a319@e Tunaun1IMIININARE WY
2. fEananunsnin Wmw iU

NARRIATIN 331UIU

1. {784 Microsoft
power point N9

1 &laslad

2. n19911

d'
Aweaenlug
NN U
n3 1 Taseasna
B9ANT NNFATLIAN

~
AMnadawlug
Tneildnm e

wazinle

=3

14A% A1n 32 AY TUN1sARULLLLWAN

T Edunas
M9 19
yigula v i

gnianlua 18

TNLaue
Uszananazilnn
LNAY MRIALINNST
=X o
NNaLTN 1iTe
AuuUn
AL AR
Uselgmllu

AUIAR

2.5aau dauuay

asungliidinla i

VWidrasenistn

hie

Ele e NI

dl 1 =
AdalieeFeu

wantasfull



M99 43 (s1R)

266

2.9uUfANY

3.MUAINTaUN

4 Rafulsziin la

5. &Ma1unnla

A LyuEeul - , . ; Bue lulsa
N . Anviuadndls  anadllldla anfige lunis snndige lums
su azlstie oA . , i , - , 531
Aunsiens adgls BEurRIinuY BEuRing
3. Power Point 1HFaugnIg WAn3nlallin - enansdfjaeulan  mnlidensiuey  aaliisendn
feafiunIg HaneufaE power point LAU8 faadicyenansd  ad fgade
. y 4 4 oo . .
Wnaueufos  power point vl uEeItu nmunauli e
NN program 2010 {1 gavyw Seianii e Wi
nwadeulin ANIAUNINNY anatiliiaus
nsnElunn enansdildaeulil  Widunig wua.
' al v A o v
UL Geufuainuane  vivernluld
s s 48
mndie 1 Andal  usseneluisng
sl uazaz
il
4. n1avin Power dunsBewiuar  a1aned B
Point HUnlfjuim tnem AUUTINA Hie
v a k2 9
fRawarnmnld  asdzainnm
ANgnGEeulin  dnonwlniui
UhuR Twanue? uazfjBauanunem
Geulunsen o i dfuRenulsm
pNfiananIdaeu
Tuumiew 1)
5. moaladme funiseusnili Mlumisduiaue @i e na sl
AN N394 A MRS N9 nwndaulng T1lsunsu office
N9 tsrlamdanunsn deyaduned wazlddely 2010
nmwedenli ld  Mawlsas UNUAHINAN alasls
o L
mnuazidesly ednesian
alas auedoys
6. PowerPoint2010 fumalialudn  dauecuuuy MHasliedfjiRese  gunsnluaz
o o 5| 4 al ' d‘ A ar ]
nsiauely inndudsrlend  Boudemanzas wisaaedyly
gtluuusine 7 FRa AumaNgnldEau Wiau
niad {1
7. A3nns@iepower  Huae@aans Wlunsthiawe  TARnU[UR f1lnsnl computer
point LazN1T atineinsdalaiing NaINUNIATINNg LAZILL internet
Haue eauwgueede  lidaouaula Tainsan
a ] = QI dg/
e ethafes  wnBedu

laliieanafiaaa

a

FMAYERES



M99 43 (s1R)

267

2.9uUfANY

3.MUAINTaUN

4 Rafulsziin la

5.&8a1u1nla

A LyuEeul - , . ; Bue lulsa
N . Anviuadndls  anadllldla anfige lunis snndige lums
su azlstie oA . , i , - , 531
Aunsiens anals FeuaaIinu Faurainu
8. N7l power 15538n95i09 7 Wlunastaue  enansdaewdinla  gunsadit
point lunng 4N LU NNg NAIUATU e fluiwes ld computer sl
wiauah #5790 A1ns lainGaunnau  internet lalnsaw
4 J . Y
nanuane sante  nawadaulu ld Tunsldaunnan
tselamdraenis  @es ufiv
ik power point Tu
msiaualu
gUuLLping 7
= ¥ 1 o a a 1 1o Y
9. Mrenuul Faudiladne illednnanu Baudelddudeu
Presentation @2a  wazdilsylemisia  dnu
uaziuasy RIS N presentation NN
Ansnwazlal
&N
10.  NITILARBIU 19597 power % lunnsg Power point
power point A¥i1 point @A14130 wuameaul anwadaulm
aulauay wewldiannnds  guUuuu power
2 o " Ny
LR LRGH! Meglumauusn  point THaaeaw
annsnldgnian  uazigniaunnn
IHvannuane T gunsnmin
QRPN
i L5 16
1. meaueay @t @wnsoillE lEeusAdluin
uazdtnisannn  Wlunsdewe  AunistEuesy  @uw nsBews nng
power point nuluguousine 14 At slide
IHuazganld show
gniaulunig nwedeaulig
TduaNINTIY
12, mslieresile maeddeants W01l lunns Feugaslua naEesi
s luribbon 1 MFUfiRasudu 4mvin power NTIiTiesan
laimemeny detaelfiananlis  point WaLeI version 184
Al @ Tu Wianuaula software
) al QI dg/ ar
nnsldidas nn NNTelu Ay

LNAY NN

animation



M99 43 (s1R)

268

2.9uUfANY

3 U150k 4.Refitlseniu la

5.&8a1u1nla

A LyuEeul - , . ; Bue lulsa
N . Anviuadndls  anadllldla anfige lunis snndige lums
su azlstie oA . , i , - , 531
Aunsiens adgls BEurRIinuY BEuRing
13, MFounsain MHeonsFiianan @ansntinly Tnaaaldiuy
suuvalad s 2wz BONULILINIG VATBANDFIN 7 LU
g3amsens alad Aseedle  taueauld power point
v A A ' a
waznseenuuy  Widenlunung NNNdA
o v 1 1 o ¥
msauedeys  wldeetiiunld
UANBINITATI
alas
14, pgionaain nnsEauginli 1 lunnsinaue
v dl A
a9l power  AunuiAzasile A

point N3

d'
Aweaenlug

N5 1491 power
J

point iaguang
i

s18n197 ldAel

PRERNL

o &
mgﬂmmmmmmw 3

1.

o A va w v . a % 44' ]
QL?ﬂuiﬁL?ﬂug N19497 slide LV]ﬂuﬂﬂ']?@ﬁ"Nﬂ']WLﬂ@'ﬂuiﬂq N19aaNLUL slide

2. fBauannsn i lunnsiauesu aansaileenuunnistiiauessls

Tdsunsumisnemuam

NARBIATIN 1 AU 3 AW TUMITARLLLLLIWAN

1.

7l Tlsunsu

excel TUNANY 49

A3 ldau Excel
AM3iFEN ARNTeY

v v
AAHA N1TRT

U

2

wy neldgms
ATUITU N19A514
n3 W NN9IARaan
lWd&ann word ->
excel N9

ERRE LIk G

Anan Md s leemd
a
A

a Dd‘d
msBeuifinnag
. e
IHaeen fagl

TGN L THIEEN

Wlunasinawld  e1ansdflaiy uay
tszunnfatay 2BLNYA

85

Wldnumounar  MHEews nsld
Hnldauas v

a
UWNAINH

ABNNLARS

= ¥
nisiigadiayaly

n3naaadlinn



M99 43 (s1R)

269

2.MuUlinny

3.MUAINTaUN

4 @anlszvinla  5.@%8 010l

A LyuEeul - , ; . Bus lusm
N . Amviuagndls  anadldlEle sniige lunis snndige Tums
su azlstie o . , - , i , 53
fumsEaus agnals FRUTRIYI LFRUTRYIU
3. mslieu A wilfiesdnen  annnsanily Hwesasiiadon
T1sunsw excel uagilnelwindes  dssgnaliiuen  Wiinawls
maamnmily uaziall Mnagld amnn 99059
FLAT N139 tszgndldiuey  soAuMEIAY
naw uazng SRNERI G Ifazman s9m157
dsegnalanusing  dsz@ninmann 893U uazgnfies
B
EIi
2 1
o
@‘gﬂmmmm@'ﬂ\‘im\‘m 1

1. freuldzews nisldullsunsuniseaiuan nsaseanam
2. fmananngn W linumonuadinduiieuiin

NARBIATIN 2 AU 4 AW AN 7 AY TUNITARLILLLLIWTN

1. meldeu excel
nM9mziideya

/1N excel

2. nngldan
Tdsunsu
Microsoft excel

2010

3. Annnslden

Tisungn excel

invineennsld
ulisunsu
excel 1ism157
LAZAANITRINIU

S0 g
NaIaL

i@l

. &,
wigsing 7 Ieting
anfesiaztinly

]

IR TRG

a

AN

a U a
FeugnATNANIg
1911 Tsunsa

excel

UBIG PR
LAZN1TAANT
v
fayalunig
19U LA
WAUIN1FIALTL
fayaannig
a U
Feug
1% lunnsg

v $ %
gaundiayafiu

NNTAUETNAIN

LANBNIANEYSTNE

fas9us9a7n
NULNUAN
uaztiaualu
ruudeyania
UsziduiinAa 12
szifin
AANIANIINNY
tsznaunng

UNAUBITUAN 7

a dl v
nngesunandinla

9081 LAENITUARS

RN

dsznaunig

Us9engl

gunsnlfinenls

Haaunaude unghilaunsnlu

o va 1 v

dnonuwesFan  excel gl
= a o 1

WATHNI8ELNE wazealufiannu

i g EGew  anilulungld

ANNNNTADLIIN uen A

:/J aa v
dunw 350114



M99 43 (s1R)

270

2.MuUlinny

3.MUAINTaUN

4 Refidlsziu da

5.8Maunnla

A LyuEeul - , ; . Bus lusm
N . Amviuagndls  anadldlEle sniige lunis snndige Tums
su azlstie o . , - , i , 53
funsiEaus atwls BEuraeing BEunaIing

4. welAd N ArddeiiGeu ¥ unns a1asfaaudila

Wdnuazdeeen  amnsninly ATIRABLIAINN / 813738iHlenans

faya N9 tszendldlunis  gnéiesaesdiays  dszneunisaey

FIIAFELAN fiReuaseld  dilleonagndies ansnsarin e

2 v A dl v = v ] QI dy
gndieswesdeya  eunnies wndleadfisdln  dinladneBeau

NANINARDIATIN 2

=

al

FeUdINNTD INTNEE lun19 1 TN 7R T19 A1 B

NARBIATIN 3 AU 12 AW 21N 32 AU LUNITABULULLIUAN

1. Tsunsumisng
excel ﬁyim’]i
Uszgnsflflunng
vivdiaya nn9

Uszaranaiiaya

2. lEBsnnaslden
excel WNTY N3
AUUA N3
v o v
Tlasiutaya N3
a3ty N9
TIENNUEA

3. n3ldanuieaiy
.
fayanuin uaz
Tunanlu
NUIANY LAY
gunsaAuandld
281999AE0 AU

v dl C?J A
1RYANTI TR

dlunisdssyneld
1 LASINNTIN® Y
n13Mdenn anvialé
o a U
WawINN9EeL3

v a v
UBIGLTEUAQE

¥ =
ABANNITNUNIUBN

70U

A1UNTNAATUADU

lunaifivdesya

gunsasinly
Uszgnsfldiunis
nauldnnan
NIAN LAY
gunsarinllaen
4
WARY LANLIALU
.
ANNAATKINEE
excel wnlaidinla

visanlails

i a5 My

Ao
JUNNaY

anastfannls

$2 aal

Winla Jan
1sznaunisiFey

A o
NBLARUAITNARN

annso ) Tlng

16

Tifdeyauacld

= 2
anunsaisaulidu

a Y o
Feulsiu

Atnsaauing i
o Baulu e
learning NAULAY
o A K
NINUTBHN

e

U711

agl
1. fEeuldEaus nsldeullsunsuniseaiun nallasag o nsidiauazdeeandaya
2.

k1l

wiyluezaaiiu
Tne usignanstl
aauluiy

nMENEINn



M99 43 (s1R)

271

2.MuUlinny

3.MUAINTaUN

4 Refidlsziu da

5.8Maunnla

aandeandnvinla

gl

A LyuEeul - , ; . Bus lusm
N . Amviuagndls  anadldlEle sniige lunis snndige Tums
su azlstie o . , - , i , 53
fumsEaus agnals FRUTRIYI LFRUTRYIU
4. maldldsunsu Hlselomd Aenansdaeun  enansdijaeula  wesaalidn
excel 2010 Bufiu  @awnsnt S Ul Simeed fiu wazmaw
nsldeuuas A foyald vinliifia  AroumnAIIEd
e a  aaa a v o
GIIGIGIEITR uwaAn H3EN9An  Feuasde
Tlsunsumngng dragiliddeys
% dl e d’l
U N9EUIN Nanysalung
¥ 3 % @
fiaya N9 naulfisaniia
a ey v
TAnifiayaiiag
Tlsunsumnsns
U AFNPIENTY
agldiayason
Aselatuay
wunH 11lA N1g
a % 4
Annnuufiladiosys
nstdinuas
Aveaniaya
5. n1efnmIAgnu 1 luna9in
Uaensizresdeys Fudiasanquass
nistidiayaann Auunilunia
excel Anaanllds i
word N19ARARN
a1 word NEN
P
excel tagih
Hapauuenly
s e d
dluadninn
f24n13 N3
RINAABLGATNHNN
2a3s0adaya
6.  Excel Wanuenadls  dalduFuldlunng nsFeuni
o dJ 3 3 b4 ¥
TAUNTl Az 11913 11991 faya liiang
QI 1 d’l v a om
Wnnuanndl diaya ng Ui
R TINT - -
BRI Tnnzidayalae
81219¢] LAUNY 14 excel



M99 43 (s1R)

272

2.MuUlinny

3.MUAINTaUN

4 Refidlsziu da

5.8Maunnla

A LyuEeul - , ; . Bus lusm
N . Amviuagndls  anadldlEle sniige lunis snndige Tums
su azlstie o . , - , i , 53
Aunsizeud agals GauTaing Gauraing
7. neineuiy ARNGTUgA
v
finaga ng
a ey v
Aanziiayaiag
Ttlsunsumngng
U AN
agldiayasion
Ttlsunsy 1nla
8. maldeu i ligunenld Wl 1 lwanu anwnsnliinayls
Tsunsu e o lieing
Microsoft excel gniiesuaziinlyl
2010
9. melElisunsu 1itlsz Teimsin W lunniieuls AaNaLAas
excel U g4
10, meldeu A wigfiesdAnen  dssgnaAldduen  ineuld ade
Tsunsu excel waginiwintes  Aivinagld anumn
SDATUIDUFIAY
Hazaan g90159
= y
fvlu uazgnéie
11, msleuexcel  Wawinwenisld Wewnsdaiu nasesunefidinla
mwazidieya  aultsunsy fayaannig
a b4
Beg
12, msFaugneaiy  inlildEeus Wl luns enansddaemey  deyanldlunng
al o a o;m a o a a =X
excel azBeadpiaunn  dfuRsslums Aowszi@ean  En
dy v
bl ajlfeyaressny wn

& &
@?ﬂmﬂﬂ%‘i’l@@ﬂ\‘iﬁﬁ\‘m 3

1.
2.

NL‘?EIHVL@L?EM? mﬂmmiﬂmmummammm
NL?H‘H@’]N’]?Q L‘WNWMWJ’]?LI? LWNVIﬂH”luﬂ%‘I‘ﬂIﬂ?LLﬂ?NI?]’]?’]\‘iﬂ’]u’]m

a7
1. ARUAUBNAIN

2

l?]'ﬂ\‘iﬂ’]?L?ilu?

2. ifinsinzns e
3. N WAING
4. thang 1 euls




NMARNUIN R

ANan1sannanssu/iand1slsenaunisizaus

ARenIAANANsTNAMIUERAE
= 4
\ananTLsznaunisisaug
e e x Y A . &
MEiTEUnT FaUNANANITATINABUATNNTIUNAUBHAIIUTUES
LA A A 3 <
miheeun2 reennslillsunsunisneenudugs

1

ANBNT 19 eFront V. 3.6 A mFLEdinausu (Student)



274

ARensdnnanssNd MTUERAE
= A a P2 A 1
JULLUN ST EUI UL NANN A ULAZ NN iU WU IR Ae]Y

eI NN BUsRaaaTInAMILE Iun s

uangasinAlulatigasaunANalNnLlsEansnIwnIsvinnuy

apnipel

AAE191

=)
8o
ed

Hamilsoynyian
= 9 1 = '
AN2NNIANENY W AniEANEANERS

WAL ATUATUN I 9 Uz A1 URAT



275

1.AanuiunnuazaudAyaaslom

=) P 4 1 Vi 1esr O va o ¥ o =2
ananuatyuaes nsieduesilun Inaenzilungdanieu adelaminisdnm

Uszidul5rewazuunAnnisBauiaet el nsdauitlvel (Adult Learning) nnsaat]lviay
o a L) o LT o g L) o

|
ol 1 I !

N3BLUUNANNATBILAZ NI B LULE At UNe AL T NN B SR aa AT n A I LE Inn 3t

Q

Y va o

NU WazaUseRneadaq g IRl FnL LU AT a1 NNIAa e TN An Ty

u
|

= a o 4 oy VS I YP N P Ty 1o o
nsAnwgtuuunsFauE NNz anwawAtiunsEaungu g aunlug lunidenieu
1 v 1o © = nzll a v U

wmaenanE Il daninu dnisuanseanlugduuunmuesanla Sl vungpaudeanislunig

o a = = > 1o o , P g = = :

nfanssung Anwnlaendseanalunidenien  daananilifuwnainaueiiaannlldy
1 nI/ v 1 Y o aa A aa 4dl =<

neiganzenu wazaiiulunfsaiegas e LTI nIeemed InengUiuL1eaTInnmaung

~ = o o v p < A o = A
W‘ﬂs]ﬂ NAUNTANNICLLIARDNNNANAN VUINNITNIURISHUNUINNINAUNUNATALATA SNEY

A

TTmsnuL 2an lun2@awsnldinasantsBauluieszawizanis@auuuUNdouvtin linaan
| p \

v
Q/VVEJQVVLD o

wangms vinliinsBeuliseties ugiassasianisEeng daiugaalinuuuanienisiemm

a

suuunsBeufuuLnaNNALAENNT R UL A WA TLE el danneu ienn sdaidTH

o

nsBaudaaandan Iaglid19anusiasnisBouiainngy  dszanns Tungui{lundarinau

o 1%

wazAnannguimnenaiguazaaenTy  utiveanidy 2 ngungnn 1sununIAighe

d9

dniineuian sasuazanuAsaLATY N9ENMeNIIWRILNEIANLAT AT HITATT NG TH]
ardndaulunjanilu dindsanannszf Euidigsnng wilnouiasan winemlod 41w

134 AU ﬂ@:w'?i 2 FAUNUNIALENTY 13 Tiadl 1990 AiAanuaw 50 ALLAzLATaTNEENATes
unFeulseEaunn Um0 260 AL §idadnmannuanla AauE esnisEeuuarluuy

PR | e 0 y , ~ o = 44'
NIFLTEUT i ‘IJ?:ﬁﬂﬂ?ﬂQNMQQHWQ&Quiﬁﬂ;@ul @Lu@ﬁqﬂquLV]ﬂiuI@ﬂ@q?@uLVIﬂLL@zﬂq?@'ﬂ@q?

o o o

FA8RalAdanTIn nangaamATulaEATANNAINOINLIENEN NN TIRANNAIULAY

o A v o P = - Yo o Lo o
anguluA1uN3EeuE n1ganunan TunsEeus aniun Tunnslaulianug lunids  inenu

3

a o 1 I3 ¥ K o a = 9 Iz [
'&g“ﬂNﬂ’)Lﬂﬁ"’lzﬁﬂ'&quﬂl’ﬂ\?ﬂ\iﬂﬂﬁ‘Zﬂ‘ﬂ‘LIﬂ’]?L‘ll’mﬂﬂﬁ‘mQ_J”lLL@ZLL‘HQﬂﬂﬂ’]ﬁ‘Lﬁ‘ﬂug“ﬂ‘ﬂﬂ@llﬂﬂg el
dl 1 =2 | o a & 1% dl ! (3 ¥
LLUU@@UD’WNL‘H@'}Wﬂ’]?ﬁﬂHWLﬂuﬂ'ﬁ‘WﬁJ\lu’]Zﬁmﬂfyﬂg’] Lﬂuﬂﬁlﬂ&l’]ﬂ‘ﬂfﬁﬂ 61.2% LLWVLNW]LL@QEI
o dl | =2 [ [ a o 1 dl v a Y Y
17.9% ﬂ‘].lﬂ’)”lllL“T]ﬂ’)’]ﬂ’]?ﬂﬂ‘]:l"]L‘]Juﬂ%‘W[f*NuﬁQELLﬁ??NLL@S QTUDTTN ﬂ’]ﬁﬁ’)\i’)’]LﬁJ‘ﬂi@L?ﬂHELL@"J

ansnsnth lldszenduazimonlaeiunisinauld fesnsuinian  56.7% fieanisieugiian

1
a

frumatulagiansaumaninign  47.0% nguldsunsudniineunnniign  50.7% guuuunig
BeuslutiasFaulussAumnusiasnisuinig A 12.7% WaissuiauiugluuunisGouglu
wuveanlallusyAliaaNfieInITNINNgn  41.8% uanwdniluniderinanusiesnisgluuunig

2 [

=l dl dl o 1 v v al
LIEIUIN Lﬂum@@ﬂ@ummmmﬂm wnanluiiesizeu



276

'
[ P v o

AN lananisdisranananla Anudienis uargluuunismeus udaf  3dei

a

a o -QIII/LS/ 1

nansRAe i lFunUiulsegtuuunisBaduuunaunaiuuwaznismauiuuug aneuduiug ug

o

Forinem ienssadunisdebnaendin uasillgnisai udngrematuladiansaume
iefintlsy@nsnimnsingu ImwﬁnzﬂmﬁL?jﬂuﬂﬁm@umummmﬁm n1slunIWRLIALEY
niumalulagasaumnaAuaznisinang liliulddunisyieu lundngasnanalisdauang
Sﬁ@WﬁTLLﬁﬁﬁﬂLﬂuz?hﬁaﬂumﬂﬁmﬂizam“ﬁﬂﬁwiuﬂﬁiﬁﬂQﬁué’ﬂuﬂﬂiﬁﬁLmuﬂmmm N19LTUI3

[ ¥ [~ o ¥ dl [ o o [ (<1 1% =2
ANNITUBHA Lﬂ‘].l‘ll‘ﬂﬂ;lJ@LL@ZZV’Y]MQCIH.I@N@V]L‘]JHWQLWH ﬂ’]?ﬂ’]L’&H‘ﬂ\‘i’]MiN’]’W 2ilueuNI9FNEN

u

1
a

nstsvgn Aunn viseanuau o iludaniandiAny  aeludaqiugenduaslAdnuniunuam
Tunisa31eda tauanasiluatinaunn failaqiiuavedlugtliasdenanas visadlafhanas
Tsunsunldindadszinmnistinauednanalilsunsuusias lisunsufiazdansuqaian A

Hunfluanuilsladtaasaansiasnislunismewd  Tdsunsnlunisaiuazannn - alafine

) % a 1 @ A v -ai o % 1 1 1
UILAUR ﬁl@ﬂN’iﬂLﬂuﬂﬂﬁIﬂ?Lmﬁ‘Nﬂ ARRANNITNRATINGIUNALUN muﬂmamwwma anunsnld

|
=

4 = o aa val % =K [ dl dl
damanu N @ae paenaunniAdau e luaneudnleasludlas lfanfqe aailuaehn

ada a o

1 ¥ 1
ansatnauedeyaliuuudansime M liuiauatings ils uasthfnnuean uiay

|
= |

tiaue arunanszanmnumn uazasvReaNaRNRWeN auadayalunaidumnis uay
aned arulisunsumnansauiuanuilelusunsund i dunnnludnsineumdulysunsn 1y

o =3 % Vi [ o J A o’:/l % J
nsauanuazivdeya {lunjdanianunaisrinuaisnsaldeultsunsutseansisaasls ws
Tundngastiainisonlitg e lullsunsuliasuynacusienisuazaiunsniig

a

1sr@Ansninnisninawls
2. Usrnyuazdviung

UFrnuazunanluniszeuiaesd nnfouuwsid nsnaasniswaun §izeu ne Gowuj
we9fjFuuarin hlgnisulasunladluinu nsmuiaues dnistindseaunis alnnsEauslils
Tuauninisedsimudianiaunsennazussg A NfiaInsresnues lun1s B Tnan
¥ ) = v [~ = Y o o s a Yo v =
funzinisefastuiegnuisanuazatnuazdntszaunisniniseudsatiuniszauing

o 9J¢=I v -Qll v a Aﬂl o a = Y Aa o
nengein s ligeEnmanzanas langAnssunauaueent snaziin fan1sEaug Bdaninu
TEEaw Wiuaowddty  awnsafnaztihlssaunisniazadnainnsan il 1l

a P

Aa o o Ay Aa A v — o °
FIMUT2aNIU Lﬂuﬂ?xﬂ’)uﬂqﬂ?ﬂugm@ﬂﬁsﬁqm LL@fzm?Lﬁ‘ﬁugﬂﬂNmﬂLum N7k ﬂug@’)ﬁlﬂ"l?uq

'
a aa o

[<1 o a ydl a dﬁl a 1 rd‘ v a | v aa
muLmLﬂu@ﬂwmmmmmﬂugwmmu%ﬂuummzﬂmu [AMEIY) mmwmﬂuaﬂmwmm i

=2

ANNABINNINNIEEUEVBIAU 91PN AIALATANUALNUNNTEES



207

3. TmnLszavAreanangms
dl v yva = v Y o v ://
1 .LW@GL'VIE;]]L?EIHN AIHIATUNITUN Lmuﬂmmmm::mﬂﬂﬂﬂmmm'm\‘ﬂmng\‘i

2 INaas1 AT NN N7 189U T SN 2NN 9T AL ULA NN T M TSN T AN FI19901

yya o <

3.ivaduliifjFaunseminuiingnian TunsiEWIALEI NN LU T B aUS AARATIA

a

4. e lunangms

dlgl o 14 ° ¥ a 9 = dg/ 1% =
Luwﬂuu@ﬂzgmﬂmmﬂm?mm PIENNNTLIEING T91aMAUMATRIAT AN TAUIANIN

|
a

g 47.0% wazidwlienngzeuasnsniinndssgnaldiuanuls uiailubem nguidsunsu

q
1
=

zaﬁﬁmﬁuu’qum@?m 4.32 S.D. 0.837 a1 Advanced Microsoft PowerPoint Presentations
NNNgARAY 4.17 S.D. 0.863 uaz Advanced Microsoft Excel N1nigataag 4.07 S.D. 0.990
dl [ % = dl QI a a o v 1 a
delunangnanatulagarsaumeanaiindss&vaninnimieu  aztlsznavllfosmiaieu
2 widaaeu THun
WIBEUN 1 ATANIAINABLAZNNITNAUINAIIUTUGS
UNn NM9R8NULLABUAZNIENAWE
* . y = .
UNA 1 BufunsdnuearAuaniRvesilsunsutiniaue
UNN 2 N133aN13aA NN 1 ana (Text Presentations)
UNA 3 NM3AANITFUNIN UNWDH ANT1UAZEIeIANs
o o o
Unil 4 N1gAaLAN NAdeulg AanaNNAIY
uni 5 NauanenIganeadlas (Slide Shows Revelations)
unil 6 Ngulszensldanu
Coa . =
wiaeFeui 2 N3l llsunsunisneeudugs
4,4y y =
uni 1 Busunslnusarauantmvesilsunsunisey
uni 2 nsnineuiudieya
Nl 3 N9anIzidiayasnn tlsunsnmaneenu

Unil 4 a39aeeuagliiayadasnisslaiuasiuun

u u

v o

uni 5 unlas (Macro) Suneinaulugnes e sing, I

uwﬁ 6 NNIHARINATLA b mﬂ%@uimqm (Auditing Worksheets)
unii 7 nistidinuazaseandaya (Importing and Exporting Data)
LT 8 ANTRNMUAANNNTNENANLanas (Security)

unil 9 netlseneldanu



278

dl 1 Y o o
5.Wm/1ﬂ’1mwﬂmummw@ﬂ@;m
v a o 2 a P4 ‘ﬂl o 3// A
1.{BauarnisntinAuinatiansaiede lsunsunistianenaudugs uaznisld
Tsunsumsneanudugs llldszegndiunnsyinanu
2 feulfnuineznislfanuluuiyusine sesldoullsunsunisinawe Waunsw
M99 IUAIUBNIULAUBNAINU AT NITLINIIAAN T TR A
3. {EUul AN UAULEIANNN I LAUNNI B U AADATIA
a =
6.NANTINNITLIEUNNTADY
o 1% a = a P2 ¥ 2 [
annM9dsafinufanssunisBeunisden  uuuunisBeuslutiesFauluseAunanu
fieannsnnnTign 12.7% WanlraumeuiugduuunisGag luuuueenladluszduaauiionis
NNNgR 41.8% wanadng aidemneusieanisgluuunisGeuiniiuaessulaininndinig i
wanluiesBeu Auiugiluuumes Aanssunisauinazilunanssun s BeuuULNANNAIY
(Blended Learning) innsfnuun Widnsuannaudmiunisiauiuanagiuuuganiu lu
anmuandeNnenianIwuaziaianass lnaddhvanalunisuannans nneinates nalew
TufieaFeuing (Face to Face) waznsimaunisaauuuueenlail (e-Leaming) wintanialunig
= P ° v va & 1asr © o Al &
Beuduazanna  zandmdugFaulnsennziluniderinanu nasdnnisieud ugUuuy
HANKATY (Blended Learning) ansnsnnndssensldiuEaunduguainisiienyfmyn
wuaAan9EeLsE Il uaznisaaudinn snd3uldlunsdansBeufununasnay  (Blended
Learning) a9az liiiAaguuudsn1sasuninnzas way a1119nazuAtly i 1an annuin
o dl o va dl | b [
uangasnNzaniug saunidug lmajdanienu
N luN199ARanssN Hdunaunisdn 4 dupeu duaeun 1 3nseiEEuu (Learmer
Analysis : A) Tuaaun 2 szyilsvianiianinangns (Course content : C) dumauyl 3 Avum
sUuinsEEuuunankaulivizaniugEau  (Blended Learning Model for Learner : B)
< A o ax o = a4 o i~ oy = | )
dupeui 4 AUUATEN199ANIIELWNANLILAYAN WA WWLN19EEUTULILEAEW (define How
to learn the time and place of Flexible learning : F) patl
AUAAUN 1 3Lﬂ‘é"‘|$ﬁ§l§‘ﬂu (Learner Analysis : A)
1.nm3dindelFnyuazuuIAnnIsEauiaesE lunj (Philosophy and concepts of adult
learning)
®  NIFWRNLIALLAY
® AuFiaINIsuazNTaNluNIEwS
® 1NANANITDTRIRLLe b 1Ean

® NITLIUNNIEUUTAAATIE

® nNelFEUEAENINAULEY



279

23Lm’1$ﬁﬁzl§ﬂu (Learner Analysis)
6 v a = o =2 A 1 o 1
e 1szaunIniueE|Ten (818, @VTN, WA, FLALNITANEN)NITABNNANFNREN
wuuifulilaiutanianieadié Probability Sample wiLn1sguuLguns
(Stratified Random Sampling) AxANANMLE MG 818, szAUNITANEN
LUUABLNNNARNARINT TS
o pranmurduNlszasA(E e, TlFuu, feiulunimiey, danlananiinly
ADATITH A3EEITH NAINLAYT)
o yinwzaaini9n llldiuaunng
o v a
o AuANguEFeY
Tunauil 25z11lszinuiamuangns(Course content : C)
d” o
1.1Uanangme (Course content)
dgl 1 % v a
® LANIABLANDIFAAIINFBINITTRIE TEU
o AN AUN IR ALY
g v o o o
o avviuiugraNeNlasuilanaaniond
- P A o >
o Hanminisysanniaietinlllg
2. inql3vasA (Objective)
o fnuuadlmnielunisEend
o k% a P2
® AMUAAINABINT N9 EES
o nl/ldilszeneiunnsinanu
3. N17aankuL (Design)
= a o = ° Ao
® nsABANNMNNETNNY ] dalRuEnITUEUeNALATYIla
= A al Yo tﬂl 1
e ImadenluneBeugiIuAesie

a a aa

® L?HH@WNW?QU?%’]?M‘HL@QLLZ\]ZN@@?Z&Luﬂ'}?G‘Hu}‘

e3¢

4. n1sUseiduia (Evaluation)
a 1 o a P
® N9UsTUNANOULATNAINIFITEUT
a A @ =2 o A o
o fanssuiuuuLNNiRYTaNIINLNIUAING
e nstsziiunanin 1

a 1% v a
L4 ﬂ’\ﬁ‘ﬂﬁ‘ZLNuN@ﬁQﬂﬁiL?ﬂuL@\i



280

<& a ° P I s o va
AUABUN 3 ﬂq“uﬂgﬂLLUUﬂ'\‘iL?ﬂuELLUUNﬂNNﬂqumL“L“ngﬂNﬂUNLiﬂu(B|ended

u

Learning Model for Learner : B)
suluuunn9ies (Learning model)
al yvaa a Y 1 e o [~ 1 1 ] a
® nsiFeuiIniEew uarliidiunisudsiulunnin d15avesusazau urazdasy
AYNNIINTBLATAININATL
al E% a |
® nslFEUSuLLRAIUTIN
a E 1 a c & £ =
® NIFUUBUULNANKAUIZ I B UNa SIRLAY Wi Feu
Aa = 9 - 9-/‘dI
o aasrlunnszauiainuuasBauiivainuane

& = 0 as [ P = [ a a o
AUNBUN 4 nwumﬁmmmmﬂﬁaummnuL'am/ﬂmu‘wLmun'm'iﬂugl.mu
ﬁmue'm(define How to learn the time and place of Flexible learning : F)

Q

ATN199AN13381 (Learning Management Method)
e et . - Ve
® 1981 (NAAUNTRTIGNANMUALLLEU OUNTliIuaLANATA9N)
®  LIANANNIIDEANUFTNATNNIBNUAZ AN FBINNITBIE TN
® AU (aunrnBauluiawaz luuile)

o nstiangulugiluuunisaenluniswungu

Do
-

o)
:(‘

& | I AU | FrEE | LATRINA b
TUADY F18azLBEANANTTN 5 .
A3 | 1980 n1g9ae

o]
=)

1(FtoF) (3alug)

Aunauil 1 IAsIzRGEaY 1 3 | WULARLDINAYNYN

1. AU T AT L UIAANISITEUETR .
Learner Analysis : A ] o Py oy
( y ) &L (Philosophy and concepts of adult learning) dalu | Aeennsizen)

2.0 muuangueFeulnauiangudiFaunu
dszaunsiuaegisau(@ig , aVEw, Lnd, s

NN9ANEN)

3.4338vinsuan AuANwuzauilszaA (F3e
ClGaug, senulunisiihaeu, daalananinluy

ADBTTN ATEETTH NANMNLNES)

4. NNETNIFTINNULALNITALEUTIANIFYN
AULEY (BENIFRUSAILAULEY, TINTUUARIT

AaINsFaumeauas, dihuanalunisizaus)

o &K o
o o . wuLTuANAIIUA
5.@"5wﬁmqmqﬂizmﬁ LAZWLULUN
5.1 MaaFaw IwAlAN1sas19"aLazNIsuILEUa Uszacd
HAUTUE AmFujBeu

5.2 wiaFau nsldllsunsumsanudugs (WU B-1)




281

. LATRgHD
an - L. fuay | e y
AUAB U TERCLAEUMANANTTH & U
AL AT | @ e
n1gagl
v 1 1 v ¥ 1
o o . N =] 1o val o
ATN 2, 3 (Fto F) (6 Talus) Online 14 A39 1178 TUBENLIELTEN (21 G T09)

2 dupaui 2szyilsziay Online 2 wilaaFaut miraFaumaiianisainda 14 21 doe-
\anuangns(Course UAZNNFUNLAUBHRNUTUF dalus | learning
content : C) P 2404 &

MueFau N5 1lUsUNTNANSTIUTUGS LLNAFaL
AaUNAY
uuLtiuin
naies
AmFuEGau
(1uy B-2)

Wungw : unagimiiaBeun 1 (easidan suse 1 3 wuLfuin
AnsiaRIaE) dalue | nnslEend
AmFuEGau
. (WU B-2)
WUNGHN | UNATUMNEFIUN 2 (s8azi@en 418150 3
w8 1 .
Amsiagiae) daTu

1. FIAEAAVLURUANFATINNULLADU N
awiszansnguaradndulsziauanusulaly

n1siseus

2. ghagmuuaihuanglunisGeuianunains
lun1sBauiuasianssulunisizaus luilam

nangasngisauaulanazFaus

3. ’ludfmmmLﬁ%mué’ngj«m;ﬁé’mz‘lﬁmn
wuugauay IneiavnnauuaIRanNNEaINg
mmé’ﬁ‘ﬂmﬁyamﬁmm:ﬁ'umsﬁ'rsummmm
\Hlavnviudugaasiafiulfaunilasnaaniann

Wamnsinisysumsinai g

4. AREVERRWUSNUNZAUALTINUATE NS
UsziiUNALAZHRAWENIA LA NsfuuANAanssad

[ <2 s a [
unusiininvdanmsnuniuanuiingaziiv

v

fanssundAnEuRaLFaY

U




282

o ° < -
an . - - MU | szaz | LAsRINalY
o AUNBUY TIEANSELRUANANGTH & Ao
A 2N L3[1 n1g93ae
k2 T T
o A o
ATIN 4,5 (F to F) (6 42T89)
& P ° s & . & o o &
3 | Tumaun 3 Muuasduuy | msiszgnaldenu Power Point 2010 ugs 1 3dalue | wuutiunnnig
= 4 °L 4 a o v A yo o
MITEUTULURANREULY | @ inpTianisaiiealad iiansanu iTeugamiL
s v
WNNZANNURLFEU(Blended - ' 3
gaeni( o watianizainen niadaulng HFeuuuuB-2)
Learning Model for Learner : - Y
5) ® WANANITATININ 3D Tu ulunnaey
nsulszgnaldenu Excel TUgs 1 3l
® N2 / BIENIINNY
® N19NUALELREN
o nalasudieanulnadangs
2 s ¥ o s o = vao
1. gaaalamuuauazanvingluuunisiFausis
FEU TRIUARTAU LATRILATNAMNSINNBUAE
NSNININY
2. tuuAnanssunsEauskuLAgIusInina
MsBENUULHANNEUTEUINBURRS LR
wazluraasau meviliinanisidausaalu
WRIFHULAZUDTARUNUING BULADS TR
3.4ngUuULABENITAANANTTNUATUNAUFAUSADY
Ananuang Bangu aRYdansFauinaa
ANNNNNENNE 9 Talauinsilauainuazas
la
a a a P & o v o
4. gmadanlunsiFausiiudacnne guiseu
aasalEmsaulaLasiassElumsEaug
& ) ° aa
4 | TUABUN 4 MUUAIENTST 8 P E P . :
N 1. 1981 (LAAIUNUINYNINUUALUUBY FIU
AANSIFRULNENULINY .
4 o NUIAUBEANURZAIN)
ADUNRLLNISIFEUSULY — v
L ¢ 2.19AE NS DEAREUANNANNNTANUAZ AN
eimielu(define How to learn ” o o & o o
i ABINTIBNLITEURDIUN (@1ansaisaulunag
the time and place of <
P wazfbuun ba)
Flexible learning : F)

§2U52AZLIA LUN1TLa U

®  NNIFHUANLHWNNTITEI:

al U al [ :/’ :/’ oI/
n9iEeuluiesEey Al 5 AT ATeA 3 daTug

AN9EUULLL Online A1UMW 14 A% ASIAY 1 F2l8d 30 W17

gauNITTEN 19 AT

F9H981 15 dalug

N80 21 dalug

MR 36 dalug




283

NANNAADY

o ANY 1 NNIMARAITUHETEUAUIU 3 AL AATIAAALADANLLIAHY F11AIN

u Q

W laaaTianIUNFeL N1FABAIMNUNIE FTNI1TUNAUD LAZTUAAUNITEDU TN

UfuiR Inensdanm duniwod udorhdeyanlinidiudaufila ielinaaesludusiell

dl o o va o dl 2 a a
® ANN 2 NNITNARBINUNLTEUANUIU 7 AL LWNBUIL uﬂummﬂ?mwﬁmwmmgﬂLL1_|‘1_|

u

NIREUSLLLNANNAULAZ NI EEUS LU LAV ULAzAIIRaa i daun e Tuy

sinee] antiutisndiudgeuiila e ldneaesludusaly

® AW 3 inamesesiugFuuaIuIL 20-30 AL INeLszAVENMeRegLuLUNNIEuS

a

Ay o oAy & guny - a a
LLUUN@NN@quLLﬂgﬁﬂq?L?ﬂugLLUUﬂ@VIEJ"H V]@?’Nmuslﬂvlﬂmqlllﬂmm NNIUNUTEANTNIN



= A
7.LLNuﬂ']ﬁ‘L?Equﬁj‘

a7 MaUsN36 Falua ( lutieaide 15 9.4.0nline 21 4.4.)

1987
(@aTa14)

qniszaeAnITEaus

s ¥
mszmswﬂug

a s ¥
NANTINNITLTAUT

NANFIU Tuu
NRITY

@an19

) v
LU
a

aa s
AENITIANLLAS

UszLNUNa

= ‘4 Y o . ° . o~ a v o & ' =~
ATLUN 1%LLQQquﬂizmﬁuﬂﬂ'§m5 N5 lganuldsunsy e-learning (LMS) HARZHUSUINUQILFU1 ALUANMSRTNRALAZNITUNAUDNANULURS RUELTEU 2 5 lgllsunsy

ANTINUAUFS

3 1.dnladngUseasAveamdngms

2.g11n90 8 uldsunsu e-leaming (LMS) 1§
3.411170 U whaFaui1 mallanisasnede
waznsiaueraUTugee Fewn2 nsld

v
Tsunsnmn9199UTUga H1UsZLL e-leaming

1 .%thfﬂdi/ﬁlqﬂizﬂdﬁﬂﬁ’ﬂ@]m‘
2.13ulilsunsy e-learning (LMS)
3.uzin wiaeBeuiil matannsang
%fﬂLmzmiilﬁmu@mmmﬁquﬁw

! v
Beun2 nsldldsunsuananeauduga

¥ a
vssenelutingiTe

a

HEuNNLLUNAREL

P F oA
NALIEI UUIEILTEIUN 1

= unnfuinnavue

TrnUsrasRduiy

=

g3 (Wuy B-1)

" wnfuiinnisBe

a

13813 (LU B-2)

& mFug
" L UNAREUARNEE

oA A
NUILILTEIUN 1

alas, Al

LUUdang, nau

AL

N151328U5UY Online ¥UAEFAUNT NANANITATNFDUASNITUNLAUBNAIN

WIUFI6ATIATIAL

1 d2lu4 30 U visa AUBENL

(7
%

eX¢
=

=

21 (9 Hala)

1.30 R L T I L P R eI ot

UMY ATRENLLILABLAZANTHNLEYD

" 5o1195ULNNT
{ANNIFAUF(LMS)
" LUUNARALLRENAY

al
bTEIU

" Luunadey
o K
" 9rUULVNN
v v
AIMNNIIUUIUBINIT

v a
LUINLTEIL

UWLLNARDL
an e-learning,

Video clip

" uunadaueias

o a
NATEUU

= ' ' = = a v & ° <
ATLN 2W1Jﬂ@‘3\|ﬂ‘§ﬂ NUELTEUN 1 L‘Vlﬂuﬂﬂq‘d‘ﬂ?'mﬂ’ﬂLL@gﬂqiu'\Lﬂu'ﬂN@qqumugﬁ

“‘ L 174
ALY 3msuszenalderu AdvancePowerPoint 2010

¥8¢



LA
(daTn4)

anilszasAnsiFaus

A5ENsiseus

fanssNsiEEus

NANFIU TUNU
NRITY

an1eg

2D

and

Faus

28N19IALAY

Usziiuna

N1515AUFUY Online uAEFEUN2 N5 1T1UTUNTNAITIINUTUES 8 A

[
a

A

59az 1 72lNg 30 U Wsa AL

s =

&1 (12 H2lai4)

1.30

ausnesLNaAanTRYe s uNINANINIY

dl AI % A s
unn 1 Limumﬂmmumammmum

2a4ltaUnsumITe 91

" 5o1195ULNNT
{ANNIFAUZ(LMS)
" LUUnAdaunau-

o a

NANLIEIU

" LUNAeL

® oo 19N

% v
AYNAINTINYR9NNT

v A
LUNLTEILS

LHLNARDL
an e-learning,

Video clip

" LuunagdaLeias
o a
PAILTEU
® HnUfjuRsen

AR

= ' ' = 4 &
ATUN 4wuﬂ@‘3\|ﬂﬁ;ﬂ NUILULTEAUN 2 ﬂ’]ﬂ‘ﬁﬂﬂmﬁ‘s\lﬁl’]iwﬂ’mﬁlugd

< o z
ATUN 5nsszgnaldau nsldldsunsunnsenutugs

= a U
T[N AANITNANFABHINE

1 L 4

WG LMS = Learning Management System vi7a3szuunn3annnsizans ilusevduainvinnimizusdnniszaunisaaudiuiiy LMS dsznaufion 5 4ausail

1. S2UUSANNIUANGRAT (Course Management) NaNE Mauuiiatlu 3

o A v = v
TEALAD KITEUW NADU LA

O U

7295LA1U user uaz AwIuLMEaUlE liidnin Ineduegiu hardware/software 71l uazszuuaNisnsasiunisldainimineetrasin gluuy

v
v o o

2 o P N av v ' 4 A -
SHUTUNTISUU Tmﬂmmmm@?wummiﬁu nalaflé Tnaeinu wisadnadumesidn ssuudunsm

2. S2UUNNIATNLMEEY (Content Management) szuutlsznaudaaipzasilalunisasa3ng Content szuvanansn lauliaisiuundeaulugy Text - based wazunaulu guuy Streaming Media

3. szuuNIAdaLLazLlsziAuNg (Test and Evaluation System) fszuupasieasy Iaefluszuunisguisasuaunsndunainisindiesaetuaznisnsatiasaudnluds wioueas $1eUaTR ATULL

aa v a o a
LAZANANITLUNLTEWUBRNUNLIEU

4. szuLdNdTNNN9EaY (Course Tools) UsznavfingiAsesiiasine ldReanssendna fieu - §aeu uay §izeu - §Eau 1Hurd Web boarduaz Chartroomlngaunsawiv History 2asdiayamaniils

5. szuuaAN1sdiasa (Data Management System) Usznaudiaaszuudnnisisuasinanes faauils

v 1
A A @

P P = o & A - o o
! ‘VlLﬂUﬂ@H@UWL?ﬂuLﬂu“ﬂ@ﬂﬁluL@\? InelFileinNh Admin Avuali

¥
v

G8¢



286

8.ALIUNNFIRE
793 2 1AaU
4 o s
9.48n"3(38143
=

zil' a 2 ¥ Al 3
aannsFendutiesBeu : alad, Aile

%'ﬂﬂ’]?ﬁ‘ﬂuﬁ Online  : @9 e-learning, alas, Video clip

10.117UseiNUNE
aanisizeusluliealdou | wuudunm, nuRey

-dl a 9 . = a oAy 1 o al
AANNTLILIU Online : dﬂﬂgummammm, LULNARDUNDU-UAILTE Y

[ %

dl a v 1 v
11.91¢18 AREUUNSH TV INE]

32y

NIy ATAE19N

[ % = 9
12. LWNUNITAANITLIEUT

LEBNNIaANsEEUEuANgnsmaTulagansaumeNeiulsransniwnieningau

A1 (luaasey) Tuasingilscasiuangns nasldauiilsunsy e-leaming (LMS) uas

Wz MeFEW1 ATANITA3INABLAZNTULAUBNAIILIUEY MilaaEau 2 N3l Tdsunsy

AN UT UGS
ANgzRARY
= o e o = N = a o as Y
TuasimgLlszasrnangnamatulagansaunAinelinysc&nan1mn1sneulsnis
. & ~ o ——_ 4 a o
uldsunss e-learning (LMS) dumeunisameiien wue vidiaizaunt wallannsdinade
waznIstaNeNaIIIugY wliaBeun2 n1eldllsunsumnsnsenudugs lussuy e-learning
NNIULLYNAFBLINIDULASNAQITEL

qniszRIANTITEuS

4
a = Y v &

FefBeulauauudafBauiiaauanansnsidl
1. ladmgsvasAraanangms
2.41:130 e uldsunas e-learning (LMS) 14

3.anunnliion wmieeui1 mallanedinedenaznsiiauananudugs wiaeduu

12 N9l Tsunsnmna19uduge NNusTLL e-learning



287

¢ o 4 a = vl o
9152 R9AINIYAALTERIALTING ANTTN/HANNSTIEEUSNIATANIS
¥ K o a al E P2 1

nsdindadiTayuwaziuIAAnN LR Iy

1.NIWRLI AL

2.anHfiansuazWsan Tun 9 s

3.1AnuF i

= v aa
4.N3TUIUNNIFLUSNADATIA
= Y Y o
5.119E8U3AENITTNMULLY
v

ANNG

dinluinnilszassaasuangns way amnsnldanulilsunsy e-learning (LMS) 16
NME/NTTLIUNNT

winmrnisldanultlaunsunisdnnisaladuarnistlszgnsiin il iusunm

[ o al

ADAN BT IBNE T8I

Tl Fews, FausineWmunued Bauiatiesaiiie

asznsisaus/ilamanse
1.uangramalulatiansaumaiinaiiuilssansn1mnsinanu
2.Aan1g 149w eFront V. 3.6
= v e ' | .- a oy

3. PEATREANUNEIFHUNIUIZUY e-learning MHdBFeUN1 WMANANTATNABUATNNS

Hauanaudugs wilsamaun2 n19ldhlsunsnnnanseudugs

nszuunIsannanssansisaus (lunasisen)

o 2 1 =

PYUUNINFUNLTEU

u
[ ) 1 o v a d” Y o I8 [
L4 HUHSEINANINNNIEIL LIRS ﬁLL@QQMQﬂ?i@QﬂﬂI@QM@ﬂQW?

® LAMd slide langRenisldaulilsunsy eFront V.3.6

munﬁs@m'ﬁ@nsfiumﬂ?ﬂué’
¥ v a o o =K o o -
o °L‘v1al, ﬁumLmuuuvmmuummﬂ?mm(LLuu B-1)
v o d” Y o c [ %
° qﬂLLuszﬂLmqmgﬂaﬁzmmmumqm

¥ ) a & A o aal ¥ .
o fuuzilealad nnslduuazuuetingsnisldeullsunsy eleaming

v
o

o fuuzhuassnasunlinisnisasiealas luseaudigs

o JnuuiiunnsBauAMTuEuu (W B-2)

U



288

®  LLNARALAAUEYU LN EHUN 1IATANIAT1NFALAYNNTUNLEUD

NANUTUG

o o qw o o oA Ay oA A a v A
® EaljLLu:;uﬂMﬂ’]?‘muﬂ‘LINL?ﬂuiﬂL?ﬂugﬁluﬁuQm?ﬂu% 1 INAUANITRATINARLASNNG

bl
o :/’ dl . dl ¥ o ¥ 12 v va
UIAUBNAINUTUAILUAD e-learning Vliml,uzuﬂumqmu wazaaiind sl

u

ausialliveaziinlgnisagimicezaun 1

& ~ %
‘Huﬂ‘g‘ﬂ N’ém’]'il,‘iﬁlug

£ =
o luiingigeu

¥

UANFIU TUNU NANURBNTITEUS

u

O o

o =K 3 o v a
wuLunAuAdRnLsrasAd wEL iFew (wuy B-1)
o K a ¥ o v wva
WU EeuIA UL Fau (WY B-2)
WUUNAARUNEREEUMNEEWA 1 ATANIEINABLAZNNIHNAUENAITUTUG
alas Power Point
PELRER IR B ER R
wutiuinnuadRnLsyas
WULVAABLNUEHUNUNIEFEUN 1 INATANIIATINABLATNTHNALBNAIUTIG

A9NH, DINFAL

=y t% =~ | | = P a o o o &
ATLIN2 aTJﬂ?Jﬂliilu) WUﬂQN@?ﬂ NULTEUN 1 L‘V]ﬁuﬂﬂ’]ﬁ‘@ﬁ"]\?@@LLﬂzﬂ’]ﬁ‘qu@u@N@\?’]uﬁlu@j\‘i

A1un3 (luasiEau) n1stszendldann Advance PowerPoint 2010

A1u4 (lunaadau) nunguagyd wiiaBauwn 2 n1sldllsunaumnisasudigs

A5 (lunasEau) nsdszgnaldanu nsldldsunsunisnsudugs

1 L

(18aZLRUA FANITOAARD :3 el)



289

N1538USUY Online MUIEFEUNT INANANITASNERUAZNITUNAUDNANUTUSS

o

wiflu 6 AT ATIaY 1 daTHe 30 WA vise TuatAuiBeu (9 4alug)
® A13zAATY
® qnilszaAnIgEes
® AsEnIlEUgANeMNANsE
® N3TIUNIIAANANITNNI9ELUT (Online)
o = o Ay
®  HANTIU TUNU HAUABNNIEES

acs] o a
® EN19IALAZLTZINLNS

NMSEEUFUU Online WilaaFaun 2 n1sldllsunsunisisnudugs
wihafli 8 A3 Afsay 1 dalie 30 WP vise Juatiugiman (12 Galug)

® ANTzAATY

® qnilsvavAnIsiEf

a v dgl

® gnsznnalFEUI/ANEMNANTY

® NITLIUNNIAANANITNN TS (Online)

® 1ANFIU TN HAIUABNTEEUT

e AFnnadanazisziiuug

1 L

(18azLRUA FINITOAARD :3 el)



290

WUAEIEAUNT [FANATANIIATINRBLATNNIUIAUBHAINUTIE

ANgzAATY

nstianedulidrazniiufnunising nsdsegn dusun viseauau o AN
: o o a4 day . 4 @ oA &
audAny unstauehedefilivsznaunisinaue dedufenazideniauliemanszees

'
k4 o o

fussenalldafiia RersilaoudndAnyazdosiinstaneaiiam iEisaunsnanauay
inlal4m Taqiiudearetflugilansdenanas vsealashasaanasasonllsunsulssinn el
N191NLEUD 1R Microsoft Office PowerPoint, OpenOffice.org Impress , Proshow Producer
v4.0.2548, Wondershare Photo Story Platinum v3.1 ifluéiu Tilsunssmiilui desilungan
amnsnlifldeulslnedne Aaltsunss Microsoft Office PowerPoint iuanuileltsunsulunng
v o & ‘ﬂl 1 | v ‘ﬂl 1% 1
asuazdnnalasiieniiaus qauutesllsunsuiasaiignginsunazuaue lfeeng

eme dunrnlddananud A 1@ naanaunwedau i ludneas  Taasluslaglaan

A o as o

1% 2 @ A v o v ' '
M f«NLﬂummmmmmLmu@mﬂgaimuummmm VI’WIM\?’]HM’]L@H@VIM’WN U Lazin

ARFNNNINENTW Sunastiaueannsn liszananAnuazaisdedann e iauedoya

TURABUTIAEY BWATAIENIN

AniszaeAnmsiFaus/anilssasalananig
1. anansadinlafemaiianiseenuun@euaznistiaue
2. mmmﬁﬁmmﬁiﬂmmuﬂqLmuﬂ‘*ﬂgua;ﬂﬂﬁﬂizqﬂﬁﬁumsﬁqmu
3. Lﬁuﬁﬂmmﬂgﬁmummmm’éwLL@zf%”mmmiﬂﬁ’éﬁqaiﬂmmuﬁwLmu@fuzﬁa

4. TUNN I W ALLEIA NN IELIUNNI U AR AT IR

qA5EaIANINIY/qALSSAIALTIN G ANSTN/MANISTIFEUFNIAIANI
nsdindetlFmnyuazuurRnnIs el lun
1. NMINAUIAULEY
2. pufinInIsuaznsen TuN 9 s
3. auawnsnaasauedll 1o
= 2 aa
4. NITLIUNNIFLUTARRATIN
5. N9EEUIAENITINALLEY
A
ANNG

NN3a319UazaANN3A ARk PowerPoint 2010 4149



291

MINHE/NITUIUNNT
Winwenisldauilsunsunisdnnisalafiaznisdseansiin 1 duanungin
o v a

GG TNAEEM
1. UszaunisnizesfFeulunisliauingnudesiuzedlsunsy PowerPoint
2. {3, e, desiulunisyinanu

= v
A19ENsEEUs/ANamanse

1NN N1FADNLLLIAALATNITUAUD

® UANNNIAI R4 lamuNLAUe

a

L4 LWﬂuﬂﬂ’]ﬁ‘@ﬂﬂLLUU?ﬁﬂﬁ’]L@u@

v
o o o

®  AFUTUAALILNNTHAR TN TNTINLALE

'
a a k%

uni 1 BusunsidnuearauaniFvesllsunsutiiaue

o puantAnuraulawazamantimnlFzunisliudssly PowerPoint 2010

« BBV e :

® uiiuAsasile Ribbon 14 PowerPoint 2010

o siunualas (Formatting Slide)

tzll o b4 tzll A .
UNN 2 N19AN13IRANNT MLEAe (Text Presentations)

o damnuualasuaznisangiliun aunafadns

o unanavAlsznavalad

! o L v o dl
o nsladtyanenl, vuneaunt, JunuaTean
. Y = o

e s1uuuNIuAnY Format 384%)n Slide Miwilauiu
Un? 3 NM9AANTILINN WHUH AN99UazIe9ANg (Picture, Chart, Flow Control &
Layout Techniques)

o n5ldsthnngtseenlud® | gUaw, Addenim Tuguuusine

e Fuuslanaw fag Format 197 i wiugtlnan, SAf1aL, saungu, iaauinug

e n3ldn1979 (Table) wazn3ldukunN (Graph) WianiaLFuwse AoeAdasineT]

] o 3 1 ¥ o qI/ |dld !
o nsldunwisesdng uaz lnazunsuguuusine] faamdsludniEandn SmartArt

UnA 4 N3ALIAN NNLAREU WG AarANNATY (Control Animations & Multimedia)

v 1
o o

o nsldetinduia 4 sduuuliifueasidns n1sssane gy
o g o - . . ¥ :

e Adinaaruninils lusendnesnuiiaue faagluuusingg

o nsldidessingr Wifugdnan ( Sound Effect)

o n7ldanla Tualas



292

UNN 5 N17waRINITaealan (Slide Shows Revelations)

e nansdlasuuulfnaniusianssizanisninuanuuUiusIA1 e (Slideshow)

® n3unsn A Flash Animation ( *.swf)
LN 6 nstlszensldanu

e walAn13d59alas lidaneanu

o aTlAnsaianwAReulva

® AlANNTA519N W 3D T power point 2010

nszudun1sannanssunsisaus(luiasFeu)

<& 1%

TunguniFay
v o 1 % v al v o v al 1 v
o fuuztinanavinniafFeu fuusiiningFaudilag annsaldldsunsy

Tuswnan Microsoft Office PowerPoint 2010 1§ifine anntiujuuziinadung

d” 1 al
\Hanae e
AUNIFAANANTTNNTITEUS
® NULLNAFALNAUDY

o fuuzthilaalad n19GENAunIT i LLATANIANLIR PowerPoint 2010

%
o

o fuuziuansuanuilinnanieainaladluszsudougs
® TUULNAABLUAITEY
duagiluanisiaug
o lutiavizeu
NSTUIUNITIANANTTNNNFIFEUS (Online)
dudngunidey

® {8 login H1uszLL LMS

>34

A =

dy o
® penunizeunfenNsazzeu
o K v v A ! ug//
e funnANAnmtihlunsiBEULAaTATY
AUNIFAANANTTNNTITEUS
v a . 1
® (i3 login HusELU LMS

a a d” dl v A o K % v a
o | ﬂumuumiﬂw,u@mﬂmmr] TunnANiautinluns e

® JLLLVARALEREVAITEY



293

Tuagluansisaus

® Online

UANFIU TUNU HAU FANSEUS
TN MUASRn sy AR A uiuEeu (Luu B-1)
WLUY AL NBLEEY - UAdTe
o K = ¥ o o va
LUULUNANITLIUUIAINTUELTEU (UL B-2)

'&1@91( Power Point

RHEATLIR LMS

28n199AkazlssiiUNg
wuuiuininuedRnLszasd
WULNARDL NAWEEIL - URIDEI

WULUNARABRL, & bNE, DTNAAL

UMY N15RBNLULFABLASNITULEUE

1% ¥ & o S @ a v (2 o @ v
1. viﬂﬂﬂﬁ']ﬂﬂﬂu”lLﬂuﬂﬂﬂuﬂﬁzLﬂuWﬂﬂ\ﬂ,ﬁﬂ‘?'\&lﬂqﬂn..’l‘lﬂuﬂ

o annFaALdNe: dpvinalad iigEaidiengawinninle b aeewilunundane s
I @ dy % 1 % = 9/da’ o [ %
SUNIUAEAN lBNN987U wazaNsnHeM et edaiau visa ldRuuAIuAN L

di/
bRAUN

1
a o

® iiA2nNAWRI (consistent):iluAsdnAnungalunisinaueslasailumemluizes
- o Ay o - = g o - = o
By e fiasilaauasdalunseanuuualas Geinnaisiesldgluuualafinanii
L odd . 2 S gae® U .
NnuRuneaiuiteniu Inaldadusenlasud Aunas iseusuazuLANYs

o o !

: o > @ A . = = L
wsinfiasnisiiuqndndny vsailuemdeasanllazaisnsalaaunnega w8
sadnmslualas iguansnelllfTing visaeiaiinisulasudanumnadliuansieainiiam
Anidntiaafionani i

4 ] v o =
o ‘lfananna: N1seanuuUAIUNLIzNaLTeda las IHAN B ANAANULILIWNY (formal
balance) WFaaNAA INHLLILIWAY (informal balance) il usifiagszdaalasnnueuli

o -dl A 26 ¥ A [ -dl o
ANBUSARIAIHANAAN wanldliimlauniuinaanuALEn

= a = 4 1 [} & dl ¢ 1 dl & (<1
L NLL‘L!"JﬂﬂLﬂﬂQﬂluﬂlﬂﬂLLﬂﬂzLLNu: UBAAITHN LL@ZﬂWWVIU??QIM@i@@LLN‘LM‘LL\?“] Aadily

v v
o

dy ] a 1 :/’ A = a A &y 1 4 A o
PANIUBILAASLLUIAALNTIUL UTNEURUTUBLNURNELLUAAR 11TR Lu‘ﬂﬁ’]ﬁl@ﬂﬁl‘ﬂﬂlm@i@ﬂ

el



294

[ %

4 = A a ¥ [ dly A

®  FSANMNNANNAU: MLuLanELazn wnsdnliunzaniuaneerasiilani 1
o Adl 1 ' ydd‘ % A a dl 1o Y ¥ &

WLLANHINENNNY uas 1EaN ALRVALNEIAN Lﬂ‘ﬂﬂﬂWWﬂ?WWﬂWiﬁJsﬁUsﬁﬂu LL@SI‘VIQﬂ@’fJ\?

%

dgl =< v o dgl ::ll [ I [
AR Tanieliunnzaniuiemnduntenng viseldiflunnennséiae

o . . ed 4 Y 4w ey -
o wuuanes: WlEenmINInngn 2 wuulualaszaanila Inelduuuniiailuiade wazan
wusniafluiient wndeaniadiudiananunanlaliildsauun (bold) Widaswa (italic)

wnien1sidauen IFmiuANLANFNg

v
[ % 1 o

® Uam wazqnitandn: dardnlualadaisiuaniziade visememdnAninu
1= = dgj o [ 1 1 ¥ = o v
Tnelifinneazidanraation) uazpsiiauailuusiaztant lnseratiqatindienau
52 % dl % =X dgl 1 [3 I = o v 1
agdinenii ieuansliinsudatiamusazilsziin wazlinisiqaindanauninndd 4

o v

qatugladueiunils Tnaannsnliuuuualasniqatindianannly Auto Layout tai
o v v d” ¥y v 1 09: -ﬂl =X Yo

aptidiaponuliitangiunidieanuusiaraiuiensgnaanuaulazesgiuianig

Wuaue a1aaz ln1sarsdianana (dim body text) Tudiaaaunussanaludaialin

o o©

v ! v
nzqmindienau wazitleindaiianewiniiengunanes

¢ RanldnaWnadieszalngzda: MslinsinnmuizanazaruisniiunisBaugla
1 = a a 1 A a dl 1 o dlg’ o ¥ = v 09;
atadlsz@nsna uivnlinswini ldusnzasiuiieuazinliinnsBauiiuanas uas

anan liaanunnana 18

® ANMNANTA (resolution) UAININ: LIBIAINANNANTATEIADNDTMDSHINEN 72-96
DPI wintiis AwnsAnntinauetlsznauluiiemiagidanilufeqlfnwiiaanuands
genn AslEnawlugluus JPEG fidimanuandnilnunans uazaunalaluguinin
113531104 20-50 KB T9%11A23911N190 L8R Y98 compress WATanIUIANTNABLINE
Tiliasadienluniaiuiiunn waznisandslnatinullswdiediannseiing (e- mail)

A [ v [~3 o o LY} Ql 49/
visansenTuan Buudulafazanunsannlé ladedn

1
> o

o Ransukuudlas wazuuuanssiuNIzaNNUalnsaisaN: Wasannsiiiaue

o

Y = = | N -y ot : = S A o o
AesiinisimeNseAeniamediniugUnsnison [ IATeILeaTA vise InsviAdiielaue
fayavensunuuaanin Al feunisiananl N maaesnauive lilAn WU

dl b % 1 ﬂl % del LA & 1 ¥y &
AanNIgnFisaNnzan manzdleanauiadandavesaladazlitlang lidiumiu
UANIBIEAINEIU 4:3

2. wmAlANNTRANLULARULAU
dl o kA ¥ a dl & 1 dl a2 ,a <3

niseenuuLAetaue avfievtiuuuefn “uikalas seantliaaumn” dneaguisvian

= ° o ' 1% I8 =
NIRANTTAATY Tmm@gmalmmmmmuau 3 dsznns Aa



295

® Works Atiauadassansadannunangliadnsaniia

TnalszisudnAtyiine azfiaansunguiluung (Audience) evnanssigeenis

fuaue uazanuiaafifesnisiiaue

o ﬂ@;mmmLﬁﬂ?ﬁ'@ﬁﬁLmu@m@ﬁzﬁ“ﬂwmxﬁiﬁmmzﬁﬁﬁmﬁutﬁﬁqmﬂﬂd%ﬁy@m AN
fhnpila e Effect sine] sestilsunsuasadenn1dlFeshadud

0 nauiidanaznslimeudy nMsthiduensiTins, msusseng viseilneusa de
shuauenslirnudndyiuidemuasfeaunsatinmaiia vite Effect AN U84
Taunsugiredesn i lFethafufigui

O nguewziawy fiisuns, Wnaanis TaudAnyduilen uazdafinaueily

o
o o A

A1ty Wemasssanizihnguesnistinaue Tl Effect 1nniin

o [ 1

2 1 !
O nanlugiliiranddtyiudussenannnniniiamntinaus Tdaaandiun Effect ws

(2 U

AasliiANdIATYAUaLIARRENET Afa8Nes LAz Background Color
® Organizes imsdnaramilanflussifisuging Tduau
doranefesinlifienu Bilmeudngnagns deyalafifecenunen wazsususeld
fasarudiananulamuatsu InsnfAaulnadnazauaindsuuitanew uazaasl
F09919EMINeEN T WeszInean N aNAsTiavaglunnseanuuy fins
sndnsuileviusafon uavgdne Ae
O AYIMANBEINITEWBLLLNATINTN
O uwsiasanig mstEUalanie Topic 138 Main Idea
0 winlaaansavaniaedds WEmaTiAnsin Main idea 189usiaz18nns 1se
TunnsnsWEaE AR n ALeity
Vgunnfasnesuansefiig wdalug) Mdadnmenuinlugndvindasias
WAt ludauidndny
1%*ﬁﬂqdﬁﬂuﬂ’1ﬁmﬂz§mmLﬁ”@m
Wasudnunzaeianesiu s ludeauiigiomnisdi
‘Lfﬁ‘ﬁmfiﬂuﬁmmqn@jmLf:@mwi@:mjumnmrﬁu
Yapuiifeanislfieuieunassalaimumissinauuremiinszany

6 o

dl L4
ENNA T2l ﬂH?ﬂQﬂ?ﬂUVIQ’]\iLLUUiQLL@Q

=)

be

o v 1

Y s T la I P R R N L A N AR,

wanugluuussaneslimanzas

O O 0O 0O OO0 OO0 O o

i/ddl 1 o A o o a o o o ©° d” | o dle/ o
EANUANFNNNY W FRFIENHIANALINY (f-vmmmuu‘wumqLﬂummquuwum)



296

® Attracts AR9REAARAT UAUlA
4 o Ry Y oA = Y ny oy
Aatiauefptiiazfiasdqawuiiiaula anunsapegasaagald anwsuiléiainnis
M uunvesdnuen lvngliisiuaindencuaus) vseldanuansseanly sannenis
wanld Effect Mnnnzandsznauniainiane

O wenlinmimanzay

TimATiAnIseanuULNWAINIZEN

o o 5 y o <

@ennnssadananuudalianediynlayumiis

% 1 4 ¥

Augesdngsaunwliinang

4 oyl

\nenananla

Tru1nuazgLsnuAnE19aINesINA

inenansnE Backgroundliiguinaula

O O O 0O 0O O O

o o % all o o o 1 all [~1 o v =
Avuar A inallaauanEuzansssneswLasuuia iR eiEe
wasuguuLeednEsTingnge)
3. aPulunaUlunIsTNaRlUswNITNENLEUD
= g A A 5
o Anmuiland FaeNaztingue
o | o Y [~3 ] dl o ¥ o
o Mnuuadlwindeuarilszifiutos et ldinnmn
U = dﬁl dl 1 1 al o o
e aiunviTalaEamEnLe) asuunszasingn1ss N wlunseudNlsenys
| A A A = )
uaznnasingls visaiideisznauvisaly
o a o o dll all % Y dla’ dl il [ all
®  AUTUNNTRANLLLAN — FeN®T — Bag AuN tFaanuuuldluiiaBesdeanadlunini
Ny oA T
HaguRTaN NNAI9TUDY
® 579 animation WAX transition 197 W N84 Transition 2edNsNa laMiTaa31

Build A1%15UN171ARAUNTAIAB N TLAZNINA TN 33



297

UNYN 1 BENAUNT M ULAzAMENLTRLadllsuNsNdLauD

U 1
Tsunga PowerPoint HAMNa11770 luf N1t auaNa9u IaaNuin1nieuaag
Power Point az{3en91 alas Tsunas Power Point 1391UsN 7 Aa¥RNaULLLATENLRY IBM PC

TUANTAUNNANAUDIUTN PowerPoint 2010 azldunana . pptx

o puantFniraulawazamantimnlazunisliulgsly PowerPoint 2010

Backstage View

el sawe i
Available Templates and Themes Blank presentation
Bl save ns
5 open LA e
o ciose
L4 i |
o N D w k) L@ L
Recent Blank Recent Sample Themes My templates  New from
woating

presentation | templetes  templates

_ oOffice.com Templates Sesech Office com for templates *

Bring -— \ ]
Wy W | .
Sare & Ser E gl =E = = i {mm LT ]
Agendas Award Calendan Content Design slides  Diagrams Erwelopes Fiyers
Help certicates shiles Srmen
g A - v \ 3
1 == =1 -
2] Optiom [ gJ —d | E - el | m |
=i 2 = U= B2 4 = _:3__ )
Farms Giestng  dovtabors I Libeks Flans  Presentstions  Reperts
cards
-1
=\ | \ -
=0 & =) - 4
Fesmesand  Schedules  Seationery Mare

wnuipsasie Ribbon diulgaluiliiinasldeulfdaau

File Home Insert Design Transitions Animations Slide Show Review View Acrobat oY
% \_—I =) Layout = L == I @ [IL—| (™ & shape Fill B Find
| o= 3
B3y Reset _ _:j D ﬁaj ZShape Qutline !'u Replace ~
Paste Mew . B J U 8§ abe &V~ A5 A SR=R=N= |f== S5+ —, | Shapes Arrange Quick
slide » "5 Section ~ = e == = === =& - *  Styles~ = Shape Effects k Select ~
Clipboard | Slides | Font | Paragraph | Drawing | Editing |




298

dl IS o 4 dl o 1
wirasdadnnisdianaunyiulgaluy

WYNIARABNLATINYG wuLTud

NATOUNIANADN

g | Cut
3 Copy
[{, Paste Options:

= & Ribbon 11 PowerPoint 2010

s A A
® |INULATANHA

WAL Home (M3INLsN)

sanAdaneaiunsasealadluiuazannisalas (nguaAnds Slides) nsnmunanm Ly
Fanes (NGNAAY Font) N1snnuuatiantil (NgNAIAY Paragraph) N199aLasANKAgLINg

sznaualas (NGNAIAI Drawing) WaziATasHaAU/ILNTaAIN (NgNAAY Editing)

Pl Ik
i | Home Insert Design Transitions Animations Slide Show Review View Acrobat
Ij &= Layout - = A A [H LI_:'P [ <n shape Fil
@Reset . ‘ i = pC | i -"{ LZ Shape Outline ¢ Replace -
sllwu::"v = Section - B I U 8 aell-ha 53 b Sna‘pes Mavnge _ﬂel =/ Shape Effects b Select ~
Clipboard I« Slides Font Paragraph Drawing Editing

<
LN Insert (Lk015N)

mw‘hé{qLﬁmﬁumﬂmiﬂd”mqﬂ?:mm"mj asuuala s [unn9e (NGNANAY Table) Nw/AdL

|
1 o o

mﬁfm/gﬂa'w (ﬂ@:uﬁﬁzﬁ“@ [llustrations) N13857°9AN NN e (naxNA&a Links) damanuuLy

q

WA (NGNANET Text) waza@1inle/adili@es (NguA49 Media Clips)

Design Transitions Animations Slide Showr Review View Acrobat

"""" LU 4EDE T Q&SP

Table Picture Clip Screenshot Photo Shapes SmartArt Chart | Hyperlink Action Text Header WordArt Date Slide Object | Equation Symbol | Video Audio
" Art o Album o Box & Footer o & Time Mumber = " bl

i
]
E
B
=
=)
if
=
©
Il

Tables Images Illustrations Links Text Symbols Media

WL Design (BNWLL)

'
' o o

1 i v
sauAdunaaiunsisAutinalas (nquA1ds Page Setup) Nsanusiea lasfinagagluun/an

Background)

Home Insert Design Transitions Animations Slide Show Review View Acrobat

= soft P D
3 nCo\ors' @
. t ] Background Styles =
\:\ ﬁ na nn nn n Ifl mn f | n = | [A]Fonts -
Page slide [er— [err— [e— = EmmEm i — @Eff @ [T Hide Background Graphics
= ects *
[}

Setup Orientation -
Page Setup Themes Background




299

WL Transitions (N15iUasugalan)

sauAdalunisnnuuaeninsnuuansasualas (Transitions)

i Home Insert Design Transitions Animations Slide Show Review View Acrobat 5
\ sy Sound: [Mo Sound] = Advance Slide
o[ L — —
- Bl FU'| -ﬂ -Eli - J @& Duration: 0200 % On Mouse Click
Preview i i Effect
None Cut Fade Push Wipe Split Reveal = Options ﬁApp\yTu All D After: |00:00.00 *
Preview Transition to This Slide Timing

WAL Animations (AWLAARWLMA)

souAdslunisiuaeiindniseasulug Auaniseaaulniaesdng (Animations)

Home Insert Design Transitions Animations Slide Show Review \u'iew Acrobat s
Tﬁ, AN -,_'F @ﬁAmmatmn Pane I Start: = Reorder Animation
[} o F d * -
= f ) 4 ~ o} - Trigger & Duration: = & Nove Earlier
Preview Nona Dpes Fade In EloatIn Effect Add _ =
- B o ) o Qptions Animation ‘f‘:.— Animation Painter S Delay: ¥ Maove Later
Preview | Animation Al Advanced Animation | Timing

WL Slide Show (NMFUBAUBNTNI)
sauAdNERiUNsiELeY Tiaued lasianue Aauadlasiaqiiydnauaianizge
alas (NguANAY Start Slide Show) Anuuar lunstEwe MauNTELeA AR /TNIAWEIY

v 1
TneTuinRe9N19L9987 8 AINAVBINBATNAIFIIA (NqnA43 Set Up) uazinuuantinaaly

NN3ULAUB/NITUARS 2 nTinas (NGNAEI Monitors)

Home Insert Design Transitions Animations Slide Show Review View Acrobat
' @ 5 Eg I:.‘:g. - -II »D . Play Narrations Resolution: | Use Current Resolution -
. Use Timings =E Show On: =
From From Broadcast Custom SetUp Hide Rehearse Record Slide .
Eeginning Current Slide  Slide Show Slide Show = | Slide Show  Slide Timings Show~  [¥] Show Media Controls | [C] Use Presenter View
Start Slide Show Set Up Monitors

WAL Review (A52991114)

9NANEUNLIAUNNIAIIAAALLENEANT LTU NMsgauan®s (NGNANAY Proofing) N13uNaIN

%

faAniuuulanans(NguAIds Comments) waznsilesiualas (nguAn43 Protect)

Home Insert Design Transitions Animatl’ons Slide Show Review \c'lew Acrobat
W iCe] _‘.J T, "FA'? 2k B R R j By ) previous %
£ _.J J Ll S Next “f{
Spelling Research Thesaurus | Translate Language Show Mew Edit Delete Previous MNext Compare Accept Rejed End
7 - Markup = Comment Comment [T Reviewing Pane eyiew
Proofing | Language | Comments Compare

L__»
WNU View (YNNB)
sauAdsdnuiuiaanyuneslunimauiualasd (nguAds Presentation Views) N94a1/uana
gnutlszneuvuniinsnellsunsy (nguA143 Show/Hide) nstia/asnelandns (NGRA1EI Zoom)

nsuandalasiilugd/anamn (Color/Grayscale) 4AN131HN1A8N19911497% (Windows) WAEN134314

ANRIN19911491% (Macros)

Home Insert Design Transitions Animations Slide Show Review View Acrobat

B EH B | & % ==

|:| Gridlines E Grayscale I%ﬁascade %
Slide Motes Reading | Slide Handout Motes . Zoom  Fitto Switch Macros
Sorter Page  View Master Master Master | [ Guides Window | [l Black and White Wmdow [ Move split  windaws -

Presentation Views Master Views Show 5} Foom Color/Grayscale Window Macros




300

e silunualad (Formatting Slide)
1Hann Template Tu Design

AANYILNY Design -> Themes

Home Insert Design Transitions Animations Slide Show Review View Acrobat
All Themes ¥ - n Colars =

This Presentation |:| @ Fonts =
Page Slide
setup Orientation ~ @ Effects -
Page Setup
Built-In
—_
fin fin fl fl :'m 3 _
EEEEEE EEEEEE .. =
[
ikl nn '
L LU LT EEEEEE EEEEEE

fin

wam:

Enable Content Updates from Office.com...
Erowse for Themes...

=
@ Save Current Theme..,

FAGE SETUP |

a a aa
AANUIT UTLAITUNU
|

!

=] Mew Slide
—TTET
[ | [ﬂ’ﬂﬂﬂ"l‘il,'w&l slide ﬂﬂﬂ‘ll"l’] -> New Slide




UNY 2 N1FAANITURANNN L ELARG (Text Presentations)

301

fomnuniilusamiidasnaiisonazld@umld ustindusimiaenduglninagls

1
al

aunronazldlunisAunn nsdfusimiadaisannsaNazliu auis @ WNUadFaanNET AN

1 o al v v
LPun N19FILEU LA

o dapuuualasuarnisdngtluun aunndasnms

Home
[XP

- Reset
M
= g

d | Slides

Layout -

slide ~ o Section ~

Outline x

{F Adobe Arabic

S e
Transitions Animations Slide Show Review View Acrobat Forn
[]36 - A A = i=- 1= M- I.E'P D‘—_Ell

The EE - ' Shapes Arrange
T Frankil dium  (Headings) ; N ’

~ T Frankiin Got {Body) -
H LilvUPC cadings)
Eﬂ:‘ Cordia MNew .
Recently Used Fonts NGO 2™ e
T FPE Pimpaesea IIL . a
— nﬁmmtzm

(¥ 2dobe Cagl

PS5 Pimpdeed I

(B| 7 U S abe Y- Aa-

Font

-

36 v AT AT

[ |

Home ->laandananuifiaanisazilasuilas -> font ( Usznnsadnes aum / )

Design -> Themes ->Aan297% @lad Layout

EE|
=4

Clipboard

unsnaaAlsznavalas

Insert
- Layout ~

Cresign

Transitions

Animations

Angles

ew
Slide ~
= |

Slides

Qutline

Title Slide

Paragraph

Section Header

Two Content

EBlank

Comparison

Content with
Caption

Title Only

Picture with
Caption




302

o

o nsladryanmal, munawand, Sunuazatiunisiiawatlszinnandumenisnl

e T

rar15|t|ons Animations Slide Show Review WView Acrobat

IE@-M “‘{-\%A

lip  Screenshot  Photo Shapes Smartdrt Chart H|J-=|I|nl AL
irt = Album ~ >

T Q2§

Dbject | Egquation Symbol | W

u eader WordArt Da

Box S Mumber

Images Illustrations Links Text

Symbols

Insert Slide Number

Insert the slide number,

The slide number reflects the
position of the slide within the
presentation.

Slide douts |
Incude on slide

Date and time
i@ Update automatically

| 01/10/55 E||

Language: Calendar bype:

| Thai [=] |ThaiBuddhist [ |

(7 Fixed
|01/10/55

Don't show on title slide

Insert -> Slide Number ->1aan slide number 132 Date and time Nazlda1lu slide

wnneme] f018Fe9N19 show luntin?i1 294 slide 1% Ain 91 Don’t show on title slide



303

® s1uuunIIuaAY Format 289N Slide THimilowiu 1 #1949 Font, Shadow,
Hyperlink ¥138 @284 Drawing Object iauua tHun1stlseugananlunnsuiilals

| = & A a4 9 9
BAENTIALTVITSEICLE BN ﬂ‘ﬂﬁ‘:ﬁzwLﬂ‘ﬂwfﬂﬂ’)’mmﬂﬂﬂumﬂﬂﬂjm

15uusie@ang Slide Aael Design ->Theme ->colors

e

Presentationl - Microsoft PowerPoint

Insert Design Transitions Animations Slide Show

cdl > |~ | padl B

‘ Themes

Fresentaticnl - IVIICrosoTT FOWErF oInt

Design Transitions Animations Slide Show Review View Acrobat (A e

“ - | Builttn S
/| HCONNNNEN office

Themes BN crayscle
BEORECONEN Adjacenc
Angles
BN NNN Apex
HONNENCN spothecary
[ - 1 EODENEEN Aspect
TJureenET was s tUfiuml § mommmEEE s
________________________________________________________________________________________________________ EONNENEE  GackTie
Click to add texdt ECDEEEEEE i
BEONNNNEE darity -
BEONNENNN composite
HOENENENEN concourse
j ﬁﬂ b =] EONENTeN couturs
HCOENENENE ctlemental
Lo BE 6 mommmm o
HONDNENE E:sential
EONNENEN cecutive
ECONEEENN Fow
EONOEEEE Foundry
............................ =% =
[ na

LCreate Mew Theme Colars...

Beset Slide Theme Calors

!

L

Aa Aa |




UFuusaAaanEsuee Slide Aae Design ->Theme -> Fonts
— = 7\

Presentationl - Microsoft PowerPoint 1
Insert Design Transitions Animations Slide Show Revie " 4]
colors -
Aa Aa WAa
EEEEEE | L] | -

Effects

Themes
Presentationl - Microsoft PowerPoint = =
Design Transitions Animations Slide Show Review View Acrobat 0
n colars - @ Background Styles =
Aa Aa MAa - Fonts =
. |- S e
T || Built-In -
Themes Office
Calibri -
Aa calibri
office 2 3
Calibri
f ~\ A2 Carabria
FNTg
office Clas) e 2
L Arial M
ENN 2| Tines Now Roman
4 60
L e e 50 Office Classic 2
: s Arial
U2 13 50 40 \ 2 o \~
13 n 32 30
1a . = 20 Adjacenc?r 2
Cambria ‘
10 i -
Calibri
0
\ 41 Angles
A Franklin Gothic M... =
2 Franklin Gothic Book
Apex
A Lucida Sans
= Book Antiqua
Apothecary

Book Antiqua
AO Century Gothic

1/5uuple Background 284 Slide #q81 Design -> Background -> Background Styles

Design Transitions Animations Slide Show W Acrobat (%) "

d:.

nﬁ‘nud"lli

o s pun wind
Background Styles -

Fons’ -_|

i
b
e m g B Fokground‘..
1l 20 ] po A ] de ound
30 [
Uz 5 50 1
40 E HABIARNR
13 Frd 32 30 (1]
) 35 25 20 +
10
0 A
1 2 3 HE) a2l Wianl
= 00 FiTiar
Aefadmdia 7
Fal Afinuan

304



305

U7 3 N193ANN23UNIW LHUNN A1319UazaBdAng (Picture, Chart, Flow Control &
Layout Techniques)
o nsldsthnagtsednlui® |, gunw, Addenin Tugtuuusine
® JFUUAININ Adgl Format AN LU v ugLnN, ARasL, saungu iAeund
NARDI UFUUFNNAE AN EUT LAY 519 11U Tdn, usezeunw,nazvieu ,in

ANAR, 2L

e n3ldn1979 (Table) wazn13lduNunN ( Graph ) WiaNTNLFLLAY AaelAdasi 7]

o nsldunuieesdng uaz lnazinsugduuusing o feamdsludniEandy SmartArt

N 4 N1aaLAN NwAaenlin AaraNNAIL (Control Animations & Multimedia)
o nsldetlinduwia 4 suuuliinueawians nnsspatlngu
o Adinaiasuninila (Slide Transition) Tusenansanuinane foegUuuusee
y =l ! Y o
o nsldideasnge WidugUnw ( Sound Effect )

o n7ld7nTe lualas

1N 5 N17uwARINITa"eI4 las (Slide Shows Revelations)
v
o nanealasuuuldnanflusnenaviranisnivus ULl FUsIeAIeY (Slide Show )

® n3ungn N4 Flash Animation (*.swf)

und 6 netlazene o
o wAtlAN17459R AR ITidneNIw
e ATANTAFTNNINLARRN N

® nAtANNTE$I9NN 3D U power point 2010

1 L

(s12A1BLR AINTDAARDRIAL)



306

Coa A » 2
waeFeun2 Feans i llsunsumnisneanudugs
ANgzAATY
AniszaesAmsiFaus/anlssasatananig

d o -4 a = vy [
%ﬂﬂﬁgﬂﬁﬂuqﬂqﬁ/"gﬂﬂigﬂﬂﬂL%\‘lWﬂ ﬂﬂii“/ﬂﬂﬂqikiﬂugﬂ AR NI

1 L

SIEATIAEA AINITOANADLIAE

a v
ﬂ’]%‘zﬂ’]iL%‘ﬂug/Luﬂﬂﬁ /A9

42 y .

uni 1 Eusiunislinulas AN TReallsunsunis99nu
o dquilsznavaalilsnInmisnedni
® unsninAllAcge

® nisA Ul Microsoft Excel

UNA 2 msﬁqmuﬁu%’m@
o mﬁm%mg@mm‘iﬁﬁu (Sorting)
® n1ngesdiaya (Filter) Aagl Auto Filter

® msvinagunadiayadiog (Sub Total) ldduiunisagtualneuaniuasgy

! 4

faya Tidnazilu nasan ANeAY A1WIL VERANNETA Aungudayansianis

q a

® NIRgIAdaLANYNABTiayaRat Data Validation 1Hdmiunsilasi
uwaziinANazaanlunstlendeyaliiazaanuinteay

® MmN muANITLARIRNNEeulafae Conditional Formatting ld&w5unas
LAPNKATDLA

dl a oY v
N9 3 MaAssidayanan ilsinsunisngnu
® TENNIWNLAL Analysis
® NIIAZITRYANNATAAINLLLABLAN

unl 4 asnsaeuagliayasanisnglafuazunug

o anuuunauazilsslamiuaininled

¥

o mswlpiiunisasiliays

a

®  NIVINTIENNUHEUYH



307

un®l 5 9113 (Macro) un1sinauludneuesiadsing «

11TAT (Macro)
n19d5149811A5 (Create a Macro)

NNTANUUANILAT

Uni 6 N3RaRINNIL LY NNsEanlegens (Auditing Worksheets)

nsRamudTaTlResdestuiala (Trace Cell Precedents)
mﬁ‘ﬁmmmqLmﬁygﬂﬁwﬁqiﬂﬁimﬁw (Trace Cell Dependents)
mmmmzﬂmv%wm

n3ndialANaNnledgRIN13ANUI (Locate Errors in Formulas)

NTAARINAANTRIAILLS (Watch and Evaluate Formulas)

uni 7 nsidinuazdsaandaya (Importing and Exporting Data)

nsasaandaya lilds Microsoft Word (Export to Microsoft Word)
NN9UNENRA1319a7N Microsoft Word (Import a Word Table)

mﬁ‘ﬁ’n‘?}]ﬁ‘ﬂgmﬁﬂu Text File (Import Text Files)

Un# 8 N1INUUARINITNEIANNLaRALE (Security)

NN9INUUATHRNNWITA NS Excel

N131la9r1 Worksheet&Workbook

uni 9 nelszene s

N1INNBIE / BIENNTNINNTU
NN9IITUHUNUREN

S 9 o
ﬂW?Lﬂ@ﬂuﬂJ@ﬂqqﬁJiﬂﬂﬂﬁﬂQH

NSTUIUNITAANANTTNNSITEUS

3 ) 2 1 =
AUUI L°l|']'§‘1J‘VILiEI‘H

o Jludinsizeu

[% o

R/ | o o '
& Huuzinanainme e fuusihaugizaudilas arunmnldldsunsy

u

Tusunan Microsoft Office Excel 2010 1#ing arntiuguuztinagune

dy 1 =
AN UELTEU



308

® Online
% {Fau login H1usTUU LMS
R p Ay P
& RenuNBEUNFeInIas el
o % [ v = ] o
% tunnaanfinautilunisizauusiasaia
AUNIFAANANTTNNTITRUS
2 =
o ludiasizeu
’00 [ o a ' ::l' dl' a' ¥ [ o
% fuuztidlegalad uni 1 FeenisEusiunislfauuazamuanti® Excel

2010

*

% Huugtuansnaaunlin1ansase excel duge

® Online

* {3au login H1uszLL LMS

0

a

FiTeU MUULNAdeLNenEe Y

X/
0‘0

= a d” dl v A o K 2% v a
* FuumnunBuwiennlfiaen dunnanundiniinlunnsizeu

NS

*

* MULILNARBLVAITEY

L)

TuagluansiFaus
o luiinsizen

® Online

UANFIU TUNY HAY RAN15EaUS

o K o o 6 O o va
WU TuAn AN uuAdRn sy AR A iU ey (Luu B-1)
WULNARDL NAWTEIL - UARI eI
v K a Y o v va
WU TuAnNsBeug AL Few (Wiy B-2)
#las Power Point

AUWLADTLLRA LMS

2En199AkazUsziNUNg
WU TuANAUUATRnLsTasd
UUUNARDL NAWEEIL - NAI T

LULNAADL, A9LNA, DNAAL



309

UNT 1 BENAUNIT M ULASAMANTAVDITLTUNTNATSI9Y

T1l21n9NM19719911 Microsoft excel 2010 111l NAN WA IANUIRILAZNNTIATIEH
foya tnaliduinans Aa xisx

® &2uilsnavaed Microsoft Excel2010

[ Back State J [ Quick Access] [ Title bar ] [ L1l Ribbon ]

Insert Page Layout Formulas Data Review View Add-Ins Acrobat

) H S=Insert - x - ﬁ
General - *j % % g %
= 3 ¥ Delete ~ @ -

- <0 .00 | Conditional Format Cell g Sort & Find &
= A0 >0 | e imatting ~ as Table * Styles ~ | F& Format * | (2 Filter~ Select =

Styles Cells Editing

[ Active cell ]

E [ Worksheet ]

i;[ Sheet Tab ]

24 -
4 4 » ¥ | Sheetl Sheet? ~“Sheet3 ~“¥J 4] [ | » 1]
Ready | 3 | ||E|E 100% (=) (+)

' |
o

- Back State L‘ﬂuﬂmmmLﬁf;l'lﬁ‘i.lﬂ’]ﬁ‘%’]\‘i’]u%\iLLWNQ’]uL‘TJ'u New, Open, Save, Print, Close
- Quick Access Toolbar luuaunetesiialiitenidewlfetamadaaunsaiulluadaly
- Title bar uauuansdalilsunau LL@;%@iwﬁﬁ@@;ﬁuﬁ \aldauat

-4nY Ribbon Lﬂul,muﬁmmfmmzﬁlﬁﬁmjmmLuw‘?‘@wﬂ@mﬁflﬁ@‘lﬁtj‘l?”mﬁ@ﬂslé”mmdmzﬁyu

- Name box waaspumisaaaiaqiiv

- Formula bar wnukangRsAuanviedesyafiuidnly

- Active cell LIARTIAQITUINIAIM 9 UDE]



310

- Worksheet Nulauaaqlilanny

® unsnnAlARN
mnﬁuﬂmﬂ@miﬂu Quick Access Toolbar

ﬂun@m%ﬁﬁmmﬂ%muﬂ@m Tnensanmnanifiandinunlu Quick Access
Toolbar 1 fifunewusiail

1. ARNLNGNATAITB9 Quick Access Toolbar @:ﬂ@ﬁﬂgﬂﬁﬂﬁlﬁ@ﬂ?ﬁ uay
Lﬁ'ﬂﬂ‘?‘i More Commands...

2. lnanAdansieannsldivieas iy New, Open, Print Preview, Quick Print, &«

Customize Quick Access Toolbar

& Mew
Taho
_h_a - Open

B Save

Clipboard E-mail L
Al Quick Print o ——
A Print Preview and Print Add to ¢
Spelling FT
| |
Undo
Redo

Sort Ascending

Sort Descending
Open Recent File

More Commands...

Show Below the Ribbon

Se ||~ |o v s |wna =




311

® nisAunely Microsoft Excel

n1sldgnaAnuInuLng

1
o ¥

1. ABNIARTNABINNTUAAINAANS A nfaetinell 1 unisaadetn C4
2. WHWLATRINNTY = UAIBNFRA UMIEAS 1113 =C2*C3 1aFauianaLlu Enter

3. NEIAA C4 AzUAPNHAANS uazi Formula bar AzUAAIGATATUINNMUALT

c4 - Je | =C2%C3
A B | C |
1
2 Fuug 255
3 Rl=RTELETR 1! 30.00
4 TIULY 7,650.00}
5

AALIANANATITDIATEIUNNANIINITATUINS TUATEIAANRIAATTLN1TATWITUAN

-dl a o rtﬂl v 1 o tﬂl o tﬂl a I'g
LATANARALA Nmwmnimzmmmu’awmm@mmmélw,mmmqume Iﬂ?LLﬂ?N’QZ@I

'
a

o o dl o v =® | o o dl V6 v v dl d’l dl
AMHNANATUARIATANUNIENINNITATUITUAQE EN[SITRL e [35N] cﬂmm finanauluisasl liva

Tl nasnsndaantsmaiaulilanilng

LASRIUN T AMHNRNNE
() AL
~ 8NNIAY
* ADL, UNT
+ - 9N, AU

AYTNAATYTDILATEIUNIENINNITATUIM AL IAANUUAIAN LUAAATAT ATYQIAN UAT

o~

o 1%

ANgRazAATYANgn TugnsAuanigasuil Basasunnaladn AgyndnfaziinisAaiua

o q

A o ' 1% 1 o |
Lﬂ?@\?ﬂﬂqﬂuuﬂﬂuu@ﬂ@[5]'111@'7 ﬂ‘]_lvl,ﬂ bTRE

©

NNIAUIUMNEATINYINABINITUINATINTVBIFNATNAE] AL 13180190 1E

|
o [

Warduranisvnasudinundqs Jduneusail



312

6

=
1. LARNLTIAR

4 1

T RINNTUAPINAGNE ’Q’]ﬂﬁQﬂﬂ’W\iﬁy[ﬁ'}LL‘Mli\iLsﬁﬂﬁﬂgﬁ H4

2. fiufiu Home A u Sum uuyaLnf

3. az1sNggnIAIUINL = SUM (B4:G4) Wigdastioyamariiazinuanuingnieaiels
z%’uﬂmmt.%éuﬂ?ﬁ'w@m finya fingnsiasudonmilu Enter finlaignéie drag Aquaasiiayalu

WA nALld Enter

2 AutoSum|~ h ”ﬁ
¥  5Sum
G

a3
Find =
Average
Sum (Alt+=)
A Count M
] Display the sum of the selected
_ Max 5 cells directly after the selected cells,
1 fin 5
— Maore Fu 3
= 3
=S UMY




313

uN? 2 MYNUNLTaYA

o nsBEendiayanINa1AL (Sorting)

ANAUNIIIA TN B FL

b

o 9 4 I LA
winithdieyatiunmnn vizsedeyanes lugtuuuresgudeyaunaineultsunsy
Excel daulun) uasanasaanuiEeniasuia gsnaznisaelil fa nsdniasiays Tnaddunau
o dy
Sy
1. AANAUMUILTAS Wi diaNfaen19dniFes
¢=4I < 4 . a 1 o dll A o v A
2. Muiiu Dataviadia Sort & FilterA@n1|uuuyaung talaanNasinsanEeN
Sort Smallest to Largest amizeanniiasliunn (A->2)

Sort Largest to Smallest amizeaanunnldiiey (Z->A)

—) Data Review View Add-Ins Acrobat

ﬂCDnnectiDn

Al falz
- BEAIR 4

z| lsort | Filter ., 1
& ﬁ‘l’ W2 Advanced C
wnections Sort & Filter

a o o v 1 A
mmmmmmmﬂ@iumwmmma

1. Aunsigagetlueiy Database

2. panin ieitlnlnazdeniand Sort ANWuATIHATIBLALNN AN

1
a

3. Midag Sort by @andiadienanlunisenizes Adee Order @BNLNNITNTIADES

a 1 by y a o o o
4. i tful HAddtevEl Je Ry vindiasas, TunnednFes viveiindesns ausihiineanli

o o - Delete Level
RONAIAL wAARNLN



314

lHome Insert Page Layout -Fu)ula Data Add-Ins Acrobat

I HE b K Cle
3 3 5 b o = N r K Clear E‘g I
i =5 =L e FE Properties ":a Reapply EE- —-
m  From From From Other Existing Refrash o Filter 7 Textto  Remove Data Con
55 Web Text Sources~  Connections | All~ =2 EditLinks S Advanced | columns Duplicates Validation ~

Get External Data Connections Sort & Filter Data Tools
D2 - fe | KBz /
= Book2 /
[ A B C D E F

1 é@dy dud T08U6 JuInBud m

2 |o0-001 K.B/

3 |oo-002

4 |00-003

5 log-004 “:‘glgdd Level l X Delete Le%l H 123 Copy Level l B - My data has headers

y A
6 (I Caolumn v Sort On Order
Sortby  |susanud lz‘ ]\Jalues El AtoZ

7 |o0-006 Thenby | sagud lz‘ Values El AtoZ

8 |oo-007 s

9 |o0-008

10 |oo-009

11 |oo-010

12 |oo-011

13 |oo-012 fuda DATHUTSU Vs 521 70.00

M 4 v »| Sheetl | Sheet2 . Sheet3 . ¥J [« I

Aumndiagasaniansasdiayaiiies Ine

® n1Ingasdiaya (Filter) Aagl Auto Filter
NMSNTAITAYA LUTINUTARISI

o v v 4 3 v = Yy & oa A
nsinauiudeyatiunnun vseguiieys uanainnisanEeauas Aaziduizenis

v

a o
HUURABY

v

=
1

o

q
1. inuntairadetf ey Database

2. Nwiiu Data viadin Sort & Filter A& 1]u T azisngqnesaanniinde
Filter

=) Book2
A B C D E
1 @du. dui I LT JHIDEUA - N L
2 |00-001 AL ISUZU KBZ 150.00
3 |o0-002 nayuarhes ISUZU TFRT/W 150.00
4 |00-003  |AeuarheEs Mitsubishi CYCLONE 130.00
5 00-004 QLI TLE Mitsubishi L200 130.00




315

3. adntjugnAsasaasindianazundenieyanfeanisluniiadniiade sneuaiaan

BENZa3auaamantn OK

=] Book2 o B
A B C D E -
1 @y, #ui S Teeud [y EUERINTE - s o |
N a
52 00-051 SUEERIE BENZ 124 Fd9a DEFO 220.00
w4 @ a2
53 00-052 SUEERIE BENZ 124 v 197 TYC 250.00
69
Ready 2 of 67 records found | = [

AUNALOL Status bar AIUANALLAAIANUIU record NALWU LA

4. aniannsnsesdiaya naLn Clear

moaaLra e TR EFIvE]

?H I Clear
¥ Reapply

Filter

\'E) Advanced

sort & Filter

1 ﬂ' ] o L = 1 tN' & Q
N15NsA9ANNLNEINUWETaNISI@ANEGINUaaN
‘lum@mmuﬁu?ﬂfagaﬁmmmnﬁﬂu Database Lﬁfawqnqﬁﬂfau%gammumnqm@

~ da o o L el o fr A g
1N record VIWNWSﬁ']ﬂ'HIﬂElL?q@quq?ﬂL@qﬂqmsﬁqﬂu@@ﬂimﬂmum@uﬂ\?u

1. Auniairaseg ey database

2. i Data AR 1] Remove Duplicates =H

Remove
Duplicates

azilsng lnezdentend Remove Duplicates

Remowe Duplicates
To delete duplicate values, select one or more columns that contain duplicates.

My data has headers

| #=selectall | | 8= unselect Al

Columns

[ avéu
] &uen
e
[ fusaeus

] svan




%
aa A

316

a A v Y a rdl ¥ v oy a '3 ¢ 1% a 1
3. Aaniaanihdelann liinsasaudeyadi luntlinanansnaualadauiaonant]u OK

[
[

4. azisng lnezaandanduaniaiuan record Nd1iupantlu OK

adu[, aui S ) T THIOBUA - na [,
00-001 fAayuarhas ISUZU KBZ 150.0
00-003 nauashas Mitsubishi CYCLONE 130.0
00-006 i3
00-007
00-010
00-011
00-013 T0.0
00-015 Amuila FORD Ranger Fighter 160.0
00-016 fAnela HING FEFC 160.0
! o ) % % A ¥ o o/ v [
L] m'immqﬂmmmal]amﬂ (Sub Total) sl“ﬁ@qﬁﬁ‘ﬂﬂ']?@?ﬂNﬂtﬂﬂLL@ﬂﬂN@ﬂ?ﬂm@Hﬂ »LN'J']
[~ 1 dl o A 1 aa 1 2 t=l| %
@::Lﬂu NATAIN ANLRAE R1UIU UTRATNINARR ﬂqﬂﬂ@‘NﬂJ’ﬂH@VIM’ﬂﬂﬂqﬁ‘
1. Wil Data laan Subtotal
= . A o P o
2. laan field V]L?qﬂ’ﬂﬂﬂq?’qgﬁqwﬂﬁ‘qwﬂ@%@ TOEUUR
3. 1a@n Subtotal (Add subtotal to:)auAUANE
Data view View Add-Ins Acrobat
_ LA @re L *¥ Show Detai
[ Properties %l s ﬁ? lﬂ JII‘EE E = HIi-:Ie Ei_t:ill
9 Edit Links U At each change in: : Analsis= | - P [—
onnections saeud |E| y [F]
N Ose tuncaon: ./ Subituta
Total several rows of related data
Sum |E| R together by automatically inserting
— subtotals and totals for the
i D N Add subtotal to: e selected cells,
ud ‘ju‘mn ; i - e Press F1 for more help.
B =
|| saeus
L= 1I|.|.11|uH
Ny
-

|| Replace current subtotals
["] page break between groups
summary below data

l Remove All ] [ QK ] [ Cancel




317

E Book2 & = =}
[EEE A B D E F

1 @16 Fufh ELHETE fusosud 1 Suuane

[ [ 2 |oo-001 nauuarhds ISUZU xEz 150.00 12

3 o00-002 fAauuarhds ISUZU |TER TTW 150.00 4

[=] 4 ISUZU Total 16

[ 5 00-003 fAauuarhds Mitsubishi CYCLONE 130.00 5

6 | 00-004 fAauuarhds Mitsubishi L200 130.00 6

7 00-005 nayuarhds Mitsubishi STRADA T/W 150.00 7

[=] 8 Mitsubishi Total 18

|J:V_I - | 9 |oo-006 nayuarhdl MAZDA MAGNUM 200.00 12

10 MAZDA Total 12

- | 11 |oo-007 fnauuarhds NISSAN BIG-M 170.00 43

- | 12 |oo0-008 nauuarhds NISSAN DIS 620 T/W 150.00 34

- | 13 |00-009 fAauuarhds NISSAN D/S 720 TIW 150.00 2

14 NISSAN Total 79

|J:V_I - | 15 |oo-010 nayuarhds TOVOTA MTX TrW 200.00 35

16 TOYOTA Total 35

- | 17 |oo-011 fdmada DAIHUTSU 570 85.00 76

+ | 18 |oo-012 Aruida DAIHUTSU Dis 521 70.00 8

4 4 b M| Sheetl | Sheet2 . Sheet3 nEN m ]

NN38NLANNN9NT Sub-Total

Data

O @anwyA4s Data, Subtotal

O aane1datias Remove All

Review

View

Add-Ins

Acrabat

Subtotal

WIICTOSO0TT EXCE]

L] Sort Filter Textto  Remd| -
=5 Edit L A 7 ndvanced Columns Duplid At each change in:
onnections Sort & Filter TRHUR
Use function:
Sum
Add subtotal to:
C D E
f
08U THIREUA M
ISUZU KBZ 1
ISUZU TFR. T/W 1
ISUZU Total
Mitsubizhi CYCLONE 1
Mitsubishi L200 18
MFitemhichi STRATIA T 150 nn|




318

® NIRIARaLANNYNFesdayasiae Data Validation M4 miunisilesiu uaziia

1 U 2
Auazaanlunstlaudanaliiararnuintelu waznistasiunislddayatn Ine
L1 U

Tanda

1.

>

Data Validation

en field Aifesn snmaday

WL Data -> Data Validation
Aendszinnaesdeyafifeanisasmagey

(%

Tunmaaauaziuingna i lddeyaniusioaaludes Sauouang azd

NNTLAILAAUANNTLL

Data Review Wiew Add-Ins Acrobat
@Connections Al Y K Clear Al @?
Zv |z . 8 NG
27 Properties ';;Reappl;-' =
o il Sort Filter 7 Textto  Remove Data onsolidate  'What-If
&2 Edit Links i Advanced | Columns Duplicat e <t
nnections Sart & Filter ',\‘ | =i Data Validation... I:
( 1 \ BH  Circle Invalid Data
e % Clear Validation Circles
C D E G H
T0eud THIRBUA ‘ EIGII b)) TR
ISUZU KEEBZ ‘ liﬂ.l]l]‘
ISUZU TFRTW Data Validation

Mitsubizhi CYCLONE

Mitzubizin L200

| Input Message | Error Alert |

Mitzubizhi STRADA T/W

W ali dom criter
ﬁaw: \

MAZDA MAGNUM

|thle rumber Izl Ignore blank
Data:

|between Izl

Mirirmurm:

0 =
Maximurm:

| 100000 =

h the same settings

E F G H I
| ok || cancel

A1 | RINE

150.00 12

(

150. ddd

2 Microsoft Excel

1

@ The value you entered is not valid.
L A user has restricted values that can be entered into this cell.

LRty | [ cancel | [ bep |




319

dszinnaasdayanazaynaliileulslutes Alow:
1 1 o = 2
e« Any Value (Ala) Fsiiazvizedaninnle
o [~3 o o [~3 dl o 1 d!
e Whole number (R1U3UHN) LANIZANATANUIULANNNIUUA TUTI991T4
e Decimal (AMWMNNATREN) RNIZAUATANNANUIUNATLNANINUA
. ! A A o
e List (978019) ANANNIEINN9NLEITEIN A
o o d
o Date (Tu7) AIAINNIALTUNNILY
e Time (1721) mmm?@ummﬁizq

o Text length (AuANEN9EAN) ANNAINENIDITDAINTISEY

o Custom (AMUUALEY) NMYUARILEI LU §ATAIUIN

Settings | Input Message I Error Alert |

Validation criteria

[/] Ignore blank

[ ] apply these changes to all other cells with the same settings

Clear Al | ok || Cancel




320

® nanmuANIIuAAIANRenladae Conditional Formatting d#uiunisuaninadesys

1
Ay ° '

o A a A A @ " o
ﬂ?mmm@ﬂﬂq?uqmﬂﬂﬂﬂﬂﬂ%NqLLEHULWHU NTRIATICN ﬂ@ﬂN’]?ﬂL@’aﬂ@mgﬂLLUUM’m

a

Rewlals Wemadnilu Conditional Formatting (N1sangluuumnReuls) luwiu Home (i

o

Aaa v 1 | 1 d”
bbIN) HITNITRTN LLU\?'ﬂ'ﬂﬂLﬂuM@’]ﬂﬂ@‘N U

Home Insert Page Layout Formulas Data Review View Add-Ins Acrobat
6 Cut s v = =- " ,_—|,'
Angsana New 16 v A A = == @/' = Wrap Text General = ﬁ ﬂ
3 Copy ~ o =3 B
; B I U~ E =E = | iEiE Merge & Center ~ | B - o, <0 ;00 || Conditional | Format  Cell
fFO"'"at Painter - T E g % ° Formatting ~|as Table = Styles
Jboard = Alignment ' MNumber ] J
=l Highlight Cells Rules » '~
A3 - | 00-002 g MM
A
ak2 E=5T Top/Bottom Rules 3
A B C D E F
e Fud EL T Jusnaud EAGY e EJ Data Bars ’
00-001 nayuarhds ISUZU EEBZ 150.00 12 EJ Color Scales )
00-002 nauuarhes ISUZU TFRTW 150.00 4
=
- L 4= ] Icon Sets 4
00-003 s Mitsubishi CYCLONE 130.00 5| D=
00-004  |nayuarhdl Mitsubishi L1200 130.00 p| &l HewRule.
_ L‘5 Clear Rules »
00-005 neyLIrhEd Mitsubishi STRADA T/W 150.00 7|
s .:E] Manage Rules...
|

| | C
jéf ﬁjﬁ —Ejﬂ :
Conditional | Format Cell I
Formatting =|as Table = Styles =
= _—.] iSohiaht Celis Bules (Lﬁungﬂmm@) dpguuLia Tnendiudmannseudeula
e, Highlig ells Rules
| Top/Bottom Rules  » (ngSusLuIn/gaTing) AngLLLLIEARNGI4R WTBARIGARNTITITEY
—10 -
- v o’ a 1 v = v o o
=1 Data Bars ) (wnudeya) ApgLuuuims IneuansunUARNAN sty aNnviTe it mNANAL
i Y = ] o ] ~ ve A
: E Color Scales » (s2auR) Angluuuis TnouansduuulaseaunuAnlusafisyy i luteuly
}
4 = o @ o . . o P
.| F#=H Icon Sets 3 (1alenan) AngUuULES ‘Emmmml,ﬂu%m@u@m&mxmﬂ AuATegtanszy 13
I e ] o
- (@37900) @379n N9 AL wLIL AT
a4
: MHew Rule,.. , ,
' (Bnang) sndndeulaiszyls Inaanunsaanidnnisdnstuuuianidausng
Cl Rul 2 ' *
. Clear Rules

@ @ &

(@nnnang) wiilagtuuuidpanutenls
Manage Rules... “



nsangluuuasandlalasi (Highlight Cells Rules)

|
v =

321

FBENe AE9N1ININLERATBVBNRUANTREBAT1LNINNGN 50 %10l

1. 1aan cell fayanfiain1amagnt

2. Wil Home -> Conditional Formatting -> Highlight Cells Rules

3. ldRaulalun1megau Greater than

AOO-Ins ACTODET
= e B X AutoS
;iWrap Text General - EE|- j utosul
(@] Fill -
i Merge & Center ~ | G - =0 ;% |Conditional Insert Delete Format
3 @ : o > Formatting = - - - &2 Clear ~
la Nuaper Ta L
\_“ L% Highlight Cells Rules ’] [L% Greater Than... [
L% Top/Bottom Rules  » L% Less Than... =
D e R K
3T M [Srrvns E Data Bars ’ @ Between...
150.00 12 % Color Scales v | 52, Equal To...
150.00 4
1= IconSets 8 \_% Text that Contains...
130.00 5 L.;E - ab
130.00 (3] [E  NewRule.. L% A Date Occurring...
@ Clear Rules k
150.00 7 =
Manage Bules... =4| Duplicate Values...
200.00 12
More Rules...
170.00 43|

=

with | Light Red Fill nith Dark Red Text [ |

)

| ok || cancl




uni 3 nMslaszidiayadaeTisunsunianeeu

FENTANUAL Analysis

NN9ILAIEVL 03 ANNATAAINULLABLNN

Uni 4 a3naneeuagiiiayadosnianglatuaziaugd

AN LAz lamiuaanisalad
pselafnunisagiieya

NN TUUNUN

dl o o [ Adl % o 09’
uni 5 111A3 (Macro) AuNMIMIUlUANHUENFaeNET

n11lAg (Macro)
n19&519811AT (Create a Macro)

ANFNIMUANITAT

uni 6 N3faRNNIILf b n13Eanlegns (Auditing Worksheets)

nsAamudTaT Resdestuiala (Trace Cell Precedents)
miﬁmmm”]Lemﬁyqﬂé’qﬁﬁﬂmmﬁw (Trace Cell Dependents)
mammz&m'j‘ﬂ{mm

N3RaRANAIATR4gAINIIATUIU (Locate Errors in Formulas)

NTAARINAANTRIAALLS (Watch and Evaluate Formulas)

unh 7 nsdinuazdsaandaya (Importing and Exporting Data)

nsasaandayalilds Microsoft Word (Export to Microsoft Word)

N15HENAN371997n Microsoft Word (Import a Word Table)

1
a o

nsrdindieyaniilu Text File (Import Text Files)

322



Un# 8 N1INMUAAINNISNEANNLaeasTY (Security)
® NI uAIRRENWIA NG Excel

® n13%lasriu Worksheet&Workbook

unh 9 netlszeneldanu
®  N19UIBNE / 21NN
®  NINUNURLDEN

A g o
L ﬂ’]ﬁ‘Lﬂ@Hlﬁlﬂﬂ'ﬁﬁﬂWﬁlﬂ\mQH

1 L

SILATIAEA AINTOAAAREINE

323



324

ANANT5 91U eFront V. 3.6

u

AMSUHLANBUTH (Student)



ada I
AnNTaIniiey
v A o '

NNTUASANIHANY
INUNITNANGAT

a o
UNETEUNAN

al
unizeu
NIMARSL
= = o @
ReulansBaudiada

=
N1TAB4ANT

dayadiuynna

GRERTLY

325

11

17

19

20

23



nnidsznau

© o0 ~N o o A w0 N -

N
o

12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28

v A
armnilsznan

WAAINFANATANNTN N
LAANLULNDFNANATANITN

U a ¥ A o 1
LA AU ARNLAIANTTA N
LAAINARNTIAAD LA ANTTANIL
WAPNINHINNIUANE AT
WAASANALITULN (eI
WARLNIAILIANNNS L
LAPNUTINABATLIANNNI LI
WAANNANIINEIALIUDILIN FEI
LARNLNENFULN T
WAANAPLITULN T eI

43/ a

WAASLTIAUNLIN T
wans|NAUgANNI B
wAAEDUE LN e

Y a o a
WAAIUTNAN LN (Te13d

WAANFARLININTNNALN e18d

WAANLLLNDFNNITLAAIAINNAALTLS

WAANFIAAL LA AIAIINAALIAL
LAASLLLNARDL
LAANANDNLLLNAADL
LAASHATAINTNARDL
v dy 1 al
ugnsayatiian - nileiseu
¥ -
wAAIN AR IRILN e
£ v
LAANULNWLINIBAINN
£ al v
LAANUTNTY LD AN
1Y =
LAAINITRAITD AN
wanantirdinyadausin

wanensan nangy

326

!

D W NN

10
11
12
12
13
13
14
14
15
16
16
17
18
18
19
19
20
21
22
23
24



327

ANANIS LY FLinausy

aqa =
AEN1TAINSLUEIU
6 v n:ll v o 1 v o dl a dl " o [<1
aiﬂ@WNW?OV}WZ'&?’]\‘IUQﬁ]eLVN AMNUUINAN  eFrontlaeaiunsn Aany "aanasAsiill
a | dld”" dll a ¥ 0% v g = = ¥ '
ANNTN N DR LHAAANLAD "’QZLL‘UEI\W]‘HWLLU‘].IW@‘EI‘NT]’]?@\‘W]ZL‘LIEIH AZHNTINTANTRH AN LA
o 1 o/ tﬂl 26 v ¥ ¥ % ¥ o 1 ] = 3| a
TURANIY UaNaNNN ﬂﬂmm‘@ﬂmgmmmmuum ELMVI’Wﬂ’]?ﬂﬂ‘]JqSJ"’&\‘i s aenzidauiluanndn " szuy

azggnatinyd v 194

_ﬁ N | carning, Génter

Model BEGESELS 'ﬁlexibLé*_earh'?g_
" 4

L a .

wuusn

121 Tafeus=:Sign In

dar Tdszuu:Login Name

Svidru:Password

FASTILI OIS RE T VIl
ﬁms‘ia:{ﬁ;}ﬂﬁwu AN
ginsailantiznilusyuy

Awsznau 1 WAAINISANASANITN LA

-



328

msaiasiiuauin T

PR ,
Hav Tdszuu:Login Name
dnustilAmaygabildnulédha. - _ @

|phichet | .

sWdsinu:Password
sWArusiaadantnmian 6 fanuse

EXT LT | :

Viuvimdaics dhanada

aesees | -

dwa
chetkhoo@gmail.com | -

-
HaA5d

|ﬁnt§ | -

IS EGERE

|q‘ﬁaﬁ1s—| x | *

WA QR L UARIAIUAANTY

AMWUsENal 2 LA ULNDSNANATANIEN

= L4 1

NNSHANANTUANIU

fliniuanntinarnnsonazlianunisuisansianiuls lnoadan  “pdnudsansiaciiu

2 '
A [

S a v o P A e A A gy
NU LHANINITARNELAD ﬁ‘::‘]_l‘i_l%vl,ﬂ‘vluﬂLLUUW@?NﬂW‘;‘ﬂ?@ﬂ ALNAN 1178 °]]@‘Vlsl°nslu‘i$‘]_l‘1_l

i Tdeuszn:Sign In

o Tdszuu: Login Name

slidru:Password

EEED] R EET
gaadaidaniiziiussuy

ANUSENAU 3 WAAIULNIARNLAIANTAREU

-



329

P e ar ¥ o 1
drsavnalinesianunay Lilval

- P , . -
wdstaris=u vaataiadndwa A tdmiastlumnin

dunfuiinasulamumlag

o 0 - g. v - w " J -
@ ladsawansaumduadllvqasausasua) aAgpaIavallatadn .

~Na o =~ LAy
ﬂ‘imm:uum%muummiuu email WLL@QM%U‘U

A

P v & ar ¥ o 1
disavnahineswarunay Tl

P u . . .
wdsdiatis=uu wiataiahdwa Ald@miasiiluanin

dganfuiinasulamumlag

ANUsENaU 4 LAAIHANSIAADULIIANTUANIY

FIENSUANGAT

Tasaainsuasuangmnsvesd e luniihil ssuuuansuangaanfditeusuazidinlu e
a ! Yy v a % 1 < o dl Y <
uniauazge lifdinausu nuniuumEaulfetamngs luaqiy aunsanavg sl
waefidudluniaganiuesine lunsGeu wiazauaiunsonilaenis@en  cursor 2180HN4 et

A A ' A = a a
WUATAUAANLLARSLNLND @J?WEQZLQEWLWNLWN



330

ACBE Learr“'ﬁo Ce nter , aaaaaaaaa a. (phichet1) | aans
Model ECGEELS F‘lex?)lt'a__@_eam."g

L .
wiwmansun:asTaiam-mimGouwasfiansmmsGounsaay

aiadvinuamnda-gldtv. . aauda lsifulant-mi slg%ﬂg—im ﬁlﬂ"ﬂﬁﬂﬂﬁwL‘%Eu—tfluamﬁﬂﬂaa um‘"s}lw%w anaerizniag
asandanadasSouaianatailaw-wibadeu-iAdluszuy aanauanedl

~

ey dnaadu

P E
anoiadiam-Janfdvome

1R

angu

ACBF Learniﬁg Ce nter " %b Student D. (student) [Wiewd Switch] | 2anansEuL

Model EErEEL: ﬂexibLé__gearu“’g o
a

\ 4
mhvdnszuu:msTaiian-maGruasiansumsiounisday - uAsanaan Ccurse O @un....

uaaaaan Course vilavin-iriadasly

- - - N . a =
ﬂﬂﬁLlaﬂdiTﬂﬁDﬁm-LﬁDﬂﬁ-Hu?ﬂLiﬂu { HavuTadaTavuR

v @ wingasmaTuladasaumaiamiznlszdnsaimaisiinau

- _ . s
v E wihEnsaui1 Basnaianisasdauasmsinduanaduiugs
=

v E unsHui2 3asn s llsunsuaseauduge

afnudasTninim-inn-wion o / sauswoisua L EeH nw‘;ulmunl Saumadamsadifanaznisi
El ST
Tazeus®
- q o= = a8 = o &
v A v } e mendasnQ
Vam’uﬁumﬂ. Aanm R 1 st w
A ' -
wrFuudl 15 fnmsad G ST clv’\'ﬁunw%@
IERRERE ST ]
P




331

ANANNUN TR

.’ 3 .
Learn'ng Cénter ) aaaaaaaaa a. (phichet1) | aanain
(Wl Blended and flexiblé Leam,g

“\IT\‘|HFI5=-'LI1J:I'I'IT55|I\'AB WiIAEIULAEA AN TR MSSIUATA Y

4 & =
SHHAUA K- I W TEA9LE

- 4. A . - =
FIﬂﬂl.lﬁﬂdTIEIﬁB'JTI’"I-LI':I’BM'\-MH?LII.TLI“ { daunpiavaiue

S @ wangammaTuladassuwmariaminlszansaimnisineu

. = - v
-~ wamSauii l.“i‘EIﬁWIFIul’-\Fl'l'iﬂ‘i"l\lﬂﬂuﬂ%ﬂ'ﬁﬁ"llﬂuﬂﬂﬂﬁ"lu’lfuq&

v AnsaanuuLAaLayRlLEYS

il 1 Gdunsldnuuarmauaifzasllsunsniaua
w1l 2 mydamistannuilduas

1w 3 MFFaMsTUAW Wl eanTuanRIadAng
W 4 MsATuRY AwAdaulin Fanaunay

v § msudnansanaalas

SEE%SS&

Learning ce nter aaazaaaaa a. (phichet1) | aanannszuu

Blénded and flexibléy e,
a

Low S
WMANANTEIL: ATALE M- NP IULREAANTTIMIEIUMSTaY  uAREAan Course L dunn...

udaanfan Course iavn-Ganaias i

- 4. - . a = . Inifeaya
AdnudaTofalmn-dian-mindo / gaunedainmm e ]

v @ wdngammaluiaddsmundianiunle=ingamamingu

_— - .
v % wihmFaui1 Fasmaiinnsaswdanasmminguanauiugs

v @ wihaFaui2 Basnslilsunsuaisisanuiiugs ]

4 @ waTuladdissund

v % waTulafdasamvduaznisdans

ACBE Learning Cé nter . aaaaaaaaa a. (phichet1) | aanann
Model ECEys E-le):ibh'alkr-am.?g

L .
wihrdnsssmriaiian-mbaFmuasfianTaimasoumsday - wAssiaan Course L @i

= =, A = ) ar »
uwaaataan Course tan-3naERs i
AAnLaAsITndaim-av-mhasoy 1 daunedafome N maiuﬁﬂammmwmu.mn'ﬁﬁ%lg:‘;ww‘s@

L ™ O
A4 @ uangasinaluiafdasaunduiaiulszdnsnmasineu aanusat »

— . . s
« % wihadauil Baswaiianmsaiiedauazaisinavanasuiugs

v % wihmiaui2 Basnslalilsunsualswauiugs B

v @ watuladasaumed

" P .
v @ waTuladarsaundAnaszn1saaais w




332

ACBF Learning Center . aaaaaaaaa a. (phichet1) | aanansEuy
Model EEns HexibLé_l_.eam'rg

a 4 -
L Rt v ala
wimdnszun:msdaian-mhafruussfianTuimsGounsday  uAfe...  LAaNATIAEDLL. ..

A a a wr -
au-inaiasly

winluTadsnsaumAuaznisdaas e

szt G e

iaaanionun @

awisznau 5 Llﬂﬂﬂiﬁﬂﬂﬁﬁﬂﬁﬂgﬂi

UNLFLUUNAN

©

¥

3 A dl [ % a dll a A 1% o
NL°l|’]’ﬂ‘1_|ﬁ‘ll@’1JJ’1ﬁ‘m/]’1ﬂ’]ﬁ‘LZ\]@ﬂ?ﬁﬂﬂﬂﬁ@ﬂ@ﬂﬂ%ﬂ’]ﬂ?ﬂu LHAARNLARNLLAI ??JUU"'\]ZbLﬂEN

a

v A [ % dli/ ¥ A | o = dl QI a a
wihraulunangrangidnausuiaeninadunangamalulagansaumneieiiul sy @naninnng
o al ] a A 1 = all dl a % dl o 3//
NWIUH 2 NUILLTHU AR UUIBILTEUN T LTANNAUANITATNABLAZNITUILAUBND  INTUTUES

oA oA A o o
PUIEIFTLUN 2 139909 M M lTnTN mq?’]\i\i’]u‘ﬂu@ﬁ

ACBF Lea rn]ﬁg Cénter 1 aaaaaaaaa a. (phichetl) | aandAsEuL
Mm!l-el Blénded and ,Flexibln!?_l!_earn"’g_

R
wimanstuL:msaiian-mbednuasianssumsEaunsaau g,

A a
a1 EI"HEII.‘!{EIH"I =11 HAILE0

- - _— . i ab
Adnudaanndai-iiam-mhsGeu / daunatafos g Mepdinaadu /7:} WanGy ‘ wAasnaan Course

A @ wingasmaTuladmsaumariavimlszansnmmaianu

. - - w
A % wihmiauil! Basmaiianmanedanaznainguananuings

0% v MsaanuLIdauAEAITILELD

0% il 1 Gusumsidnuarsaaurizasllsunaniaua
0% | il 2 msdamsiaauiituaae

0% Wil 3 msTRmssLaTe weud BT LATIRRns

0% | unil 4 mseuay awadauln FansunE

0% il § msudnamsaoalas

A % wihaEaui2 BasnsallsunsuaNeautugs

0% il 1 FusumsidnuarsaanizasTlsunsaseu
0% i 2 mavhaufuiaya

— " P
0% il 3 mstiAseddayadaTUsuAsua T30
0% il 4 ghaneeagltayasieaiseliuatusugd
0% il 5 inias (Macro) wiesfunsvioniudneaeidaaht o

- - o

0% il & msdRenumsuily Andaninoges (Auditing Worksheets)
0% unil 7 mstiuardsaantaya (Importing and Exporting Data)
0% il & msAvRAasnmAulaande (Security)



333

Lea rnlng Cénter aaaaaaaaa a. (phichetl) | aan3anaseuy
Blénded andflexiblé, Learn’g_

R

winanse nsFadiam-mhedruaziansemsEaumsaau
5 = S -
HuRaUATIRINZITI LA A duy Tl

A4 =
HHaluauI-1d 1 1ass

- 4 o N . o
panLasITIaEaTm-iam-minGo / daunadafue 3 Wepdiwasdu /A"? siangu ELLﬁmmSan Course

A @ wingaTmaluladasaumamiamiuls=dnsawaisiteu

-~ % wihmiauiil 13a dansasied 15U |I.l'l‘|"|lﬂ|l
I
U= dasnasiain: mﬂhmuanu'lmww.-ilumumipmm nsUszy & wiaaudu 4 foitsl
% nﬁuahﬁm‘tumsmmuanaﬂawiﬁﬂs.naummﬂmua daifudaiay mauiﬂdl.uammmaoa
5 ussmu‘lﬂﬂ‘aqm Na:aumwﬁ1ﬁeu\’m"mu‘tumsmuwaamauﬂuuﬁammana:hua“mhlam
o Januszasaiall: 1. annsauiiadomalianiszanuuudauaznisiuaue 2. usaihaag
- Tﬂsun‘mu'lmuaﬂuaalﬂiﬁﬂiuunmﬁumim\ﬁu JafumareanslEnuuasmsaiaLassans
= FlasmoTilsunsmiauatugs 4. lﬂunwﬂmmmulaomuni..muﬁ'lswuuiaaammm
i3 s Tanauanlsadiugm: wrutufniruatanUseasd  wumeaay daudeu - wiadoy,

Fang, auaaY
~ E widaiavumidou: Uy nsanuuLAaLaENTILAE uwm Eusumsldnuuasauand
W

U] yasTalsunsuliaus unil 2 n'lsﬁ’mmwamww‘lﬁlmm uwi 3 msimmﬁﬂmw wrugdl a179
uaEHIaIANT UMY 4 ASAILAY mwmaau‘lm Azmaunay v 5 nrsuanants o lac

0% aa laﬂn'mquumqaau LunaEaY, 33 e-learning, Video clip
0% ﬁPa‘lT\Gf:IuaEm. Ezifault Professor

o i -mbeEauni: 6

: Anaanzuizu: B0.00

i A ‘ina

o

i

i w6 msiiaaumsuily asdanlooges (Auditing Worksheets)

% i 7 mslidinuazdiaantaya (Importing and Exporting Data)

% w7 8 misAmusAIsinmATNlaaaNE (Security)

Learn]ng center aaaaaaaaa a. (phichetl) | aananAsEuy

Blended and Flexi bl& Leam,g_

N @

wihmanszuu:mstadfam-mhodouuarfansumsdounsaau

HUGAUANTATVETT IULAILATA AUYTAL

A & =
SIHHaaK - HagLs

ranuassmadair-dlaw-micndou £ dausodiaiimue S Teyfimaadu /7.}7 sWan&Y %uﬁnméan Course

S @ wingammaluladasaumaniavimlszdninmmsiieu

- - . 4
A E wihaSauil Banvaiianisasedanazasinauanas uiugs

0% i nsaanuuLFauaEAsULEEa
% i 1 FudunsidnunassuaeTitacTlsunniiaua

% i 2 msFanisiaAnuilduass
53 i 3 msFanisnlaw wrund srneuazdonodns
% i 4 MsAauAY mwmﬂau"lm EGRERTEN

a

A E mhﬂEﬂuﬁz BHavnlillsunsua s iudugs

0 diadnasiaim: msldldsunsuassanuiugsiuidmsiansiayasard unadayaiidum

0% ay @enanuiuiiayraagive Tviusssglda el animnwlunsautayainh

0% WinuivihillssAngamiueu

0 Famlszasaiill: 1.annseliang mmﬁﬂmnmmﬂanumga"lﬂimﬂs"unmﬁuﬂ1n’m1u
- 2. quanx:r..n'ls‘mnuiﬂﬁuﬂsmmﬂaw‘tum‘mimiian'lsmaua 3. TUnSRRIUT AULD IS T ASELIY

0% ﬂTELTﬂuiﬁWﬂE\ﬂiﬂﬁ

0% msTanawaniszuiuna: wwuvauniau-ndasoy, Anditdsioamas

0% wdaiimumEme: w1 L?:Jsfums‘hj"nuua..amHuﬁiﬂaﬂiﬂiuﬂmmﬁ\mw i 2 msvi

0 Jwufurays w3 msiensitayasioTlsunsusai1sioaiu vwi 4 Nﬁaﬁmmﬁiﬂuaunma

asnalainasusugd uwi 5 ules {Macro) funmhauludneasidantd g vt 6 ms
Aamunisuily msidanTsegns w7 arshuhuazdaantaya und B avsdrmusimsinm

A @ waTul amnlaaady

na -JapAsiGuumsaau: wuuvaaay, dne- learning, Video clip
ﬁna'ﬁnsﬂaanu. Default Professor

riavin-mihaEauiil: §
P E LMe  @lasusiing: B0.00

e g

MNUTLNBU 6 WARIATALUULNLTEIU

-7-



334

% a a a4 & ' o , P ~ o o A
LLNQ']Q;‘]JLL‘]J?JWLLuu@um@\‘lUV}L?ﬂuu ATTUBLNULUANSUNLTE U ﬂ?ﬂﬂ@ﬂ@jm?uuj nae

Aunlage1anst AuiuunBeuil arilitemuuuanaudu axdsngnnndngnsiane vl

k1l

o o a o« PR g A ~ p o A A
HL?EH@WNW?QL?NL?QHT@ET]@ "LTHLTEULUAUN- UUBILTEY " LWﬂ@lﬂq?L?ﬂuVNﬁN@l NTRLARNAN

o o o g Y o a M PR a [y a
LLQU@WQU?JHSLHLLL@V']VL@L@E (m‘]_IVILﬁ‘ﬂuuuﬂuuN'ﬂﬂﬂl&ﬂﬂﬂﬁ‘ﬂl& )NL"HW@U?N@’]N’]?QW@”@J

o
a

faya Inanienatlu "adia : 91e91W" INeNAzgIneaBaAse e LAz FawaTa lUudo



335

Lea rning Cénter . aaaaaaaaa a. (phichetl) | aanannTzuy
(| Blended and Flem‘u.%_!_ean‘,g_

R

mimanszuL:AsTatiiam-mhanEunaziansumsEounissau
& -
v TUADUATITRINZLLIEN

Pl &,
srdaiaw-iEnanst

adnuassnofiatmian-micedo 7 daunedafome

~ @ winganvwaTuladasaumaiaviuls=ansamaisvines

y 4
~ E wihasaui L%a\lmaﬁﬁn"lsm'"mﬁaun:msmmuawa\nmfum/

0% i MsEanuLLRanRI NI NEU
0% A 1 GusunsidnusataasuTizacTlsunnniniaua
0% il 2 nis¥annstaanaiilduaas

% 1A 3 N15TanTsTUaw LRual ATeLaEEiaFng

5% 1A 4 N15AILAN ATWLARaWLT SoREumEIY

% il 5 nsuasemsaaalad

A a WihmEaun2 l%a\lnTi’hﬁﬂ‘iuﬂiuﬂ"I'ﬂﬂ\l%@\i

0% i 1 GusunslinuaraaaTizas Tlsugfuanoou
0% unii 2 asvhoufusiaya

unii 3 nsTiasnidayasaTilsuasue
unii 4 ghenoauaaltayasagffloivazusuad

il 5 11ias (Macro) winstungfhonludnerasiisaviig o
0% unii 6 nsdrsnumsuily ngfiauTnages (Auditing Worksheets)
#oya (Importing and Exporting Data)
mirnulaarsty (Security)

0% il 7 msihaiuasdsaa
0% uni 8 nsAuRsA:

= i a =
ACBF Learr“ng Ce nte r ) aaaaaaaaa a. (phichet1)} | aananssuy
Model [ECEEVEEZT

L
wimdnszun:amsdaiam-w oaGmuussfiansunsEmumssay - maderzaan L dun

daaa aaadddiaa

AagaH UG 5

) AR | (53 Meyduasdu

&b 50U § a07uL 129

AamnurinnEge Ufiiuianssu (02 a.a. 2013)

deurnudA A Eae Wudue  Fud siniiums

Lo lifiazans gavarn Tuuiud

Avrraniifasvaeiunsaul

nwilsznau 7 LLﬂﬂQLLNQﬂ’JUQNﬂ’]iG‘ﬂu

sinldazifluniiwanaesunizen azingge dludu a9un Hauinan azidaunaunu

Fine°) LU Tayagansn



336

.’ P . 3
\ ACBF Learr“ng center aaaaaaaaa a. (phichet1) | aanansEuu
[IYYa [ | Bénded and flexibléearni

L
mihmdnszur:msdadiamn-mbaGruuasAansnsEIumssay - msdernyaas L g,

daaa aaaadaaaa

Hayaduen

i WHIAAUAM | MeyTinaadu &b \FEU § J00us 129

Ham e fiiufianssu (02 a.a. 2013)

deuanuddn A da

Lobifiazas vauar uuid

assyanga lunisanlsa

Tdnssyadusiaanyae tumFaud

Mwisznal 8 LARIUEIABAILANNISIEEY

Ujyunanssa
ATB I8N
nsanLse

FU-A9U1981T

-10-



337

Uuianssu (02 d.a. 2013)

danF

\ ACBF Learn"ng cEnter : , aaaaaaaaa a. (phichet1) | anannstuu

PN Blended and Flexible L-:-am'?g_

vy B
mihmdnsumsian. - n-nbaGoulafianssmasmumsday  iiuianss

ifiiuAanssy 10 d.a. 2013

I dnafianssulmdauil ‘ UERIVARANTIY

J

Suid fianssu

arlugitmuadenssyiutul

NMnUsznau 9 WAAINANTTNERLUDILNLTEIU

=
UNLTEU
~ a A P o Ny a A A s 2 oA o
ﬂ']ﬁ'L?ﬂuU“V]L?ﬂuuu@qll"]ﬁ‘ﬂ‘V]@351/]']1@1:@?]ﬂq?L@ﬂﬂVl?qﬂm’ﬂiu@qﬂumum@\?ﬂu’)ﬂL?Elullm

] a o v o
wmeanuluntivan

-11-



s trmaar el 1 dudemldruasesqnndbsas thurnahores

un# 1 BudunmsidonmuazamamideasTilsunnininwaua

msdas st dan wr-keEnE

ol

abf: e uffituifinne (19 do. 2013)

rude imeedaneie

wrimdavnalreuasd winfsnsomn il

Fustnadaseauiey

B aandithhn s funnina...
B1athinaleln Richon 1% Powerfoled 1110

Bl plssualed (Formaising Side)
Furvneasarninisy

nmwisznau 10 uaAILNENABLNGE Y

M @ wangasmaTuladasaummamamiuls=ansnwnisinau

(A * wihm3auil1 Basnailanisasvianaznisi muawm’mifum\
0% umih AsaanLuLFaLasATinaua
0% i 1 GusuaslinuuazaauauTiras Tlsunnnhgua
0% unfi 2 msTanisiasnuildudss
0% il 3 ArsTanTsTlaTw LHugl e LaEaEIAns
0% il 4 ANSATLAN ATWLAE 2U WD FanEuNETY
\ 0% unfi 5 Asudnensanoalas j
6\ % wihm3aui2 Basnstalsunsuaineauiugs \
0% unil 1 GusunslinusasnuauTanas Tlsunsuaimaau
0% unil 2 AsvhaTuduTa ua
0% il 3 ArsiATsitayasaTUsuAsYs 15199
0% unil 4 afFenaauanltayasoaisaleiuasusund
0% unil 5 u1las (Macro) nTAstumsvauludnoasisaniit g
0% i & Arshinatunisudla asiiauTaages (Auditing Worksheets)
0% uni 7 arslauatdtaantaya (Importing and Exporting Data)
\ 0% unil B ArsATMuREIMSSn A laaasie (Security) /

Awlsznau 11 WEAYRIALAULNITEU

-12-



339

6

napsutihauaue eIl FautasNgniIuaTaY 81A19ENAN199ANNTHEN

= %
LNLTEILLLA

wortin frwe hraane wedr = npeeardeam e e e et aaledduiee L

wiline v el s lusiman : awhindovussfiamae

A s nran o

rovavirdidason vl see

s vuiner et wird ey Sav e Mickes K

AMNUsznay 12 waAIHanIUNLTaU

Wagdinausn 1aManisAne Feudiaiaudo a1unsn iasasunig 9 liEwadausn

Taemnisnalu maalugd

o m = -
T-MUIBLTEUY ATLLTEUSE LAY |

nwisznau 13 uaALlNRUgANIsITaY

BN UINANNNTNFUATAUEIUATININIINALNLEY FXULAZNINITULATEINNAY

v
gn Tusensauesumiug dag

-13-



340

A @ wangasmaTuladasaumndmiavimlszdnsamasiineu

[ - - v il
A E wihaEaui Bannailamsdsedavasasindvanadudugs

33.23% | vyl Asaanulydauazansiiaua

0% W 1 BUAUATS IHTULAEAMAENTAT 29 TilsunsnigEua
0% il 2 mstanstiarnuiitugass

0% A 3 AsTanisslanw weund esouasdaadnng

0% T 4 ANSATLAL ATWARAEUND FaMEuHETY

0% il 5 msudrintsanodlas

mwilsznau 14 uansgonuzluunizau

'
2 4 o

1 U
FidnausnLNdougNisaNasiuwilanunEaw alaaninimne danud luunideu

a

E oy
twlfian

- 4
wRillansaanuuudaiinaua

ANsznau 15 LAAIUUNNNNLNIZ 2

14-



General | Options

Select Printer

E:aHP Universal Printing PCL 6 (v5.5.0)
%8 Microsoft XPS Document Writer
= pdfFactery Pro

4 |

Status: Ready Prirt to file

Location:

Comment:

Page Range

@ Al Number of copies: 1 =
Selection Cumrent Page

() Pages: 1 Collate

Enter either a single page number or a single 111 212 313 alnaua

page range. For example, 5-12

[ Pt ][ cance |

MNUszNaU 16 WARAIAIAENINITNANLNLS I

d” L4 t:ll a 1 tal a I a :j % 1
u@ﬂ@’muumgLﬂmﬂmmmu’]mm:ﬂmmmmﬂﬁmumuLmﬂuumma‘ﬂuuuﬂmhum

azAu WiazANAIUHeE e usHuARIANAATIuLEY fazuansetlu usaziiiaEew Ty

ANUINATRILARZUN

-15-



342

AMEANAAINAR LY

AR LT

R
S
B I U 2 | == =2

drud: IEI

awisznau 17 LL'&ﬂﬂLLHUﬂﬂ%Nﬂ’]i‘LLﬂﬂﬂﬂ’J’]NﬁﬂL'ﬁu

Uszidnauinnad )

Student D. (student). L]

i ®

AuaFAe s 5. (professor).

o 1 a [
Anisznau 18 LAAIAADENNLAAIANNAALIAY

-16-



343

nsnAdal
1 o a 1 = v d” =
nanageUneaulaznazeuluuarimzeu ulasaaiailenvesunizay lu
wUUnAgeL Hanaasiilszinnaesunynageusne uatetlszinnudous aransdaiuauiinun
dnarlii wuunaseutszinm i frfdineusuasueiunuunaseuniazituwsiin i fas i

wireuludauniu teazllunsaldls

uni 1 Busdunisldnuuazaaiamiduasilsuasnivaua

ANTAIATATSUSHISIAATS

—
> i) @ ol
SuEmuilawi-wing | |dzyadiawi-min
5EU Gou

RS TUANW Agdf 51U

swdadan-dy vaan vl 1 Gudunsldmuarauaidea Tisuranhiaua  suuvadauiauEou

wimadaunawmiou

uuuvadAaunauwIuY

w1 BudunisTdnuuesanonidsasTusunsunduaua

. amniEmnaulauasaneanié i@t unisuiulsatu PowerPoint 2010
. unuadasia Ribben Tu PowerPaoint 2010
. suuuualas (Formatting Slide)

sflandieaunigneEsaniga

'ﬂmunn s lunsaay: hHERTT]

o~ drundadomnfawua: 10

Lﬂ’ MTUARIHAR IO Y LIRS DU: ugsomsanfninosmnda
anulddvhuuvessvaduiboue: 0sf
pafifviidnhuuuvesauildlidiu: 1 a6

Euvhuinmagan »

1. anauRmiaulawasrquaytan@iunainl... }

Awilsznau 19 waALUUNAFaL

-17-



344

draaran 1

- | @ . = '
AUNAISUIIUAaY Power Point 15ani1az'ls

E AslLEuaTY

RN T O]

MMWdsznau 20 waAIANLLLNARAL

] -

mrtaizn-Trmean w1 dudunsliunarpuaeiEsasidunanmug | suivasauraedou

WA sAURAUS I

Fuvhwimeaauda 19 .0, 2013, 10:32:33 wantuafalia 19 §.0. 2013, 10:34:35. viuaialuia 2ud 2
v,

@ TEhvhurmmaszusatuas 1 efe waslamBoand dwhuuuveaaudldin 0 af
aruuuilafia: 1008 su

B LARIHA AN RN
@ a1 (Auuy 10%)  whodou-Si wnmedauiawdou®

Auin1s¥ireuas Power Point unitasls
| imdniay

ix) mled . éndanfaues uasiludiapuionan
| wihaa

| MITUNAUEITY

AvpuazasuueilE: 100% | Tdaruuvlunviwamau: 100% « 10 = 10%
@ dmudad 2 (asuu 10%)  wihodou-$ s daunawiou”

Power Point 1nasaiu 1.0 Taidumedasdsannla

AMWisEnau 21 LAAINATBINITIAFDL

-18-



345

FaulansFaurasa

¥ v

= o = = 4 )y g =
NL°]J’]ﬂ1_|ﬁ‘llZQ'WN"I?OV]@t@]L\‘]‘ﬂuvhﬂuﬂ'ﬁ‘l,ﬁ‘?;lui@ﬂﬂ’]ﬁ‘ﬂ@ﬂ@ml@ﬂﬂ@ "UDHALUANT - UNLTUU

a

TunthunBeungsneazaunnliinaudusiasReulsiawinagnglsaaasinu

UNA 1 BudunIs i vRazamauifGaasTlsunsNLNLE

ANSESAT ANSLISWISAANTS

» i)
i) - 2
TvidaundullGus . .
LT sayatilani-win
ilawr-wianiEy ¥ Ee
T

afsrTudwii abé:simau

G2

V

ngafilsie - JaH1ES

A L

A ar o w
WniatlavumdaunazEfuianssunsiaaug

[BuvuvadavaauEau

B L Aangurdinauluarsadutdnlasuniaisul.. .
¥ 2.ufiuiAsaadia Ribbon Tu PowerPoint 2010

® 2. qUunua'las (Formatting Slide)
[FBuuunadaunaasau

nmwisznau 22 uapstiayalian - uuleEeu

Hayatilai-wnhaEa

I A 1l = " ) = - o m
‘HayaLuan1-1wu mSauinn: " unil 1 Budunis i uzﬂmﬂuuﬁmaﬂiﬂs unsuisaua

& daamstdaau: Professor D. (professor)
B vlawm-wio-umGEau: 3 wmiso-um
[ wuuwmsdau: 2 wuuvAdAaL

wnawi-wdanlansiudlav-wihaeu

awilsznau 23 wansaulauasunizay

-19-



346

n5aaANg
eFront uaNsn Wigdinausnldirresiosne iNedeansiuenanstuazidinausndi
= [ v a dl A dl o d”
weariuls Jirrediiadednsnail
atfrale e nor Tl s T m e f esvn e des day

srdailne-Tanmaas)

- @ wiinganwaiuiada nanwaidavinlssadndn n v

"~ a wi i Fmeit ! doeemadanadwlosecn i ususaas g

mimdnsru:asdadamn-minErunafiansunsEiuns@an | ANSeaAT AT

phichet khoo

AayadIuar

Aaa A naga

@duAanuddmA Baa

Srlufe ey dava iy Wl

4
UBAITHN
5
vl e mhedreefiermmeinermey  fudnnm

CL e T ST BT gt g ] v T ar ey
1. Evrv el (0 Su-de s, K8 0 wwiinme TedrEram ()

1 vy [0 fu-saui, (MB) 0 v s Koytes W | )
L. v [0 f-asara, O

dawraiieaurin

Sl s el

AnUsznau 24 LAAIUELILINTRAINN

-20-



347

ANy "a3wdiaanu- d1anslud " laninisdensanisudcazilasulilaandin

faArNFIUY AR

v
o o

dJ = 1 4 = =
TINANBIUS NAANUARAIMTNITHANU

A lH e ARNAREDY

L1l k1l

o

o dl o | % = MY
NAaaning dulruatundaviredslylfens

audamNy

o I

. 4
fhedanaulldanebu

wivadrarn e daw wnoaleaasfarranirunsmay fud . shedaens .

ilnnselasEu

|
5 P PR T T D

sdaE

aa |
titmsadaasisin [

mwisenau 25 uanuTNdaudanu

A o a ¥ v ' ' Ay = A ny o

HANTINNT ﬂ@ﬂLﬂJi‘é "@?'N?Jfﬂﬂgqﬂ-ﬂlq')@q?sl,ﬁll"qgmqﬂq?ﬂLﬂﬂu%ﬂﬂqqﬂﬂ\iﬂu‘ﬂuvlﬂ N7
Ly o a P ~ g a °
?"N"ll‘ﬂﬂqqllLL@zL@ﬂﬂq?LLuUIﬁ]quﬂﬂm We  eFrontazduaniniaaINy I@ﬂLﬂrﬂﬂ AMUIULUTZLAN

|
a ¥ o a

2 ! 1 v 6 ¥ dl dld (% P o dl
HEU wunguiiy 61 ninecdesiuunzaunzauedlf vivendngmeau

-21-



wiEFnl ey e T wu e sl an i qun frilay Tl ENSRRNTT-R..

| 1
Lirunsssedisgh _r_J

THL TiE . - L T L T * 2 n -
o I - —r p =
e yalagats .I-IIIHII‘:III.II-“ VBl e i R AL s AR e |

Lot :
Jjirrintulre e | sy v b i il s B - |

._.“f:“'-sl.iﬂn'l'..ﬁml'-lm_ Wi | LT D LR TR bl s T R = |
0] mvingnatunae: | Lanfstafarmneu ~]

MSEIE T

o |

Pitegnaalunaiim ||

nAnisznau 26 LAAINISAITAANNDY

& S 9 o = = vy = ¥ o A o
Forum tiuazifendesiuluumiEeu Gamuieanudd §iineusuaanuiivanive e
Forum £ lvisaginausuannsnairaiodalu Wein was vise uansponuAnwivluiadesine

QJdI %
209EBUlE

0.




349

L4

AYAFIUYAAR
I dl A & ] o Y v ¥ o o Y 1
Wwen "eiseslle " uazna "feyadouia * filinausuanunsnufladsriRdausialdidu
= e A A = o Aa 9 A o = % ' '
BwadvidesasemuaziBanlnansenannuuuefunifacdeuiietininlasuazsieanatly  “da:

Tunnnalagunlas”

L Ly PIL R R BT LS LR T o S A

5 'rlﬂ;“'ﬁl..' lamaansy

alrggermesatn-ilawrnetioy ¢ st m i Than m--!n--ﬂ..r fouprne

] @ wiinganwaiuladd nanvwadavinlssidndnman v

~ a wid ienmei 1 dosmaianviad redoses v niessas wiege

wrindrirs e i wihmlnue sl vreerairenaee arlsdasn

Hayadiuda

WS TURE Ium Ia,:

| MTAGATEES T Gl s

NIRRT A
Earmesnusrhtfnnsssssnmiieg [T

Asvrads deadn [

g eyt

Asrchuiinen walieuelas

T dnaaiu

dradunda F Ov:

Ansadar: !

s A I d Attt st [ 1]

ilan T diirmann: r B ]

walanlssnmmennid; VI-E ,_n.ﬁ.-' .d:n::a-'...'. udtinl

Tdnwmnliznmilasnluing

mMwisznay 27 uaRnTNTayadIUs

-23-



350

agslsfimugiirausnaunsouflaglnndaudaléain  dangdniwdausia "anta

1 ] o v v o A % o dl A %
"BINANRAILFIN" E;JJL"II’W'ELI?NZQ’]N’W?G’Qﬂﬂ’]ﬁ‘IﬂElL@’ﬂﬂqﬁj‘ﬂLL@’J@WIV@@E“JJI]’WWV]L@@H%

dgualuaifAen:

manlivialvaudysl it tuiaadu: | |

waantelldnmann: | [ Viang ™ ]
windantdinnomeii: |v | (rang-Randgglunudann)
Tdmsulasuulasguin

mwisznay 28 uanin1sanluangy

-24-



ANANUIN o

‘i’lﬂu'luﬂ@:NVIﬂ@’ﬂ\‘l



1.31EUNNGHNARDI NINAABIATIN 1

352

A1AU T - ANA

ALY

1 [WNANTAEUT Wunau

UNWENUNASANEIUNTYNIg

2 [WNdaRal Mgy

UNWENUNAIANEI WY NI W LA

ae o

3 |[UNAAUNITEN LWRHTIRTI

inapnIswia ldgunynig

b4
%

2.?W£quﬂ~lﬂ@:3~l‘1/1®ﬂﬂ\1 ﬂ’]ﬁ“ﬂﬁ@@\‘iﬂﬁ\‘iﬁ 2

A1AU T2 - ANA

ALY

aa o

1 UNAINTINE TUNLaL

WaningunIsRukaz iy

2 [Weana@nslaaugnioyau

UNWENUNAIANT U YN TA LA

3 [UNANINNNEALAIAUNT

UNWENUNAIANTIUN YN TA LA

o o

4 phedgfunasns

UNWEUNAIANTIUNTYNIT

5 [WNNLAT LN

UNWENUNAIANT U YN TA LA

6 [NENNAAY SUNTgIAY

UNABUNAIANTIUNEYNIS

7 W NANYNINIA N370ULTN

UNWEUNASANEIUTYNIg




3.‘3"1ﬂu'13~lﬂ2§9~]1’]@@“ﬂ\‘1 ﬂ’?ﬁ“i’lﬁ@@\?ﬂﬁ\iﬁ 3

2
(%

~ 9 9 =R o = A a a a
V]?JL‘LlﬂuﬂaljLﬂlqﬁjﬂ’ﬂﬂ?ﬂﬂ@ﬂ@mﬂwﬂtui@ﬂ'&q?’&ulmﬁLW@LWNﬂ?ngIﬁﬂ’]WQ’]u

a

U 4,14,21,25,31 sla1Ax 2556 W astlsrgaduiiugng an.

353

anU

T2 - ANA

AR

AUNKUATHANNANDNIANEYITE

1

v e A
WA ALEQTINA

UNWENUNAI AT U YN T LA

2 peavadedoducasan UnWmundsanddminng

3 [WEeRTIn TAUNA dnWmundsandydminng

4 [NAIIBI0YTEN ADSEUN RINTNIIUGINNTEIUI YN

5 [MNAN98NIIRULITLAL WaniineugenisUfFanu

6 [W1edddmn assnuned WaniineugenasUfiFanu
AUNFUATHANLUATDLATY

7 [MNANMIINTINSANTAN LU UNWENUNAI AT U LY N T LA

8  [unantUneTlunIe UNWEUNASANEIUNTYNIg

9 [WNAMAING WINNIT UNWENUNASANEIUITYNIT

10 [WunImdiasoyimud UNWENUNASANTIUNTYNIT

11 feanarannand dasiau UNWEUNAIANTIUNTYNIT

12 WNEN9Nmliuns RnwiingugennsUUFanu

NAYAWATNLAZWAUILATDTUE

13 [WINENUID ARANAY UnWaudsanduinynig

14 [enagn geasauinid UnWaudsanduinynig

15 [UNERTIUNIeANNdow Unimundaandimnnig

16 [Wedagdayeyninans UnWmundsanddminng

17 [Wnaaneiuaftnenuui dnWaundeanfimnng

18 |[W1edns grian dnWaundeanfimnng

19 [uNa1usgmRTn RN RNVl S HR TN R




354

AnU e - ANA

Qq

AR

20 [Wnmadla nanae

WU AANL TR

21 [WNA1FARLINT WANNAN

WU AIANL TR

22 funagnanilanialaninsen

WU RN AIANL TR

v

23 [UNAN9RaNTdY 48

a

WanineugenisUiFanu

24 JwsananyaisEansanin

WaniineugenisUiFanu

25  [NANNINNgeziAes

WanineugenisUiFanu

26 g gANINula

PNWENUNIAIAN

NANNAN

=

27 [nagnaNTae nuAs

a

inATnsRuuatiny@UfimnIg

@

aa o o 6

28  [UWNE1LR1IAATNUTAY

WnineugInIsUFanu

AUETaNAUATANTAUIA

29  [neanagdungulszidig

Undrnnsmeniamestiiinnis

nulemgIRdaunely

30 [wngldudiennsnl

RINENIIUGINNTEIUI YU

31 | W9g@n9tan AguEmid

dnWmnndsanddmnng

32 | wasin dadeu

dnWmundsanddmnng




AANUIN °d

AMAUTTENNIANITNARNRAN



356




357




358







360

Q

ﬂeﬁaﬂﬂé‘“ 8l

Te TRANA WENIL] ATASIT
% A | a
FULAAUL A 10 WEYY 2512
dl a v 1 o/ o
ANUNLNA ALlaNUIUARINTE AIMTANTINNNNIUAT
PR o = A a y = Vv o
anunegilaqiiu 75 maglatuAABIN ATy Hamie 12 ugtinudasylan

nUUAILAABIN ATty Tle waeuuesuaN
IAMUBILIN NTNNEUIWAT 10150

Fumdaniininnsanulaqiii UNTIN19AANRIARITIUNEY NN LA 8

d‘ o o o v dl = o
@mummmuﬂ@ﬁguu @O’]‘LIH‘]J?ZNQ@?I@H@ ABNITANHILASWENLN

NUNINLNAUFITNANGAT

sedRnnsAns

W.A.2530 YaenAnEmeauLlane
AN TLUNNATUNS

W.A.2532 auLFeyny PanNames
ANINLNALAFAIUFUUNN

N.A.2535 WYVANARTLTUTIR (IN.1) INENITARNNILFRT
ANINLINE AFAIUFIUNN

W.A.2540 ANLANFARTNNTUNR (N.N.) WARIAEN1TIANITIZLUATAUNA
ANNUWINERLNTAR

W.A.2557 NaANEAET TR (NA.A.) N1ANEE Ly

AN AL ATUATUN T 136N



	Cover
	Abstract
	Chapter 1
	Chapter 2
	Chapter 3
	Chapter 4
	Chapter 5
	Bibliography
	Appendix
	Vitae

